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Introduction

Welcome to 3D Programming Using the Morfit 3D Engine.  Whether you are an experienced game designer or looking to produce your first 3D game, this book is for you.  In a very short time, you will be using the Morfit 3D Engine to create rich and exciting 3D games with beautiful graphics and state-of-the-art performance.  While mastering a 3D graphics API can take years, the Morfit Engine will have you writing games within weeks.

Why use a graphics engine?

 Hardware and Software standards are constantly changing: The 3D accelerator and API market is undergoing rapid changes.  Each month we hear about the new “king” of the market.  MiniGL Out, ICD In.  DirectX 5.0 Out, Direct6.1 In. Glide2x Out, Glide3x In, OpenGL 1.2 1.1 … Testing code on dozens of different 3D accelerator cards is so time-consuming and tedious that you won’t have any time to make the game itself. By the time you finish your game, the industry could look a lot different. You need someone else to take care of those details so that you can spend your time on the actual development.

 Learning curve: A good 3D engine hides all the ugly details of 3D API programming from you without sacrificing the performance. Becoming an expert with even just one API takes a lot of time and patience.  Using a 3D engine allows you to program on a higher level.

 Development Time: Even if you are already an expert with the 3D APIs, you still have to develop a smart engine on top of it. That’s exactly what we have been doing during the last four years. Why reinvent the wheel? Use something that is already debugged and working, instead of taking the time to do your own research on topics such as binary space algorithms, surface caching, physics and kinematics, texture memory management, software rendering, etc.  Why spend your time designing an engine when you can spend it designing the game?

 Performance:  Engines that come with hardware APIs don’t perform well. For example, the Direct3D Retained Mode engine is weak, and incapable of dealing with large worlds efficiently.

 Tools: A good 3D Engine SDK comes with a pack of tools to assist the development process.  GUI-based tools can cut down development time significantly, as many programming tasks are replaced with the ease of drag and drop mouse functionality.  If you try to tailor your own SDK package- i.e. take a 3D engine from vendor X and the World Builder from vendor Y, terrain generation program from vendor Z- you will have to spend lots of time on import / export issues, trying to find out why your beautiful models from 3DS look terrible in DirectX format. 

Why Use the Morfit Engine?

 Performance: Morfit ensures great performance, including a high frames per second rate, great graphic quality and special effects. You will be able to impressed with the speed in which it digests huge worlds, with or without the help of a 3D accelerator card. 

 Technology: Morfit’s 3D Engine proprietary Virtual-Reality engine is based on state-of-the-art algorithms and techniques, including proprietary PIRR technology (photo realistic Interactive Real-Time Rendering). The result is more advanced performance both in speed (frames per second) and image quality than other PC based engines. Morf’s VR engine SDK makes it extremely easy to add any kind of 3D content to any application or to create arcade level games from scratch. 

 Simplicity: Working with the Morfit 3D Engine is amazingly simple, shortening your development time.  Morfit programs can be very compact. Here is an entire sample program. It loads a world and displays it on the screen until the user presses the Escape key: 

#include "mrft_api.h"

void main(void)

{

Morfit_engine_load_world("worlds\\world1.wld","", bitmaps",USER_DEFINED_BEHAVIOR);


//Render till the Escape key is pressed.

while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



Morfit_engine_render(NULL, Morfit_camera_get_default_camera(););



}

} 

 Total control: Using the Morfit 3D engine you can control every aspect of your 3D game down to the bits and bytes level.  The Morfit 3D engine doesn’t limit you to using just the Morfit functions when developing your game; for example, you can very easily add your Direct3D code.

 General Purpose: Many 3D engines are limited to producing only one kind of game. A great engine like Id Software’s new Quake engine cannot be used to design a racing game or a flight simulator.  Morfit is a general purpose engine that includes optimizations for both indoor and outdoor games. 

 Very fast learning curve: The Morfit Engine uses no new classes and no data structures.  SDK comes with about 30 sample programs, many of which are less than one page of code. How complicated can one page of code without any new data types be?

 A full package of tools: Morfit supplies a wide range of tools that are all tuned to work smoothly with the Morfit 3D Engine. This will save you a lot of time looking for complimentary tools and then laboring to make them work together. 

 It is free: Not only is it free, it can also be a source of income. The engine has built-in advertisement capabilities that make it the only 3D engine that provides a complete business solution. 

 Flexibility: The Morfit 3D engine lets you develop applications using the development environment that you are used to. The SDK comes with sample Console, Windows API, and MFC programs.  Morfit also provides different versions of the SDK to work with some of the most popular compilers.

 Dll technology at its best: Morfit releases a new version of its engine every two months to reflect the latest accelerator cards and APIs.  Thanks to dynamic linking libraries technology, you will only need to replace the Morfit Engine DLL file- you won’t have to recompile your programs. 

What does Morfit provide?

The Morfit 3D Engine comes with the following tools:

· Programmer’s Software Developers Kit:  These APIs give you complete control over your 3D world using your favorite programming environment. 

 World Builder: The World Builder allows you to create complex 3D worlds through an easy to use drag-and-drop interface.

 Terrain Editor: Use the Terrain Editor to convert simple bitmaps into complex 3D terrains.

 World Text Editor: The Text Editor lets you ‘tweak’ your 3D world manually by manipulating the saved world.

 World Viewer: Take a tour of the worlds that you create using the World Viewer.  You can see the objects moving and the animations changing as you move a camera through the world.

Who is this book for?

What should you already know?

The examples in this book are written in fairly simple C++.  In order to understand them, you should have some experience in C++ programming.  Knowledge of MFC will be helpful, but its not necessary.  About halfway through the book, I introduce the very basics of MFC.  I will cover just enough so that those who don’t know MFC will be able to produce MFC programs that use the Morfit Engine.  Programmers who already know MFC will be able to see very quickly how to integrate Morfit into MFC programs.

A basic understanding of 3 dimensional geometry is important.  In Chapter 2, I present the basics of the 3D coordinate system.  While knowledge of topics like 3D matrix transforms, rotations, light reflections, etc. will certainly allow you to understand more what is happening on a deeper level, and will allow you to achieve more complex effects, you certainly do not need to understand the internals to produce good-looking 3D games.

For the first example only, I walk you through creating a new workspace and project in Visual Studio.  After that, I assume that you either already know how, or that you will look back to see the procedure for creating new programs.

What will this book teach you?

If you are interested in creating 3D games, this book is for you.  It gives a brief introduction to the Morfit World Builder, which allows you to create your 3D world using a drag-and-drop interface.  I only cover the basics- what you need to run the example programs in this book.  For a complete understanding of the World Builder, use the detailed Tutorial that is packaged with it.

The bulk of the book deals with the Morfit SDK.  It gives you complete control over the 3D world that you have created.  When you have finished the book and run through all of the example programs it contains, you will be able to write your own 3D games using the Morfit APIs.

What tools will you need?

The hardware and software requirements for developing with the Morfit Engine are:

· A compatible operating system: Windows 95, Windows 98, Windows NT

· A 3D graphics accelerator card, while not required, is a definite plus.  Certain effects are only visible when using an accelerator card.

· A compiler that is compatible with the Morfit 3D Engine: Microsoft Visual C++ 6.0, Microsoft Visual C++ 5.0, Borland C 5.0, Delphi, Borland Builder, and Visual Basic.  The examples in this book were created using Microsoft Visual C++ 6.0.

· The Morfit 3D tools: the Software Developers Kit, the World Builder, the Terrain Builder, the World Viewer, and the World Text Editor.  The latest versions of these products are available for free download from the Morfit web site, www.morfit.com.

Chapter 1 – Getting Started
Using the World Builder

The Morfit World Builder is a powerful tool to create rich and exciting 3D worlds quickly and easily.   This section provides an introduction to the World Builder – you will  create a world, add a few objects, and view your world through a moving camera.

Creating a new world

Start up the World Builder.  Select File->New.  You will see a list of templates upon which you can base your new world.  Select “Terra.wld” and open it.

The World Builder window contains many toolbars and windows.  Right now, you only need to worry about a few of them.

In the center of the screen are three views of your world.  When you load the template, the top (main) view is almost filled by the road.  Move the camera up so that you can see some of the grass on either side of the road.  Make sure that the Camera Mode icon is selected.  Click on the Up Arrow and the Down Arrow until you have a view of the road and some grass.

It’s time to add some objects to the world.  The frame on the left side of the screen contains four tabs.  Select the one on the right, Model Gallery.   Scroll down through the folders and select “Rural Objects.”  Scroll down until you see the swing set.  Using the left mouse button, drag the swing set onto the main viewing window, and place it on the grass next to the road.  Now select the folder named “Buildings.”  Drag a building or two on to the grass.  When you are done, your screen will look something like this:
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Figure 1.1

Creating a Camera

Before you can view your world outside of the World Builder, you will need to create a camera.  While the engine will automatically create a default camera if you don’t, this camera would be stationary.  Instead, we will create a camera that moves through the world along a track.

First, let’s draw a path for the camera to follow.  Select the Create New Track icon on the right side of the screen.  Name the track my_track.  Click on the road in the main view window- a gray dot will appear.  This will be your track’s starting point.  To continue the track, click again farther up along the road.  Continue your path onto the grass and around one of your buildings.  Tcomplete the track, click again on the track’s starting point.

It’s time to create a camera.  Click on the Create Camera icon.  Name the camera my_camera.  Next to Track, select “my_track.”  Leave Chase set to “No chase,” and set ChaseType to “Track.”  Set speed to 80 and leave softness at 1.  Click OK.  (For now, don’t worry about what all of these values mean.  The purpose of this example is just to get a general picture of how to create and view a world.  Later chapters will explain all of the details of how to move along a track.)
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Figure 1.2

When you open World Viewer, it will display the world through the default camera, the first one on the list of cameras.  Select the Camera\Track View tab.  There will be one camera listed above yours.  To delete it, right click on ns_camera and select “Delete.”

Select File->Save As, and save your world  as “firstworld.wld” in the directory “C:\Program Files\ 3D Engine SDK (for Visual C++ 6.0)\Worlds.”

Viewing Your World

Now you are ready to view your world!  Click on the Launch Viewer Mode icon, and follow your camera’s tour through the world.  When you are done, press escape to return to the World Builder.

Experiment with the World Builder

Now that you have viewed your world, take some time to explore World Builder.  Click on the Object Movement Tool.  In this mode, you can select objects and move them around the world.  Click on the Blue Arrow icons to move the selected object around the world, and the Magnifying Glass icons to enlarge or reduce the object.  Use the Object Rotation Tool to rotate objects.

To look around the world, make sure you have Camera Mode selected.  Now, the Blue Arrow icons will move you around the world without moving any of the objects.  The Magnifying Glass icons zoom in and out.  Drag the mouse around the three View windows, and watch the world move.

Find a car in the Transportation folder in the Model Gallery, and add it to your world.  Create a track for it to follow.  To have the car follow the track, select the Object Movement Tool and then select the car.  Right click the car and select Properties of object.  Select “Dynamic,” and assign the car to the track just as you did for the camera.

Explore the help menu, especially the “The “How do I work with…” and “Tutorial” sections to learn more about the World Builder.

Using the SDK

Now that you have created a world in World Builder, you are ready to use the 3D Engine SDK.  This library of functions gives you full control over the 3D worlds that you create.  We will begin with a program that loads the world that you have created and displays it on the screen.

Creating a console application

The first few applications that we write will be console applications.  Console applications have nothing to do with Sega or Nintendo.  A console application is merely an MS-DOS program running in Windows.  While they don’t look as nice, and they create a console window that will we will have to minimize every time we run the program, we will use them because they are much smaller and much simpler to write.  This will allow us to concern ourselves with the details of the Morfit API, and not worry about a large application with many files.

Later on in the book, however, we will want to be able to write more complex programs- for example, we will want to be able to use the mouse as an input device.  For that reason, Chapter 5 takes a look at the design of 3D applications using MFC.

Creating a New Project

Open Microsoft Visual C++.  Select File->New.  Select Win32 Console-Application.  Name your project “LoadWorld” and select “Create new workspace.”  Click OK.  Select “An empty project” and click Finish.

Adding the Morfit Library to Your Project

To use the Morfit functions, you will need to link the Morfit library to your project.  In the Workspace window, select FileView.  Right click on “LoadWorld Files” and select “Add files to project.”  Navigate up through the directories until you reach the “3D Engine SDK (for Visual C++ 6.0)” directory.  Select the “Engine” directory, and then “Lib”.  Next to “View files of Type” select “Library Files (.lib).”  Select “Morfit.lib.”  Click OK.

Including the Morfit Header File

Now you need to create the program file.  Select File->New, and create a new C++ Source File named LoadWorld.cpp.  You will need to include the Morfit header file, “mrft_api.h.”  It is located in the “3D Engine SDK (for Visual C++ 6.0)\Include” directory.

Example:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

Note:  all ‘\’ characters in path names must be entered as ‘\\’ when inside a string.  Also, your include path may differ.  It will depend on the location of your project and the location of the include file.

Setting Your Project’s Working Directory

In order to avoid having to specify in our program the location of the world file, we will set the project’s working directory to the directory that contains the .wld file that we want to use.  Select Project->Settings.  Click on the Debug tab.  Change the working directory to the directory that contains the world (e.g. C:\Program Files\Morfit\3D Engine SDK (for Visual C++ 6.0)\Worlds).  Click OK.

Your program is now 3D enabled!

Displaying your world

It takes only three steps to display the world that you created.   You need to load the world, select a camera, and display the world on the screen.

To load the world, use the function Morfit_engine_load_world.  The four parameters of this function are: filename, directory of the world, directory of the bitmaps used in the world, and the display mode.  Our file is called “firstworld.wld,” it is located in the working directory, and the bitmaps are located in the “Bitmaps” directory.  We will load the world in “USER_DEFINED_BEHAVIOR” mode, also known as Viewer Mode.

NOTE:  Viewer Mode places some restrictions on the operations that you can perform on the objects in the world, but renders the world very quickly.  Editor Mode gives you complete control over the objects in the world, but renders the world somewhat more slowly.  The differences between Viewer and Editor Modes will be discussed in depth in Chapter 12.

To load the world:

int rc = Morfit_engine_load_world( "firstworld.wld" , "." , "Bitmaps" , USER_DEFINED_BEHAVIOR);

Morfit_engine_load_world() returns an error code VR_ERROR if the world was not loaded successfully.  If an error has occurred, print out an error message and exit:

if (rc==VR_ERROR) {


cout << "Failed to load world, aborting\n";


cout << "look at error.log to see why\n";


return;

}
(As this message indicates, if your program encounters any difficulties, you should check the file named “error.log” to find out what went wrong.  Another useful place to look for information about how your program ran is the “morfit.log” file.)

Let’s give our window a title bar:

Morfit_engine_set_default_rendering_window_title("First World     <ESC>  -  Exit");

Now load the camera:

DWORD camera=Morfit_camera_get_default_camera();

Morfit_camera_get_default_camera() returns a handle to the default camera.  Any time you want to create, move, display, destroy, or access an object in any way, you need its handle.  This function will return a handle to the default camera, in this case the only camera, which in the World Builder we named my_camera.

Now that you have a camera, you are ready to display the world.  The parameters to  the Morfit_engine_render() function are a window handle and a camera handle.  A window handle of NULL will display the image  on the default window.  Tell the engine to keep displaying the world until the escape key is pressed:

while ( (GetAsyncKeyState(VK_ESCAPE)) ==0)) // loop until escape is pressed

Morfit_engine_render(NULL, camera);


Note that GetAsyncKeyState is not a Morfit function.  It is a C++ function that tells us whether the given key has been pressed since we last checked. 

Here is the complete program:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{

int rc = Morfit_engine_load_world("firstworld.wld" , "." , "Bitmaps" , USER_DEFINED_BEHAVIOR);

if(rc==VR_ERROR) {


cout << "Failed to load world, aborting\n";


cout<< "look at error.log to see why\n";


return;


}

Morfit_engine_set_default_rendering_window_title("First World     <ESC>  -  Exit");

DWORD camera=Morfit_camera_get_default_camera();

while( (GetAsyncKeyState(VK_ESCAPE)==0)) { // Loop until escape is pressed


Morfit_engine_render(NULL,camera);



}

}

Listing 1.1

Compile your program, and then run it.  You should be able to see your world just as you did using “Launch Viewer Mode” in the World Builder.  Your display window might be blocked by the console window- just minimize the console window.

Controlling your world

That’s a very impressive result for only a dozen lines of code.  Now, instead of watching the camera travel in circles, let’s take control the camera.  First, let’s maximize the window and hide the cursor:

Morfit_engine_maximize_default_rendering_window();

ShowCursor(FALSE);  // Hide the cursor

In the World Builder, we set the camera to chase the track “my_track.”  To remove the camera from the track, use the command:

Morfit_camera_set_chase_type(camera,NO_CHASE);

Now create a function Move_Camera to control the camera:

void Move_camera(DWORD camera)

This function should get the camera’s current position.  It should then check to see if a key was pressed and reposition the camera accordingly.  To get the camera’s position, use 

Morfit_camera_get_location (DWORD camera, &x, &y, &z);

Changing the x-coordinate will move the camera forward and backward.  Changing the y-coordinate will move the camera left and right, and the z-coordinate controls the camera’s height.  Let’s start by moving the camera up and down:

if(GetAsyncKeyState(VK_UP) <0) // move camera up


z +=25;

if(GetAsyncKeyState(VK_DOWN) <0) // move camera down


z -=25;

We’ll do the same to move the camera left and right, and we’ll move the camera forward and back in response to the ‘f’ and ‘b’ keys.

After calculating the new coordinates for the camera, set the camera’s new location:

Morfit_camera_set_location(camera, x, y, z);

All that remains is to call the function in our main program loop:

while( (GetAsyncKeyState(VK_ESCAPE) ==0 ) {


Move_camera(camera);


Morfit_engine_render(NULL,camera);


}

That’s all it takes – here’s the whole program:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{


void Move_camera(DWORD camera);


int rc = Morfit_engine_load_world ( "firstworld.wld", ".", "Bitmaps", USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("To move the camera, use arrow keys, 'f', 'b'  <ESC>  -  Exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera=Morfit_camera_get_default_camera();


Morfit_camera_set_chase_type(camera,NO_CHASE);


while( (GetAsyncKeyState(VK_ESCAPE)==0 ) {



Move_camera(camera);



Morfit_engine_render(NULL,camera);



}

}

void Move_camera(DWORD camera)

{


double x,y,z;


//Gets camera's location coordinates 


Morfit_camera_get_location(camera, &x,&y,&z);


if(GetAsyncKeyState(VK_UP) < 0) // move camera up



z +=25;


if(GetAsyncKeyState(VK_DOWN) < 0) // move camera down



z -=25;


if(GetAsyncKeyState(VK_RIGHT) < 0) // move camera right



y +=25;


if(GetAsyncKeyState(VK_LEFT) < 0) // move camera left



y -=25;


if(GetAsyncKeyState('B') < 0) // move camera back



x +=25;


if(GetAsyncKeyState('F') < 0) // move camera forward



x -=25;


Morfit_camera_set_location(camera, x, y, z);


return;

}

Listing 1.2

Help, My world won’t load!

Inevitably, at some point in your program, you will try to run a program, and it will completely fail.  Here are some tips:

Log Files

Two log files are created every time you run a program that uses the Morfit Engine: morfit.log and error.log.  These files will be created in your program’s working directory.  Check them to see what is wrong- you will find out whether the engine simply couldn’t find your world, or if the world file was somehow corrupted (for example, you modified it manually and made a mistake).  These files can be useful sources of information.

Where is the World?

For all examples in this book, the world file must be in your program’s working directory.  By default, that is the directory that contains your program’s executable.  We override that by setting the working directory in the Project->Settings menu.  The alternative would be to leave the working directory where it is, and specify the directory of the world when you call the Morfit_engine_load_world() function.

I See My Objects, But No Bitmaps!

By default, the bitmaps are stored in a directory called “Bitmaps” which is located in the same directory as your world file.  Because the world file is located in the working directory (“.”), the bitmaps should be located in the directory “Bitmaps”.  Make sure that the call to Morfit_engine_load_world() specifies the correct directory.

I See the Object, But When I Get Its Handle, It’s Always NULL!

What probably happened here is that you forgot to make the object dynamic.  You will learn more about dynamic objects in Chapter 3, but for now, just remember that if you want to access an object, it must be dynamic.  Otherwise, an attempt to get its handle will return NULL.

Hardware Acceleration

If you have a 3D graphics accelerator card, the Morfit Engine can use it to speed up rendering.  Also, certain special effects are only available when you use hardware rendering.  To enable your 3D card, just press CTRL-ALT-V while any program is running.  We will look at hardware rendering in more detail in the coming chapters.

Summary

In this chapter, we learned how to create a simple world using World Builder.  We created a camera and set the camera’s path through the world.  We viewed that world first using the built-in World Viewer, and then by writing our own program to view the world.  We then used the Morfit camera API to take control of the camera.  Finally, we looked at a few of the common errors that you will see when writing Morfit programs.  While the list is not complete, it will provide you with a head start in identifying many common errors.

In the coming chapters we will explore the Morfit APIs in more detail.

The next chapter looks at some of the basic concepts that will help you program 3D graphics, and an overview of the Morfit API.

Chapter 2 – The Basics

This chapter will introduce several basic concepts that will help you understand the sample programs in this book, and help you write your own programs.  First the 3D coordinate system is introduced.  The difference between the world’s axes and an object’s axes is explained, first in two dimensions and then in three. The concept of a handle will be explained briefly.  If you already understand these subjects, feel free to skip to the final section of this chapter, “An Overview of the Morfit API.” 

2D Coordinates

To understand the 3D coordinate system, let’s briefly review the concepts in two dimensions.

[image: image5.png]yais

o1 02



[image: image6.png]2[001]

*[100]

y010) vt

x[100]

2[00-1]




The positive x-axis is a line running up from the origin through the point (1,0).  This can be written as the vector [1,0].  Note that this vector can also be written as [2,0] or [17,0].

The positive y-axis is numbered left to right, and can be represented in the same way as [0,1] (or [0,4.5]).

The negative x-axis, going down, is [-1,0], and the negative y-axis goes to the left, [0,-1].

World Space

Let’s consider these axes the “World coordinate system, ” or World Space.  The positive x-axis will always point to the top of the page, and the y-axis will always point to the right.

Now pretend that a car is sitting at the origin, driving down, in the direction of the negative x-axis.  To drive forward, the car moves in the direction [-1,0].

Now pretend the car is turned to the right, in the direction of the positive y-axis.  To move forward, the car must move in the direction [0,1]. 

Object Space

Our goal is to define a coordinate system such that whenever the car moves forward, it will always move in the direction of its x-axis.  To do this, we must give the car its own independent set of axes. Let’s define the car’s positive x-aas always pointing out the back of the car, and its y-axis pointing to the left side of the car:
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Now, no matter what direction the car is facing, it can always drive forward by moving in the direction        [-1,0].
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The difference between these two coordinate systems is very important to understand.  Look at the above picture.  In the car’s object coordinate system, the car moves forward in the direction [-1,0].   In the world coordinate system, the car drives forward in the direction [1,1].

In the world coordinate system, the x and y-axes are always represented by the vectors [1,0] and [0,1].  An object’s axes can move with the object.  In the above picture, the car’s x-axis is represented by the world coordinate vector [-1,-1], and its y-axis is [-1,1].

Morfit’s engine will convert vectors between the two systems, and many functions will accept coordinates in either world space or object space.  However, a clear understanding of the difference between these systems is crucial in order to obtain the effects that you desire.

3D Coordinates

The same principles apply in a 3D coordinate system.  Morfit uses a right-handed coordinate system.  Think of the positive x-axis as pointing straight out the front of the screen.  The negative x-axis points into the back of the monitor.  The positive y-axis points to the right side of the screen, the negative y-axis to left.  The z-axis is positive moving towards the top of the screen and negative moving towards the bottom.
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A car driving straight into the screen moves in the direction [-1 0 0], and one moving to the right moves in the direction [0 1 0].  A helicopter rising towards the top of the screen moves towards [0 0 1].  These are all using world coordinates.

To use an object’s object space, just attach a set of axes to it, with the x-axis pointing straight back, the y-axis pointing to the right, and the z-axis pointing up.  For example, a rocket ship shooting straight up into the air would have x, y, and z-axes of [0 0 –1], [0 1 0], and [1 0 0], respectively.

[image: image10.png]Table Object

Leapeboon. 1} tabletop_palygon

Leg_polgon_1_2

Leg_polgon_4_4

Lea polboon 2.4 |y popoon




Vector addition

Let’s say we want to know the coordinates of the location n units in front of the object.  In the object’s coordinate system, that would be the location [-n, 0, 0].  But what would that be in world coordinates?  Well, if the object facing directly into the screen (that is, its direction is [-1. 0, 0]), then the desired point would simply be [current_x_location – n, current_y_location, current_z_location].  But what if the object is facing an arbitrary direction [dir_x, dir_y, dir_z]?  First, we must make sure that the direction vector is a unit vector- that is, its magnitude is 1.  The magnitude of a vector is defined as √(x2+y2+x2).  Therefore:

unit_direction = [dir_x, dir_y, dir_z ]/ √(x2+y2+x2)

The location n units in front of the object is:

location_in_front  = current_location + n * unit_direction

One use of this function is to find an object’s next location, given its current speed and direction.  If direction is a unit vector, then:

new_location = current_location + speed * direction

Vector Subtraction

Moving an object forward is an example of vector addition- you are adding a multiple of the object’s direction vector to its current location.

To find a vector from one object to another, you would use vector subtraction.  For example, suppose that a camera is located at cam_pos = [cx, cy, cx], and an object is located at obj_pos = [x, y, z].  If you want to find out what direction the camera would need to face in order to view the object, just subtract the camera’s location from the object’s location:

direction = obj_pos – cam_pos

Note- this is the same as:

dir_x = x – cx

dir_y = y – cy

dir_z = z – cz

The distance between the camera and the object is simply the magnitude of this vector: √(dir_x2+dir_y2+dir_z2).

Planes

The final 3D object that we will consider is the plane.  A plane can be described by the following equation:

Ax + By + Cz + D = 0

For example, the plane that contains all points where x=-4 can be written:

x + 0y + 0z + 4 = 0

A plane’s normal is defined as the vector perpendicular to the plane.  While there are an infinite number of lines perpendicular to any plane, they all have the same (or exact opposite) direction, and this is what is important.  For example, the vector normal to the xy plane (that is, the plane z=0) is the z-axis, either the positive z-axis  (the vector [0, 0, 1]) or the negative z-axis (the vector [0, 0, -1]).

In general, to find the normal to a plane Ax + By + Cz + D = 0 is the vector [A, B, C].

HANDLES

In order to manipulate just about anything in the Morfit API, you need to know its handle.  Every camera has a handle and every object has a handle.  Bitmaps have handles, and polygons have handles.

A handle is defined as a DWORD (just another name for an unsigned int).  That means if you pass any unsigned integer to a function that expects a handle, the compiler will not complain.  If you pass a camera handle instead of an object handle, the compiler will not know the difference.  At runtime, however, a MessageBox will pop up and inform you of the error.  The same thing will happen if you pass in a NULL handle, or a handle to an object that has been destroyed.  The MessageBox informs you of the problem, and the function in which it occurred.

You can check for yourself that a handle is valid by calling the appropriate “is” function – Morfit_camera_is_camera(), Morfit_object_is_object(), etc.

 In the sample programs in Chapter 1, we obtained the camera’s handle using the Morfit_camera_get_default_camera() function.  We could have gotten the handle using the camera’s name (Morfit_camera_get_using_name(“my_camera”)).  Note that it is preferable to get the camera’s handle (or any object’s handle) only once, and use it throughout the program, rather than using these functions to get the handle each time it is needed.

We have functions to cycle through all of the cameras in the world: Morfit_camera_get_first_camera() and Morfit_camera_get_next_camera().  We will see an example of cycling through handles in Chapter 3.  Similar functions are available to get handles for objects, bitmaps, groups, etc.

An Overview of the Morfit API

The Morfit API is comprised of a number of groups of functions.  Each group of functions is used to control a different aspect of the 3D world that you have created.  Some of the important groups of functions are: the camera API, the object API, the engine API, the polygon API, and the bitmap API.

All Morfit functions are preceded by the word Morfit and  the name of the function group.  For example, Morfit_camera_get_location(), Morfit_engine_load_world(), and Morfit_object_set_direction().

Morfit provides a description of each function and the parameters that it requires.  Make sure that “Use Extension Help” in the help menu is checked.  Select Help->Contents, and double click on Morfit Help.  Alternatively, just position the cursor over the name of a function and press F1.

In addition, the Morfit header file mrft_api.h provides a description of every function in the API.

What follows is a brief description of the Morfit APIs.  The chapters that follow provide an in depth look at the functions in each group.

The Object API

The Object API is used to control the behavior of objects in your world.  Available objects include people, buildings, vehicles, walls, blocks, or trees.  You can also use the World Builder to create new objects of any kind.  Objects can be created and destroyed, moved and rotated.  The API provides collision detection – can your car move forward, or will it bump into a wall?  You can set an object’s physical properties – elasticity, friction, and force, for example – and have your object move according to the laws of physics.   Other functions can be used  to access the polygons that make up an object.  You can even attach animations to objects.  The Object API is used when the world is loaded in Viewer Mode.  This API is covered in detail in Chapter 3.

The Camera API

You already have some experience with the Camera API from the programs in Chapter 1.  Its functions are used to select and position the cameras which your world.  It provides functions to rotate and zoom the camera, as well as tilt and focus.  Cameras can be controlled manually, set on tracks, or set to chase other objects.  This API is covered in Chapter 4.

The Group API

This API allows you to collect a number of polygons together and treat them as a single group.  This group can then be moved, rotated, or resized as a unit.  You can get the size of the group, or its bounding box.  Other functions will calculate or change the group’s center (the point around which it will be rotated or scaled.  The group’s physical properties can be set, as can its color or bitmap.  The Group API contains many of the same functions as the API Object API, but the Group API is generally used in Editor Mode while the Object API is used in Viewer Mode.  (Chapter 12 details the differences between Editor and Viewer Modes.)   The Group API is described in Chapter 6.

The Engine API

This API includes functions that effect the world as a whole, and the way in which it is displayed.  Its functions are used to load the world and display it on the screen.  Many of its functions effect the program’s performance and picture quality. For example, it provides functions to enable the use of the z buffer, or set the resolution of the display.  It can provide atmospheric effects, or maximize your display windows.  More details about the Engine API can be found in Chapter 7.

The Bitmap API

This API loads and alters bitmaps for use in your program.  Bitmaps are used to give color and texture to your objects.  See Chapter 8 for details on the Bitmap API.

The Animation API

Use this API to display animation on a polygon- a series of bitmaps that shift over time.  Animation can be used to create effects such as fog, or show a person running as he moves through the world.  Animations are discussed along with bitmaps in Chapter 8.

The Polygon API

All objects are made up of a number of polygons.  This API controls those polygons- their shapes, colors, and bitmaps.  You can set lighting properties for a polygon- its transparency and brightness, for example.  You can retrieve the points that define a polygon, or add new points to it.  Polygons can be scaled, rotated, and moved.  You can check whether a point lies inside a polygon, or whether a line intersects it.  More advanced functions in this API can be used to create light and shadow effects.  The Polygon API is discussed in Chapter 9.

Other APIs

Other Morfit APIs include the Point API, the Background API, the Track API, and the 3D Card API.  These minor but still useful APIs are described briefly in Chapter 10.  For more details on these or any other API, you can look at Morfit Extension Help in Visual Studio, or examine the Morfit header file.

Summary

This chapter presented some of the fundamental concepts of the Morfit Engine: the coordinate system, world space, object space, and handles.  It also gave an overview of the Morfit APIs.  These are discussed in more detail in each of the following chapters.

Chapter 3 - Objects

Objects are the building blocks of your world.  Examples of objects include cars and trucks, walls and floors, trees and animals, tables and chairs.  After reading this chapter, you will be able to position and rotate objects, and control their movement through the world.

Many of the Morfit APIs have a very similar structure.  Once you learn how to control objects, you will find that you also know how to manipulate cameras, groups, and polygons.  For example, once you understand Morfit_object_set_track(), which causes an object to move through your world along a track, you should immediately feel comfortable using Morfit_camera_set_track() or Morfit_group_set_track().  

Most of the functions in this API fall into one of the following categories.  One set of functions is used to select and name objects.  The largest set of functions controls an object’s movement through the world.  Another group of functions is used for collision detection.  Other functions allow you to copy or destroy objects, and to create various effects.  These functions have been grouped under the title “Utility Functions.”

Keep in mind that the functions discussed in this chapter do not form a complete listing of the Object API.  When you feel comfortable with the material covered in this chapter, look in the Morfit header file or Morfit Help for an exhaustive description of the functions.  

Viewer Mode and Dynamic Objects

There are two main ways in which you can display your world: Viewer Mode and Editor Mode.  The mode you select affects both the performance of your program and the functions that you can use.  You specify the mode when you load your world:

Morfit_engine_load_world(world_file_name, world_directory_path, bitmaps_directory_path, world_mode);

The last parameter, world_mode, is what interests us here.  When you specify USER_DEFINED_BEHAVIOR, the world loads in Viewer Mode.  For Editor Mode, use the constant EDITOR_MODE.

The first time you load a world in Viewer Mode, a very large data structure called a Binary Space Partition Tree (or BSP tree) is created to contain all of the objects in the world. This structure is then saved in a file.  Once this structure is created, moving the camera around the world is a very fast operation.  The engine never needs to recalculate which objects and which surfaces are in front and which are hidden- all of this information is contained in the tree.

Once an object is placed into the tree, it cannot be moved- that would require recreating the whole structure.  If all objects were placed in this structure, nothing in the world would be able to move (except for the camera).  The solution is to have two types of objects- static objects, which are placed in the tree when the world is loaded and can never be moved, and dynamic objects, which are stored separately and can be moved.

It is these dynamic objects that are controlled using the Object API.  To make an object dynamic in the World Builder, right click an object, select “Properties of Object,” and select “Dynamic”.

When you load your world in Editor Mode, this data structure is not created.  Therefore, all objects, static or dynamic, can be manipulated.  To control objects in Editor Mode, the Group API is used (see Chapter 6).  The world is rendered more slowly in Editor Mode.  (This is actually only true when using software rendering.  When aided by a graphics accelerator card, the difference in speed is negligible.  We will discuss hardware rendering in Chapter 9).

Accessing and Naming Objects

As you learned in the previous chapter, in order to manipulate any object, you must first obtain its handle.  There are several direct ways in which to obtain an object’s handle.  The first is to specify the object’s name.  In the World Builder, you can specify an object’s name in the “Properties of Object” dialogue box.  Once the object has a name, your function can obtain its handle with a call to

DWORD Morfit_object_get_object_using_name(char *object_name);

At other times, you may want to cycle through all of the objects in the world.  You can accomplish this through the functions Morfit_object_get_first_object() and Morfit_object_get_next_object().

DWORD Morfit_object_get_first_object(void) returns a handle to the first object in the world.

DWORD Morfit_object_get_next_object(DWORD object_handle) takes the handle of one object, and returns the handle of the next object in the world.

You can use these functions to cycle through the list of objects as follows:

for(handle=Morfit_object_get_first_object() ; handle!=NULL ; handle = 
Morfit_object_get_next_object(handle) )


{


...


}

To check that an object handle is still valid (for example, to make sure that the object has not been deleted, or that the handle points to an object and not a camera), you can call the function

int Morfit_object_is_object(DWORD object_handle, char *function_asking);

This function returns YES if the handle is valid and NO if it is not.  If it is not valid, it will also pop up a message box whose title is the parameter function_asking.  If this parameter is NULL, no message box will pop up.

Tget the name of an object, use the function char * Morfit_object_get_name(DWORD object_handle).  You can change an object’s name using Morfit_object_set_name(DWORD object_handle, char * name);

Moving Objects

There are four main ways to control your object’s movement through the world.  You can control your object directly by specifying its position and direction.  Functions that move and rotate your object fall under this category.  Second, you can assign your object to follow a track that you have created.  Third, objects can be set to chase other objects.  Finally you can define your object’s physical properties and have your object follow the laws of physics.

Direct Control

These functions allow you the most control over the objects in your world.  We’ll take a look at a few of them, and write a program to get a feel for how they work.

The most basic of these functions is 

Morfit_object_set_location(DWORD object_handle, double x, double y, double z);

This takes the object and places it in the world at the location [x, y, z]. 

To set an object’s direction, call the function

Morfit_object_set_direction(DWORD object_handle, double x, double y, double z);

Here, [x y z] is a vector pointing in the direction you wish your object to face.  Remember from Chapter 2 that the x-axis points straight out from the screen, the y-axis points to the right side of the screen, and its z-axis points to the top of the screen.  So Morfit_object_set_direction(my_object, 0, -1, 0) will turn the object to face the left side of the screen.

All these functions have corresponding functions to get the object’s properties.  For example, 

Morfit_object_get_location(DWORD object_handle, double *x, double *y, double *z)

places the object’s current location into the variables x, y, and z.

If you want to move an object straight up, you could do the following:

double x,y,z;

Morfit_object_get_location(my_object,&x,&y,&z);

z += 10;

Morfit_object_set_location(my_object,x,y,z);

Another way to do this would be to use the Morfit_object_move() function, which moves the object relative to its current position:

Morfit_object_move(my_object,WORLD_SPACE,0,0,10);

Here is where the distinction between world space and object space that was discussed in Chapter 2 becomes very important.  Recall that the world space vector [-1 0 0] always points into the screen, while the object space vector [-1 0 0] always points straight in front of the object, no matter what direction it is facing. 

You can rotate an object around any of its axes with the Morfit_object_rotate() commands.  They all have the following form:

Morfit_object_rotate_x(DWORD object_handle, double degrees, int space_flag);

Here, degrees represents the number of degrees to rotate the object, and space_flag is either WORLD_SPACE or OBJECT_SPACE.

Let’s write a program to show how an object moves in object space.

The program will respond to keystrokes in the following way:

up
move the object forward along its x-axis

down
move the object backwards along its x-axis

left
move the object left along its y-axis

right
move the object right along its y-axis

<space> rotate the object 90 degrees around its z-axis

<esc>
quit

First, open the World Builder and create a world for the demo.  Select New, and use the BlankFloor template.  From the Transportation->Cars folder in the model gallery, select one of the cars and place it on the floor.  In the car’s properties, name it “my_car”.  Don’t forget to make it dynamic! If you leave it static, Morfit_object_ get_object_using_name(“my_car”) will return NULL.  Remember, in Viewer Mode, the only objects that you can move are dynamic ones.  Zoom back a little bit, so that you can see the car and some of the surrounding floor, and create a new camera.  Name it my_camera.  When you are finished, save your world into the Worlds directory.
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Figure 3.1

Now open Visual Studio and create a new Win32 Console application called Object1.  Add the Morfit library file to the project and set the program’s working directory to the directory containing the world file, just as you did in the example in Chapter 1.  The main function will look very similar to our sample program from Chapter 1, except that instead of calling the Move_camera function from inside the main rendering loop, we will call a function to move the car in response to a keystroke.  

In main(), we load the world just as we did before.  After getting a handle to the default camera, we also need to get a handle to the object my_car:

DWORD car=Morfit_object_get_object_using_name("my_car");

Let’s turn the car to face into the screen:

Morfit_object_set_direction(car,-1,0,0);

In order to turn the object in the specified direction, the engine must know which direction is the car’s front.  To the engine, an object is just a collection of polygons.  How does it know that a piano stands on its legs, and a car’s windshield is in the front?  We will see in Chapter 9 that polygons can specify their orientation- that is, whether they represent the top, bottom, front, or back of the object.  Since the engine knows which polygon represents the front of the car, it can turn that polygon to face the given direction.

Now we’ll write the function MoveCar.

First define how far the car should move with each keystroke:

const int speed = 20;

Now we’ll respond to the arrow keys.  The up arrow should move the car forward in whatever direction the car is facing, that is along its negative x-axis.

if (GetAsyncKeyState(VK_UP)<0)


Morfit_object_move(car_handle,OBJECT_SPACE,-speed,0,0);

The down arrow should move the car backwards, along its positive x-axis.

if (GetAsyncKeyState(VK_DOWN)<0)


Morfit_object_move(car_handle,OBJECT_SPACE,speed,0,0);

Left and right should move the car along its y-axis.

if (GetAsyncKeyState(VK_LEFT)<0)


Morfit_object_move(car_handle,OBJECT_SPACE,0,-speed,0);

if (GetAsyncKeyState(VK_RIGHT)<0)


Morfit_object_move(car_handle,OBJECT_SPACE,0,speed,0);

Finally, pressing the space key should turn the car to the left- that is, rotate it 90 degrees around the z-axis.

if (GetAsyncKeyState(VK_SPACE)<0)


Morfit_object_rotate_z(car_handle,90,OBJECT_SPACE);

The completed program is listed next.  Compile and run the program.  If the car moves too little or too much with each keystroke, adjust the constant speed until it looks better.

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{


void MoveCar(DWORD car_handle);


int rc=Morfit_engine_load_world("Object1.wld",".","Bitmaps",USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("Object movement demo   <esc> to exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera=Morfit_camera_get_default_camera();


DWORD car=Morfit_object_get_object_using_name("my_car");


Morfit_object_set_direction(car,-1,0,0);


while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



MoveCar(car);



Morfit_engine_render(NULL,camera);



}

}

void MoveCar(DWORD car_handle)

{


const int speed = 20;


if (GetAsyncKeyState(VK_UP)<0)



Morfit_object_move(car_handle,OBJECT_SPACE,-speed,0,0);


if (GetAsyncKeyState(VK_DOWN)<0)



Morfit_object_move(car_handle,OBJECT_SPACE,speed,0,0);


if (GetAsyncKeyState(VK_LEFT)<0)



Morfit_object_move(car_handle,OBJECT_SPACE,0,-speed,0);


if (GetAsyncKeyState(VK_RIGHT)<0)



Morfit_object_move(car_handle,OBJECT_SPACE,0,speed,0);


if (GetAsyncKeyState(VK_SPACE)<0)



Morfit_object_rotate_z(car_handle,90,OBJECT_SPACE);


return;

}

Listing 3.1

Now we’ll adjust the program to illustrate the difference between moving in object space and world space.  We’ll add responses to the following keystrokes:

 ‘w’
arrow keys will move the object in world space

‘o’
arrow keys will move the object in object space

Here is the new MoveCar function:

void MoveCar(DWORD car_handle)

{


const int speed = 20;


static int mode = OBJECT_SPACE;


if (GetAsyncKeyState('W')<0) 



mode = WORLD_SPACE;


if (GetAsyncKeyState('O')<0)



mode = OBJECT_SPACE;


if (GetAsyncKeyState(VK_UP)<0)



Morfit_object_move(car_handle,mode,-speed,0,0);


if (GetAsyncKeyState(VK_DOWN)<0)



Morfit_object_move(car_handle,mode,speed,0,0);


if (GetAsyncKeyState(VK_LEFT)<0)



Morfit_object_move(car_handle,mode,0,-speed,0);


if (GetAsyncKeyState(VK_RIGHT)<0)



Morfit_object_move(car_handle,mode,0,speed,0);


if (GetAsyncKeyState(VK_SPACE)<0)



Morfit_object_rotate_z(car_handle,90,mode);


return;

}

Listing 3.2

Type in and run this new program.  Note that it behaves identically to the car in the first example until you press the ‘w’ key.  Now using world coordinates, the left arrow key moves the object towards the left of the screen, no matter which direction the car is facing.  Move the car around.  Switch back and forth between the two coordinate systems until you are comfortable with them.

Moving on a Track

Setting an object’s position manually provides you with the most control over an object’s behavior. For other objects, Morfit provides a number of methods for the engine to control an object’s movement without your involvement.  The first one of these methods is through the use of tracks.

When you set an object to follow a track, the Morfit Engine will advance the object along the track each time you call the rendering function Morfit_engine_render().

The easiest way to create a track is by drawing one in the World Builder. To review the procedure for creating a track, please refer back to Chapter 1.  This section will describe how to place an object on a track and how to control its behavior while following the track.

In the World Builder, create a new world using the BlankRoom template.  Place a few objects in the room- I placed a piano, a table, and a chair.  Now draw a track around the room and name it “mytrack”.  Add a man- I used the running man, located in the “People->Running” folder in the gallery.  Open up the Property of Object dialogue box, and rename it “man”.  Don’t forget to make it a dynamic object.  Next, create a camera.

Note: the easiest way to make the man follow the track that we have created is to use this dialogue box.  You would set Track to “mytrack,” ChaseType to “Track,” and Speed to a positive number.  Instead, leave these settings alone.  We will do it manually from within our program.  Save the world- name it “track.wld”.

Create a new project and set it up just as you did the last one.  After loading the default camera, add the following lines of code:

DWORD man=Morfit_object_get_object_using_name("man");

DWORD track=Morfit_track_get_using_name("mytrack");

These lines retrieve the handles of the man and the track.

The Morfit_set_chase_type() function specifies what you want your object to follow.  Most of these options will be covered in the section below, “Chasing Objects.”  For now we are interested in two choices: CHASE_TRACK and CHASE_TRACK_AIRPLANE.  Both cause the object to follow a track.  In the first case, sharper turns are made.  In the second, the object banks around and turns gradually, like an airplane.  We will call:

Morfit_object_set_chase_type(man, CHASE_TRACK);

Now you need to specify which track to follow (a world can have multiple tracks):

Morfit_object_set_track(man,track);

Set the man’s speed as he moves around the track:
Morfit_object_set_absolute_speed(man,20);

Run the program.  Notice that you don’t need to call any special functions.  The man automatically moves around the track.  Each time the Morfit_engine_render() function is called, the object advances along the track.

Here is a complete listing of the program:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{


void Move_man_on_track(DWORD man,DWORD track);


int rc=Morfit_engine_load_world("track.wld",".","Bitmaps",USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("esc to exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera=Morfit_camera_get_default_camera();


DWORD man=Morfit_object_get_object_using_name("man");


DWORD track=Morfit_track_get_using_name("mytrack");


Morfit_object_set_chase_type(man, CHASE_TRACK);


Morfit_object_set_track(man,track);


Morfit_object_set_absolute_speed(man,20);


while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



Morfit_engine_render(NULL,camera);



}

}

Listing 3.3

One problem that you may notice (if you use the same man that I did) is that the man seems to have sunk into the floor.  The middle of his body seems to be following the track just fine, but his legs are beneath the ground!  To solve this problem, we will take advantage of the concept of a track offset.

When you set an object to follow a track, the Morfit Engine will ensure that the exact center of the object passes through each of the track points.  What we desire is that the bottom of the man- his feet- pass through each point on the track.  A track offset allows you to tell an object to follow a track from a set distance.  For example, you can define a track along the ground, and have a jeep drive along the track.  You can have an airplane follow the same track, with an offset vector of [0 0 150], and it will fly along the 150 units above the track.  We will see another use of the track offset when we look at the Morfit_object_set_falling_from_track() function below.

We would like the middle of the man’s body to follow a certain height above the track, so that his feet will be on the floor.

[image: image12.png]


As the above figure illustrates, we would like the center of the man’s body to follow a track half the man’s height above the ground.  This will ensure that his feet are on the floor.  To get the man’s height, we use the function 

Morfit_object_get_bounding_box(DWORD object_handle, double box[2][3]);

This calculates the minimum and maximum x, y, and z coordinates and places them in the box array as follows:

box[0][0] is the minimum X

box[0][1] is the minimum Y

box[0][2] is the minimum Z

box[1][0] is the max X 

box[1][1] is the max Y

box[1][2] is the max Z

The man’s height is obtained as follows:

double box[2][3];

Morfit_object_get_bounding_box(man,box);

double height = (box[1][2]-box[0][2]);

We then set the track offset by specifying a vector half the man’s height above the track:

double up[3]={0,0,height/2};

Morfit_object_set_track_offset(man,up);

Add these lines of code to the main function and run the program.  Now the man walks along the track properly.

Note:  When you set an object to follow a track using the World Builder, the track offset calculations are done automatically.  It is only when you set an object to follow a track from within your program that you need to worry about this.

That’s how easy it is to use tracks.  Just set the object to chase the track, set the object’s speed and offset, and the engine worries about the rest.  Note that if you want an object to stop following a track, do not try the following:

Morfit_object_set_track(man,NULL);

The engine will ignore this command.  What you want to do is the following:

Morfit_object_set_chase_type(man, NO_CHASE);

This is all that you need to know to use tracks.  Of course, you can set an object to follow a track from within the World Builder, and not even need to write a single line of code.  However, for a deeper understanding of how tracks  function, we will modify our example one more time.  Let’s look at two ways in which we can set an object to follow along a track we have created in reverse.

The Morfit Engine stores a track internally as a series of points.  Each point has an index: the first point on the track has an index of 0, the next point has an index of 1, and so on, up to an index of number_of_points-1.  Each time you call Morfit_engine_render(), the engine calls the Morfit_object_advance() function for each dynamic object that is following a track.  It looks at which point the object is moving towards, and moves the object towards that point.  (How far toward the point depends on the object’s speed.)  When the object reaches a point, the engine advances the track index to the next point on the .

The following functions will be useful to us:

int Morfit_track_get_number_of_points(DWORD track_handle);

int Morfit_object_get_next_point_on_track(DWORD object_handle);

int Morfit_object_set_next_point_on_track(DWORD object_handle, int point_index);

The first function returns the number of points on the given track.  The next function returns the index number of the point that the object is moving towards.  The third function sets the point on the track that the object should move towards.

We will use the following method to move the object backwards along the track: first, we will store the object’s current destination.  We will keep checking this destination to see when it changes.  When it changes, it must mean that the object has reached one destination point, and the engine is getting ready to move it to the next. Instead, we will decrement the destination index to start the object moving towards the previous point on the track instead of the next one.  Once we set the destination index, the engine will take care of the rest for us by moving the object towards its new destination.

This procedure is implemented in the following function, which you should call from within the main rendering loop.

void Move_man_backwards_along_track(DWORD man,DWORD track)

{


static int last_destination = -1;  // keep track of last destination


int points = Morfit_track_get_number_of_points(track);


int destination = Morfit_object_get_next_point_on_track(man);


if (destination != last_destination) { 

       
// destination has changed



// decrement destination index

       
int new_destination = last_destination-1; 

       
// wrap from 0  back to the end of the track



if (new_destination <0) new_destination = points; 



Morfit_object_set_next_point_on_track(man,new_destination);



last_destination = new_destination;


}


return;

}

Listing 3.4

There is another way to follow a track backwards.  We can create an identical track whose points are listed in the opposite direction.  Since it would be very difficult to do this in World Builder and match up the points exactly, we will do it by editing the world file directly.

Open up the world file “track.wld” in any text editor- you can open it up in Visual Studio.  As you can see, a world file is just a plain text file that describes everything in the world- the objects, the polygons, the camera, the tracks, etc.  Do a search for the text “mytrack”.  You will find a section that looks something like this (the exact numbers, of course, will depend on the track that you defined):

TRACK: mytrack


CYCLIC: YES


256.681 -238.554 -400


-400 -361.511 -379.905


-370.389 67.0213 -400


-38.5786 44.2623 -400

45.8104 313.636 -400


336.769 229.891 -400


388.992 -40.9091 -400


360.093 -189.474 -400

END_TRACK: mytrack

Each of these lines is just the x, y, and z coordinates of a point on the track, begin with point 0 and ending with point 7.  Copy and paste this section of the file, and modify the new copy by reversing the order of the points.  Give it a new name.  You will wind up with something like this:

TRACK: mytrack_backwards


CYCLIC: YES


360.093 -189.474 -400


388.992 -40.9091 -400


336.769 229.891 -400


45.8104 313.636 -400

-38.5786 44.2623 -400


-370.389 67.0213 -400


-400 -361.511 -379.905


256.681 -238.554 -400

END_TRACK: mytrack_backwards

Now you can set the man to chase “mytrack” or “mytrack_backwards” and the engine will take it from there.  For more on how to manually edit the .wld file, see Chapter 14.

Chasing Objects

In the previous section we looked at how to set an object to move along a track.  Here we look at another type of automatic movement: the chase.  Any dynamic object can chase any other dynamic object.  Objects can chase cameras, and as we will see in the next chapter, cameras can chase objects.  There are four factors that effect how an object chases another: the chased object, the chase offset, the chase type, and the chase softness.  We will look at each of these four properties.

The Chased Object

The chased object can be either a dynamic object, a camera, or a group.  To set the object to chase, call:

Morfit_object_set_object_to_chase(DWORD object_handle, DWORD object_to_chase_handle);

Morfit_object_set_camera_to_chase(DWORD object_handle, DWORD camera_to_chase_handle);

Morfit_object_set_group_to_chase(DWORD object_handle, DWORD group_to_chase_handle);

To find out what object is currently being chased:

DWORD Morfit_object_get_chased_object(DWORD object_handle);

DWORD Morfit_object_get_chased_camera(DWORD object_handle);

DWORD Morfit_object_get_chased_group(DWORD object_handle);

Note that an object can only track one thing at a time.  For example, if an object is currently chasing a group, and you call Morfit_object_set_camera_to_chase(), the object will stop chasing the group and start chasing the camera.

Also, do not try to cancel a chase by calling:

Morfit_object_set_object_to_chase(object, NULL);

This will not cancel the chase.  Instead, use:

Morfit_object_set_chase_type(NO_CHASE);

You can also set this option in the World Builder.  Just select the object’s properties, make it a dynamic object, and select the object to chase from the list.

Chase Offset

The chase offset defines how far away the chasing object remains from the chased.  For example, if the chase offset is [0, 0, 20], then the chasing object will follow the chased object, but will remain 20 units above it.  If the chase offset is [10, 10, 0], then the chasing object’s x and y-coordinates will remain 10 units greater than the chased object..  Note that the chasing object’s speed is irrelevant- it will remain the given distance away from the object no matter how fast the object is going.

The precise manner in which the offset is interpreted is determined by the chase type- see the next section for details.

To set an object’s chase offset:

Morfit_object_set_chase_offset(DWORD object_handle, double offset[3]);

To get the current offset:

Morfit_object_get_chase_offset(DWORD object_handle, double offset[3]);

When you use the World Builder, you do not have to specify the chase offset.  It will be calculated automatically based on the distance between the two objects.

You can also set an object’s chase distance.  This represents how far it will remain from the chased object.  It has an advantage over chase offset, which you can see when the chased object turns.  When you use chase distance and the chased object turns, the engine will automatically recalculate the chaser’s location to remain in the same position behind the chased object.

Morfit_object_set_chase_distance(DWORD object_handle, double chase_distance);

double Morfit_object_get_chase_distance(DWORD object_handle);

Chase Type

The chase type controls the manner in which one object chases another.  There are three possible chase types:  precise, location, and flexible.

When using chase precise, the chasing object remains in exactly the same position relative to the chased object.  For example, suppose that a helicopter is chasing a car from above and behind- that is, at an offset of [10, 0, 10].  If the car turns, the plane will swing around to remain in precisely the same position, above and behind the car.  If the car rotates, the plane will rotate with the car.

Chase location works in the same way as chase precise, except that the helicopter will not rotate to match the car’s rotation.  It will maintain the same distance from the car, but not the same rotation.

Chase flexible allows the chasing object a little bit more freedom.  It doesn’t turn sharply in response to moves of the chased object.  Instead, it banks more softly, even if this means that its offset from the chased object deviates a little bit. 

You can select an object’s chase type with the following function:

Morfit_object_set_chase_type(DWORD object_handle, int chase_type);

chase_type should be one of the following constants:  CHASE_PRECISE, CHASE_LOCATION, CHASE_FLEXIBLE, and NO_CHASE.  Use NO_CHASE to cancel a chase.

The following function returns the current chase type:

int Morfit_object_get_chase_type(DWORD object_handle);

An object’s chase softness is used to determine how shthe chasing object turns when using chase flexible.  You can control an object’s chase softness with:

Morfit_object_set_chase_softness(DWORD object_handle, double softness);

double Morfit_object_get_chase_softness(DWORD object_handle);

The softness is set on a scale from 0 to 1.

In the World Builder, you can select a chase type and softness by bringing up the object’s properties.  Not that in the World Builder, softness is on a scale from 0 to 10- the value that you type in is divided by 10 to result in the actual softness.


The best way to understand the difference between the chase types is with a sample world.  Create a world in the World Builder based on the BlankFloor template.  Create two objects- say, a car and a helicopter.  Create a track for the car to follow.  Make the car a dynamic object, and set it to follow the track with chase type TRACK.  Make sure to give the car a speed.  Now make the helicopter a dynamic object.  Set it to chase the car.  Try it first with chase type PRECISE.  Save the world, and open it in the Viewer.  When you understand how chase precise works, close the Viewer and change the chase type.  Try both location and flexible, and experiment with different softness values.

Physics

Rather than specifying a path or object for your object to follow, you can set an object to follow the laws of physics.  You specify an initial speed and direction, set the object’s various physical properties, and the Morfit Engine takes care of the rest.

To instruct an object to follow the laws of physics,  you set its chase type to CHASE_PHYSICS.  To cancel its automatic motion, just set the chase type back to NO_CHASE.

The object’s initial velocity is a vector [x y z] that specifies the object’s speed in each direction.  For example, an initial speed of [10 0 10] would send the object shooting up and to the right.  You can specify this speed in one of two ways:

double speed[3]={10 0 10};

Morfit_object_set_speed(object_handle,speed);

Or you can specify the vector’s direction using Morfit_object_set_speed(), and then set the magnitude using Morfit_object_set_absolute_speed().  Recall from Chapter 2 that a vector’s magnitude is sqrt(x2+y2+z2), which here is √(102+02+102) or √(200), approximately 14.14.

double speed[3]={1 0 1};

Morfit_object_set_speed(object_handle,speed);

Morfit_object_set_absolute_speed(14.14);

Why would you want to set the direction and magnitude of the speed separately?  You might want to send a number of objects flying in the same direction at random speeds:

Double direction[3]={.4, .6, .8};

for (j=0;j<5;j++);

{

Morfit_object_set_speed(object[j],direction);

Morfit_object_set_absolute_speed(object[j],rand());

}

When you start an object with a random initial velocity, you will often want to restrict certain directions.  For example, if an object is sitting on the ground, you usually do not want it to fall down any farther.  You want to ensure that the z value of its initial velocity is positive.  Here is an example:

double direction[3]={rand(),rand(),rand()};

if (direction[2]<0) direction[2]=-direction[2];

Morfit_object_set_speed(object,direction);

Morfit_object_set_absolutee_speed(object,50);

Once you have set the object’s initial velocity, you need to set a few other physical properties using the following functions:

Morfit_object_set_max_speed(DWORD object_handle, double max_speed);

Morfit_object_set_friction(DWORD object_handle, double friction);

Morfit_object_set_elasticity(DWORD object_handle, double friction);

Morfit_object_set_force(DWORD object_handle, double[3] force);

The max_speed property sets a cap on the object’s maximum absolute speed.

Friction acts on the object’s speed as follows:

0:

No friction

Between 0 and 1:
Object slows down each time the world is rendered.  The higher the number, the faster it slows.

1:

Infinite friction- the object will stop immediately.

Less than 0:
The object will accelerate each time the world is rendered.

The exact calculation used is that every time Morfit_engine_render() is called, the object’s absolute speed will be multiplied by (1-friction).  Note that a value of –1 means that the object’s speed will be doubled each rendering cycle- the objects can get very fast very quickly.  Typical values of friction are between -.03 and .03.

The object’s elasticity affects how the object bounces off surfaces.  When a collision occurs, the object’s absolute speed will be multiplied by its elasticity value.  Therefore, a value of 1 means that the speed will remain unchanged after a collision.  A value of .5 will cause the object to bounce back at half its original speed, an elasticity of 2 will double the object’s speed after the collision.

Force is a vector that can be used to simulate gravity.  A force of [0 0 –1] acts like gravity- it presses the object down.  You can change this vector to create various effects.  For example, [0 0 1] will pull objects towards the ceiling, [1 1 0] towards a corner of the room.   A world set on the moon might have a smaller force vector (e.g. [0 0 -.01].

Let’s create an example world and see how physics produces realistic-looking behavior.  Open the World Builder and create a new world from the BlankRoom template.  From the “3D objects” folder in the gallery, pick one of the spheres.  Place four of them on the floor of the room.  You might want to make them smaller.  Rename them ball1, ball2, ball3, and ball4, and make them all dynamic objects.  Create a camera.  Save the world with the name “physicsdemo.wld”.

In Visual Studio, create a new console application named “physics”.  Add the Morfit library file to the project, and set the project’s working directory as in previous programs.  The basic structure of this program is the same as the others.

After loading the default camera, get the handle of each of the balls:

DWORD ball[4];

ball[0]=Morfit_object_get_object_using_name("ball1");

ball[1]=Morfit_object_get_object_using_name("ball2");

ball[2]=Morfit_object_get_object_using_name("ball3");

ball[3]=Morfit_object_get_object_using_name("ball4");

Next, let’s call an initialization function to set the balls’ physical properties:

for (int i=0;i<4;i++)



init(ball[i]);

In the init() function, first set the object to chase physics:

void init(DWORD ball) {


Morfit_object_set_chase_type(ball, CHASE_PHYSICS);

Next set the ball’s starting velocity.  We’ll give each ball a random direction and speed.  Since the balls are on the floor, restrict their initial z direction to positive values.

double speed[3]={rand(),rand(),rand()};

if (speed[2] <0) speed[2]=-speed[2];

Morfit_object_set_speed(ball, speed);

Morfit_object_set_absolute_speed(ball,rand()*200);

Now set the other physical properties:


Morfit_object_set_max_speed(ball,150); 


Morfit_object_set_friction(ball,0);


Morfit_object_set_elasticity(ball,.7);


double force[3]={0,0,-1};


Morfit_object_set_force(ball,force);


return;

}

There is one more thing that we want to do.  Because the friction value is positive (and the elasticity is less than 1) the balls will gradually slow down.  Let’s restart them if their speed gets too low.  In a function restart_stopped_balls, check the speed of each ball.  If it’s very small, just call the init() function to start the ball moving again.

void restart_stopped_balls(DWORD ball[4])

{


double speed;


for (int i=0;i<4;i++)


{



speed= Morfit_object_get_absolute_speed(ball[i]);



if (speed<.5)




init(ball[i]);


}


return;

}

Just call this function inside the main rendering loop, and you’re done.  Here is the complete program:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{


void init(DWORD ball);


void restart_stopped_balls(DWORD ball[4]);


int rc=Morfit_engine_load_world("physicsdemo.wld",".","Bitmaps",USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("esc to exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera=Morfit_camera_get_default_camera();


DWORD ball[4];


ball[0]=Morfit_obje_get_object_using_name("ball1");


ball[1]=Morfit_object_get_object_using_name("ball2");


ball[2]=Morfit_object_get_object_using_name("ball3");


ball[3]=Morfit_object_get_object_using_name("ball4");


for (int i=0;i<4;i++)



init(ball[i]);


while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



restart_stopped_balls(ball);



Morfit_engine_render(NULL,camera);



}

}

void init(DWORD ball)

{


Morfit_object_set_chase_type(ball, CHASE_PHYSICS);


double speed[3]={rand(),rand(),rand()};


if (speed[2] <0) speed[2]=-speed[2];


Morfit_object_set_speed(ball, speed);


Morfit_object_set_absolute_speed(ball,rand()*200);


Morfit_object_set_max_speed(ball,150); 


Morfit_object_set_friction(ball,0);


Morfit_object_set_elasticity(ball,.7);


double force[3]={0,0,-1};


Morfit_object_set_force(ball,force);


return;

}

void restart_stopped_balls(DWORD ball[4])

{


double speed;


for (int i=0;i<4;i++)


{



speed= Morfit_object_get_absolute_speed(ball[i]);



if (speed<.5)




init(ball[i]);


}


return;

}

Listing 3.5

Run the program and watch the balls move around.  Play with some of the constants- elasticity, friction, and force- and see how the balls’ movement is effected.

Collision Detection

Collision detection is often very important when designing a 3D game.  Morfit makes it very easy to detect collisions with the Morfit_object_is_movement_possible() function.  This function is used as follows: you provide the starting point and ending point of a line.  The function returns true if any another object (or polygon) is intersected by that line.  If an intersection is found, the function also returns the coordinates of the intersecting point, a handle to the polygon that was intersected, and a handle to the object that the polygon belongs to.  The syntax of the function is as follows:

int Morfit_object_is_movement_possible(DWORD object_handle ,double start_location[3], double end_location[3], DWORD *intersected_polygon, double intersection[3], DWORD *blocking_object);

The function returns YES if movement is possible and NO if it is not.  If it returns NO, and blocking_object is NULL, then the collision was with a static part of the world.

You may want some objects to be non-collisional.  For example, you may want an airplane to be able to pass through a cloud.  You can accomplish this with the following function:

Morfit_object_make_non_collisional(DWORD object_handle);

Related functions include:

Morfit_object_make_collisional(DWORD object_handle);

int Morfit_object_is_collisional(DWORD object_handle);

Let’s look at an example to see collision detection at work.  Use the World Builder to create a new world based on the BlankFloor template.  Add a few buildings to the world, then add a car.  Name the car “mycar” and make it a dynamic object.  Create a camera that will give you a good view of the world, and save the world as “collision.wld” in the Worlds directory.

In Visual Studio, create a new Console Application.  Set it up like the previous examples (set the working directory, add the library, etc.).

We will use the following method to implement collision detection.  We will draw a line from the front of the car straight ahead speed units.  If there is no collision detected, we will move the car forward.  Note that this is a simplified method.  For example, it will allow the corner of the car to pass through objects, as long as there is nothing located directly in front of the center of the car.  To solve this, we could test for collisions in multiple places in front of the car, but our method will be sufficient to illustrate the concept of collision detection.

When you use the Morfit_object_get_location() function, you will get the coordinates of the center of the truck.  To get the coordinates of the front of the truck, we will use the following, where [x y z] is location of the center of the car and [dir_x, dir_y, dir_z] is a unit vector that gives the direction of the car:

front_of_car[0]=x + dir_x * half_car_length;

front_of_car[1]=y + dir_y * half_car_length;

front_of_car[2]=z + dir_z * half_car_length;

A point speed units in front of the car can be calculated in the same way:

ahead_of_car[0]=front_of_car[0] + dir_x *speed;

ahead_of_car[1]=front_of_car[1] + dir_y * speed;

ahead_of_car[2]=front_of_car[2] + dir_z * speed;

We can then check for a collision, and move forward if possible:

DWORD intersecting_polygon;

DWORD intersecting_object;

double intersection_point[3];

if (Morfit_object_is_movement_possible(car_handle, front_of_car, ahead_of_car, &intersecting_polygon, intersection_point, &intersecting_object))


Morfit_object_move(car_handle,OBJECT_SPACE,-speed,0,0);

That’s all that is required.  Here is a complete listing of the program.  Note that in the main function we get the bounding box to calculate the length of the car (see the section on Tracks, above, for a description of this function).

#include "..\\..\\..\\..\\Include\\mrft_api.h"

#include <iostream.h>

void main(void)

{


void MoveCar(DWORD car_handle,double half_car_length);


int rc=Morfit_engine_load_world("collision.wld",".","Bitmaps",USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("Object movement demo   <esc> to exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera=Morfit_camera_get_default_camera();


DWORD car=Morfit_object_get_object_using_name("mycar");


Morfit_object_set_direction(car,-1,0,0);


double box[2][3];


Morfit_object_get_bounding_box(car, box);


double half_car_length=(box[1][0]-box[0][0])/2;


while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



MoveCar(car,half_car_length);



Morfit_engine_render(NULL,camera);



}

}

void MoveCar(DWORD car_handle, double half_car_length)

{


if ((GetAsyncKeyState(VK_LEFT)<0) ==1 )


{


Morfit_object_rotate_z(car_handle,10,OBJECT_SPACE);


}


if ((GetAsyncKeyState(VK_RIGHT)<0) ==1 )


{


Morfit_object_rotate_z(car_handle,-10,OBJECT_SPACE);


}


if ((GetAsyncKeyState(VK_SPACE)<0) ==1 )


{



const int speed = 20;



double x,y,z;



double dir_x,dir_y,dir_z;



double front_of_car[3];



double ahead_of_car[3];



Morfit_object_get_location(car_handle,&x,&y,&z);



Morfit_object_get_direction(car_handle,&dir_x,&dir_y,&dir_z);



front_of_car[0]=x+half_car_length*dir_x;



front_of_car[1]=y+half_car_length*dir_y;



front_of_car[2]=z+half_car_length*dir_z;



ahead_of_car[0]=front_of_car[0]+speed*dir_x;



ahead_of_car[1]=front_of_car[1]+speed*dir_y;



ahead_of_car[2]=front_of_car[2]+speed*dir_z;



DWORD intersecting_polygon;



DWORD intersecting_object;



double intersection_point[3];



if (Morfit_object_is_movement_possible(car_handle, front_of_car,ahead_of_car,&intersecting_polygon,intersection_point,&intersecting_object))




Morfit_object_move(car_handle,OBJECT_SPACE,-speed,0,0);


}


return;

}

Listing 3.6

Utility Functions

There are a number of other functions in the Object API that you may find useful.  This section will introduce a few of them.  For a complete list of functions in the API, look in the header file “mrft_api.h”.

Duplicating Objects

The Morfit_object_duplicate() function allows you to make a copy of an object.  For example, in the Physics example above, we could have created one ball and then duplicated it a number of times.  This would have allowed us to control dynamically the number of balls in the world.  The function is defined as follows:

DWORD Morfit_object_duplicate(DWORD object_handle, int duplicate_polygons_flag);

The object_handle parameter is the object to be copied.  The duplicate_polygons_flag tells the engine whether to make a copy of all of the polygons in the original object or not.  If it does not, then when you change a bitmap on one object, it will change the bitmap on the other object because they share the same polygons.  In general you will want to use YES.  The main reasons to use NO would be to save time or memory when copying a very large or complex object.

Enabling and Disabling Objects

There are times when you might want to temporarily remove an object from the world.  When an object is disable, it is not drawn, does not take part in collision detection, and uses no CPU time.  Disabling and enabling an object is much faster than deleting the object and recreating it later.  The related functions are:

Morfit_object_disable(DWORD object_handle);

Morfit_object_enable(DWORD object_handle);

int Morfit_object_is_enabled(DWORD object_handle);

Expiration Timer

There are times that you may want to disable or destroy an object after a certain delay.  For example, if a car drives through mud, you might want to show mud splashing into the air.  Instead of having to destroy it yourself after a few seconds, you can set the mud in motion (using the CHASE_PHYSICS functions) and set the mud to disable itself after 3 seconds.  The syntax of the command is:

Morfit_object_set_event(DWORD object_handle, int time_in_milliseconds, int event);

Here event is either MORFIT_DELETE or MORFIT_DISABLE, depending on what you want to happen to the object after the timer runs out.  To cancel the timer, call the function with time_in_milliseconds equal to 0.

It is a good idea to set an object’s handle to NULL after you delete the object in order to make sure that you don’t try to use the handle after you delete it:

Morfit_object_set_expiration_timer(obj_handle,1000, MORFIT_DELETE);

obj_handle=NULL;

Falling from a track

If your world is not completely flat, it is very difficult to specify an exact track for an object to move along on the ground.  For example, if the track is a simple square and it runs through hills or valleys, the object will sometimes pass through hills and sometimes be in the air.  To avoid this, you can define a track above ground (or define a track on the ground and use an offset to raise it up) and then call this function so that the object falls to the ground directly below the track.  In this way the object can move across hills and valleys, and the engine will automatically adjust its z coordinate to ensure that it stays on the ground.

Morfit_object_set_falling_from_track(DWORD object_handle, double
height_above_ground, int fall_through_dynamic_objects);

The object will fall until it reaches height_above_ground distance above the ground.  When fall_through_dynamic_object is YES, the object will pass through dynamic objects that lie below it (like planes), but still land on static objects (a building, or the ground).  When fall_through_dynamic_objects is NO, the object will land on the first object that it passes through.

Here is an example of using this function to ensure that a man runs on the ground along a track:

Morfit_object_set_chase_type(man, CHASE_TRACK);

Morfit_object_set_track(man,track);

double up[3]={0,0,200};

Morfit_object_set_track_offset(man,up);

Morfit_object_set_falling_from_track(man,0,YES);

Type Name

The object’s type name is a string field associated with each object that is now unused.  You can use it for your own purposes to store information about an object.  The functions to set and retrieve this field are:

int Morfit_object_set_type_name(DWORD object_handle, char *new_name);

char * Morfit_object_get_type_name(DWORD object_handle);

Automatically Advancing Objects

In Viewer Mode, every time you call Morfit_engine_render() to display the world, any object that is set to chase, to follow a track, or to move according to physics, will move according to their parameters.  At times, you might want to stop the object from advancing every time you render the world.  Use the following function to disable automatic motion:

Morfit_engine_advance_objects_automatically(int yes_no_flag);

When automatic motion is disabled, you can advance an object manually with:

Morfit_object_advance(DWORD object_handle);

Or, you can advance all objects with:

Morfit_object_advance_all();

Summary

The Object API allows you to manipulate objects in Viewer Mode.  You can control objects manually, or use automatic movement modes to instruct an object to follow a track, another object, or move according to physical properties.  In addition to functions controlling an object’s movement, the API also provides functions for collision detection, for copying, deleting, disabling, and naming objects.

Chapter 4 – Working With Cameras

No matter how rich your world is, no matter how many objects, animations, and special effects it contains, you cannot display it without the help of a camera.  The camera’s position and direction determine what part of the world is displayed on the screen.  This chapter describes how to create and control cameras.

Four main factors affect the image that a camera displays on your screen.  The first is the camera’s location.  The second is the direction the camera is pointing.  The third is the camera’s zoom, and the fourth is the picture quality.  After looking at how to select a camera, we will examine each of these areas in some detail.

Camera Handles and Names

Remember the method you used to cycle through all of the objects in a world?

for(handle=Morfit_object_get_first_object() ; handle!=NULL ; handle = 
Morfit_object_get_next_object(handle) )


{


...


}

Compare it with the following code segment:

for(handle=Morfit_camera_get_first_camera() ; handle!=NULL ; handle = 
Morfit_camera_get_next_camera(handle) )


{


...


}

Wasn’t that easy?  Accessing a camera’s handle or name is just as easy as working with an object.  Here is another example:

char * Morfit_object_get_name(DWORD object_handle);

char * Morfit_camera_get_name(DWORD camera_handle);

One important function is named differently than its parallel object function.  Note: 

DWORD Morfit_object_get_object_using_name(char *object_name);

DWORD Morfit_camera_get_using_name(char * camera_name);

You can create a new camera using the function

DWORD Morfit_camera_create(char *camera_name);

Note that the camera will be created using default values- you will want to set the camera’s location and direction before you use the camera.  The function returns a handle to the newly created camera.

To destroy a camera use:

int Morfit_camera_delete(DWORD camera_handle);

Remember not to use the camera’s handle after destroying the camera!  To delete all the cameras in a world use the following:

Morfit_camera_delete_all(void);

There are two special camera handles that you should know about.  The default camera is the first camera that was created in the world.  This is the first camera on the list of cameras in the World Builder, or the first camera that you created in your program.  To use it call

Morfit_camera_get_default_camera(void);

The current camera is the last camera that was used to render the world.  Some functions (for example, Morfit_engine_3D_point_to_2D) don’t take a camera handle has a parameter.  Instead, they rely on the current camera.  If you are using multiple cameras to display images in more than one window, you might want to make sure that these functions use the proper camera.  To set or retrieve the current camera, use:

int Morfit_camera_set_current(DWORD camera_handle);

DWORD Morfit_camera_get_current(void);

Camera Location

You position cameras in the world in exactly the same way that you position objects.  The following functions behave exactly like their parallels in the Object API.  To move a camera to the location with the coordinates [x, y, z]:

Morfit_camera_set_location(DWORD camera_handle, double x, double y, double z);

This function retrieves the current location:

Morfit_camera_get_location(DWORD camera_handle, double *x, double *y, double *z);

To move relative to its current location, use:

Morfit_camera_move(DWORD camera_handle, int space_flag, double x, double y, double z);

Here, space_flag can be in either WORLD_SPACE or CAMERA_SPACE.  Camera space is just like object space.  The camera space vector [-1 0 0] always points straight in front of the camera.

The automatic methods of camera movement are also identical to those of object movement: you can set cameras to follow tracks, chase objects, or move according to physics.

Just to see how similar camera movement is to object movement, open up any program that has an object moving around.  You can use one of the examples from Chapter 3.  After loading the handles of the camera and the , add the following (be sure to replace car with the name of the object’s handle in your program):

Morfit_camera_set_chase_type(camera,CHASE_PRECISE);

Morfit_camera_set_object_to_chase(camera, car);

Morfit_camera_set_chase_distance(camera, 500);


Morfit_object_set_direction(car,-1,0,0);

The camera will now follow the car from a distance of 500 behind the car.

For details on how to move a camera using tracks, chasing, or physics, see the relevant sections in Chapter 3.  Just replace Morfit_object with Morfit_camera, and you’re all set.

Camera Direction

At least as important as a camera’s location is the camera’s direction- a camera pointing straight up in the air will not show much, unless there happens to be an airplane flying by.  This section covers the various methods by which you can aim a camera.

The most basic way to set a camera’s direction is using Morfit_camera_set_direction().  This function allows you to specify a vector that defines the camera’s direction.  The following command will aim the camera at a 45( angle pointing up and into the screen.

Morfit_camera_set_direction(camera, -1, 0, 1);

You can retrieve the current camera direction using

Morfit_camera_get_direction(DWORD camera_handle, double *x, double *y, double *z);

If an object is located at (x, y, z) and a camera is located at (cx, cy, cz), then [x-cx, y-cy, z-cz] is a vector that points from the camera to the object.  Therefor, the following example points a camera at an object:

Morfit_object_get_location(object, &x, &y, &z);

Morfit_camera_get_location(camera, &cx, &cy, &cz);

Morfit_camera_set_direction(camera, x-cx, y-cy, z-cz);

Morfit provides many commands to simplify rotating and aiming the camera, so that you don’t have to calculate the vector direction every time you want to turn the camera.  The first is the point_at command:

Morfit_camera_point_at(DWORD camera_handle, double x, double y, double z);

You can replace the above example with the following, which will also point the camera at the given object:

Morfit_object_get_location(object, &x, &y, &z);

Morfit_camera_point_at(camera, x, y, z);

Note:  Specifying coordinates for the camera to point at does not completely define the camera’s angle- it still allows the camera one degree of freedom.  To illustrate this point, point your finger at a corner of the room.  Note that you can turn your hand over and still point at the same corner.  When you use Morfit_camera_point_at(), the engine calculates the camera’s z-axis to be perpendicular (or normal) to the ground. 

A related function, Morfit_camera_point_at_2D(), allows you to specify an (x, y) coordinate on the screen to point at.  The Morfit Engine transforms this point into a 3D world coordinate and points the camera.  One use for this would be to move the camera in response to a mouse click.  You might want to center the view on the object or point that the user clicked on.  We will see how to respond to input from the mouse in Chapter 5 when we look at using Morfit with MFC.  How the engine converts between 2D and 3D coordinates will be discussed in Chapter 7 (see the function Morfit_engine_2D_point_to_3D). 

The camera_rotate functions rotate the camera around its axes.  Recall that, just as with an object, a camera’s x-axis runs forwards and backwards, the y-axis runs left and right, and the z-axis points up and down.  Therefore, rotating a camera around its x-axis will leave the camera pointing at the same spot, while turning the picture upside down.  Rotating around the z-axis has the effect of panning the camera left and right, while rotating around the camera’s y-axis will point the camera up or down.  The following functions rotate the camera around the given axis:

Morfit_camera_rotate_x(DWORD camera_handle, double degrees, int space_flag);

Morfit_camera_rotate_y(DWORD camera_handle, double degrees, int space_flag);

Morfit_camera_rotate_z(DWORD camera_handle, double degrees, int space_flag);

Similar functions allow you to specify the angle in radians instead of degrees:

Morfit_camera_rotate_x_radians(DWORD camera_handle, double radians, int space_flag);

Morfit_camera_rotate_y_radians(DWORD camera_handle, double radians, int space_flag);

Morfit_camera_rotate_z_radians(DWORD camera_handle, double radians, int space_flag);

Note that all of these functions allow you to specify a rotation in either CAMERA_SPACE or WORLD_SPACE.

You can also rotate a camera by specifying or modifying its tilt angle, head angle, or bank angle.

A camera’s tilt points it up or down:

tilt = 0: camera looks straight.

tilt = 90: camera looks up

tilt –90: camera looks down

Note:  Adjusting a camera’s tilt is the same as rotating it around its y-axis.

A camera’s head angle points it to the left or right, without changing the camera’s tilt:

head angle = 0: camera looks forward into the screen

head angle = 90: camera looks left

head angle = -90 (or 270 ): camera looks right

head angle = 180: camera looks from the screen out

Note: Adjusting a camera’s head angle is the same as rotating it around the world’s z-axis.

A camera’s bank angle turns it around while still focusing on the same point (recall the example of turning over your hand while your finger points to a corner of the room).

bank angle =  0: camera looks straight.

bank angle = 90: camera is turned 90 degrees counterclockwise

bank angle = -90 (or 270): camera is turned 90 degrees clockwise

bank angle = 180: camera is upside down

Note: Adjusting a camera’s bank angle is the same as rotating it around its x-axis.

Morfit provides functions to set, retrieve, and modify each of these angles.  Each function returns the new angle.

double Morfit_camera_set_tilt(DWORD camera_handle, double angle);

double Morfit_camera_get_tilt(DWORD camera_handle);

double Morfit_camera_modify_tilt(DWORD camera_handle, double change);

double Morfit_camera_set_head_angle(DWORD camera_handle, double angle);

double Morfit_camera_get_ head_angle (DWORD camera_handle);

double Morfit_camera_modify_ head_angle (DWORD camera_handle, double change);

double Morfit_camera_set_bank(DWORD camera_handle, double angle);

double Morfit_camera_get_bank (DWORD camera_handle);

double Morfit_camera_modify_bank (DWORD camera_handle, double change);

After we look at one more function, we’ll write a program to see how these angles effect the camera’s view.

Zoom

[image: image13.png]


The camera’s zoom angle determines the camera’s field of view, or how large an area the camera displays.  Remember that the size of the screen remains constant.  Therefor, the less of the world you display on the screen, the larger the image will appear, while if you display more of the world, the picture will appear smaller.  The following figure illustrates how a narrow zoom angle shows less of the world, resulting in a large picture on the screen, while a wide zoom angle shows more of the world, resulting in a smaller picture on the screen.  

Figure 4.1

To set the zoom angle use the following functions:

double Morfit_camera_set_zoom(DWORD camera_handle, double field_of_view_angle);

double Morfit_camera_get_zoom(DWORD camera_handle);

double Morfit_camera_modify_zoom(DWORD camera_handle, double field_of_view_change);

field_of_view_angle can be between 1( and 179(.  Each of these functions returns the new zoom angle.

A Sample Program – Camera Control

Let’s construct a sample program to experiment with moving and rotating a camera.  The user will select a camera mode (move, rotate around x-axis, adjust bank angle, etc…), and control the camera using the up and down arrows.  The following are the camera modes:

Key
Mode

M
Move camera forward and backward

X
Rotate camera around its x-axis

Y
Rotate camera around its y-axis

Z
Rotate camera around its z-axis

B
Increase \ decrease bank angle

H
Increase \ decrease head angle

T
Increase \ decrease tilt angle

F
Increase \ decrease zoom (field of view)

O
Point camera at next object

C
Switch to next camera

First create a world- any world will do, as long as it has at least one dynamic object and at least one camera.  Save the world as “camera.wld”.  Create a new project in Visual Studio and set it up as usual.

The main function will be the same as alw, except that inside the main rendering loop, we will call the MoveCamera() function.  Because we allow the user to switch cameras, this function will return the handle of the current camera.  The main function is listed below:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{


DWORD MoveCamera();



int rc=Morfit_engine_load_world("camera.wld",".","Bitmaps",USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("esc to exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera;


while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



camera = MoveCamera();



Morfit_engine_render(NULL,camera);



}

}

Listing 4.1

The MoveCamera() function will load the default camera, and store the handle of the first dynamic object in the world.  We will create an enumerated type to store the current movement mode.

DWORD MoveCamera()

{

static DWORD camera = Morfit_camera_get_default_camera();

static DWORD object_handle = Morfit_object_get_first_object();

enum movement_mode {Move, RotateX, RotateY, RotateZ, Bank,HeadAngle, Tilt};

static movement_mode mode=Move;

const speed = 10;

Next, respond to the ‘C’ key by switching to the next camera:


if ((GetAsyncKeyState('C')<0)


{



camera=Morfit_camera_get_next_camera(camera);



if (camera==NULL) camera=Morfit_camera_get_first_camera();



mode = Move;


}

Respond to the ‘O’ key by aiming the camera at the next object.  Load the handle of the next object, cycling back to the first object if necessary.  Get the object’s location, and point at it:


if (GetAsyncKeyState('O')<0)


{



object_handle=Morfit_object_get_next_object(object_handle);



if (object_handle==NULL) object_handle = Morfit_object_get_first_object();



if (object_handle==NULL) return;



double x,y,z;



Morfit_object_get_location(object_handle,&x,&y,&z);



Morfit_camera_point_at(camera,x,y,z);


}

Set the camera’s movement mode:


if (GetAsyncKeyState('M')<0)



mode=Move;


else if (GetAsyncKeyState('X')<0)



mode=RotateX;


.


.


.

Respond to the up arrow based on the current mode:


if ((GetAsyncKeyState(VK_UP)<0)


{



if (mode==Move)




Morfit_camera_move(camera, CAMERA_SPACE, -speed, 0, 0);



else if (mode==RotateX)




Morfit_camera_rotate_x(camera,speed,CAMERA_SPACE);



.



.



.


}

Respond to the down arrow:


if ((GetAsyncKeyState(VK_DOWN)<0)


{



if (mode==Move)




Morfit_camera_move(camera, CAMERA_SPACE, speed, 0, 0);



else if (mode==RotateX)




Morfit_camera_rotate_x(camera,-speed,CAMERA_SPACE);



.



.



.


}

Finally, return the handle of the current camera:


return camera;

}

Here is a complete listing of the program:

#include “..\\..\\..\\Engine\\Include\\mrft_api.h”

#include <iostream.h>

void main(void)

{


DWORD MoveCamera();



int rc=Morfit_engine_load_world("camera.wld",".","Bitmaps",USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



cout << "Failed to load world, aborting\n";



cout << "look at error.log to see why\n";



return;


}


Morfit_engine_set_default_rendering_window_title("esc to exit");


Morfit_engine_maximize_default_rendering_window();


ShowCursor(FALSE);  // Hide the cursor


DWORD camera;


while( (GetAsyncKeyState(VK_ESCAPE)&1) ==0 ) {



camera = MoveCamera();



Morfit_engine_render(NULL,camera);



}

}

DWORD MoveCamera()

{


static DWORD camera = Morfit_camera_get_default_camera();


static DWORD object_handle = Morfit_object_get_first_object();


enum movement_mode {Move, RotateX, RotateY, RotateZ, Bank,HeadAngle, Tilt, Zoom};


static movement_mode mode=Move;


const speed = 10;


if (GetAsyncKeyState('C')<0)


{



camera=Morfit_camera_get_next_camera(camera);



if (camera==NULL) camera=Morfit_camera_get_first_camera();



mode = Move;


}


if (GetAsyncKeyState('O')<0)


{



object_handle=Morfit_object_get_next_object(object_handle);



if (object_handle==NULL) object_handle=Morfit_object_get_first_object();



double x,y,z;



Morfit_object_get_location(object_handle,&x,&y,&z);



Morfit_camera_point_at(camera,x,y,z);


}


if (GetAsyncKeyState('M')<0)



mode=Move;


else if (GetAsyncKeyState('X')<0)



mode=RotateX;


else if (GetAsyncKeyState('Y')<0)



mode=RotateY;


else if (GetAsyncKeyState('Z')<0)



mode=RotateZ;


else if (GetAsyncKeyState('B')<0)



mode=Bank;


else if (GetAsyncKeyState('H')<0)



mode=HeadAngle;


else if (GetAsyncKeyState('T')<0)



mode=Tilt;


else if (GetAsyncKeyState('F')<0)



mode=Zoom;


if (GetAsyncKeyState(VK_UP)<0)


{



if (mode==Move)




Morfit_camera_move(camera, CAMERA_SPACE, -speed, 0, 0);



else if (mode==RotateX)




Morfit_camera_rotate_x(camera,speed,CAMERA_SPACE);



else if (mode==RotateY)




Morfit_camera_rotate_y(camera,speed,CAMERA_SPACE);



else if (mode==RotateZ)




Morfit_camera_rotate_z(camera,speed,CAMERA_SPACE);



else if (mode==Bank)




Morfit_camera_modify_bank(camera,speed);



else if (mode==HeadAngle)




Morfit_camera_modify_head_angle(camera,speed);



else if (mode==Tilt)




Morfit_camera_modify_tilt(camera,speed);



else if (mode==Zoom)




Morfit_camera_modify_zoom(camera,speed);


}


if (GetAsyncKeyState(VK_DOWN)<0)


{



if (mode==Move)




Morfit_camera_move(camera, CAMERA_SPACE, speed, 0, 0);



else if (mode==RotateX)




Morfit_camera_rotate_x(camera,-speed,CAMERA_SPACE);



else if (mode==RotateY)




Morfit_camera_rotate_y(camera,-speed,CAMERA_SPACE);



else if (mode==RotateZ)




Morfit_camera_rotate_z(camera,-speed,CAMERA_SPACE);



else if (mode==Bank)




Morfit_camera_modify_bank(camera,-speed);



else if (mode==HeadAngle)




Morfit_camera_modify_head_angle(camera,-speed);



else if (mode==Tilt)




Morfit_camera_modify_tilt(camera,-speed);



else if (mode==Zoom)




Morfit_camera_modify_zoom(camera,-speed);




}


return camera;

}

Listing 4.2

Adjust the camera until you feel comfortable with all the possible rotations and angles.

Picture Quality

Morfit allows you to control the quality of the picture displayed on the screen.  Higher picture quality will lead to slower rendering, while lower picture quality can speed up the rendering process.  Picture quality is only relevant when you are using software rendering.

The height and width of the image represent the number of pixels that will fill the rendering window.  Note that this is independent of the size of the window.  The image will be stretched or shrunk so that the given number of pixels fill the window.  Very small image height and width values will lead to a very grainy picture in a large rendering window, but will look just fine in a small rendering window.

You can retrieve the current height and width values using the following functions:

int Morfit_camera_get_width(DWORD camera_handle);

int Morfit_camera_get_height(DWORD camera_handle);

To set the resolution, call the following, where quality is height * width.  Note that you cannot set the height and width directly- the engine will ensure the proper ratio based on the window’s shape.

Morfit_engine_set_picture_quality(int quality);

Morfit_engine_increase_picture_quality();

Morfit_engine_decrease_picture_quality();

Hidden Surface Removal

When using software rendering, one of the methods that the Morfit Engine uses to perform hidden surface removal is an algorithm known as “z buffer”.  One parameter that affects the z buffer algorithm is the camera’s distance from the eye.

The larger the camera’s distance from the eye, the more accurate the picture will be.  However, if is too far away, then the camera will not display objects that are very close by.  You should experiment with different values, increasing the distance until you start to see objects disappear from the display.  

Morfit_camera_set_distance_from_eye(DWORD camera_handle, double distance);

double Morfit_camera_get_distance_from_eye(DWORD camera_handle);

Typical values for distance are 1-20.

Other Useful Camera Functions

Two useful functions are

int Morfit_camera_convert_point_to_world_space(DWORD camera_handle, double camera_space_point[3], double result[3]);

int Morfit_camera_convert_point_to_camera_space(DWORD camera_handle, double world_space_point[3], doublresult[3]);

These functions convert 3D coordinates between camera space and world space.  For example, to find out the world space coordinate of the point 10 units in front of the camera, you can call:

double cs[3]={-10, 0, 0};

double ws[3];

Morfit_camera_convert_point_to_world_space(camera,cs,ws);

Summary

This chapter described how to move and aim cameras.  The camera API controls both the quality and content of the image that is displayed on the screen.

Until now we have been viewing the world in Viewer Mode, where only dynamic objects and cameras can be manipulated.  Chapter 6 explores Editor Mode, where you have total control over all of objects in the world.  But first, we will take a look at writing Morfit programs that use MFC.  MFC will allow us to create examples that accept input from the mouse, and take advantage of other Windows features.

Chapter 5 – Using MFC

All of the sample programs in the previous chapters were written as Windows console applications.  This was for simplicity.  Console applications can be very short, and all you have to know to write them is C++ (or even C). However, console applications have many disadvantages, the least of which is the annoying DOS window that pops up every time you run them.  On the other hand, applications written in MFC look and act like Windows programs.  They make is simple to respond to user input from both the keyboard and the mouse.  They also allow you to create dialogue boxes and menus and tie them in to your programs.

This chapter provides an introduction to using the Morfit SDK with MFC.  It doesn’t attempt to teach MFC – that would require much more than one chapter.  It won’t even try to explain what MFC is.  It will, however, provide the knowledge necessary to create MFC projects that use the Morfit 3D graphics tools.  

Creating a New World

The programs in this chapter will use the world file “shapes.wld”.  Create a world using the BlankFloor template.  Place three 3D shapes in the world – I used a cube, a pyramid, and the “hexabox”, but you can use any shapes you want.  Make them dynamic objects and create a camera.  Now get rid of the black and white floor that the template placed into the world.  Instead of using the “Save As” command, select File -> Release.  In the resulting dialogue box, make sure that “delete template polygons” is checked, and press OK.  The floor will disappear.  Exit the World Builder.

Hello, World! Using the Morfit Application Wizard

In Microsoft Visual Studio, select File -> New.  This time, in the Projects tab, select Morfit AppWizard.  Name the project “mfcdemo”, and press OK.  Visual Studio will create a new application that supports MFC and the Morfit 3D Engine.  Select Project -> Settings, and select the Debug tab.  Set the working directory to the folder that contains “shapes.wld”.  Note that the AppWizard already linked in the Morfit library and included the Morfit header file.

When the AppWizard created our project, it added some sample code to some of the functions.  We will need to delete some of it as we construct our own example.

Recall the layout of our console applications:

// Initialization

Load the world

// Main rendering loop

Repeat until user presses <esc>:


Move camera and/or objects


Display world

The problem with this approach is that it monopolizes the CPU.  We constantly check for user input even when none has occurred, and we constantly re-render the world, even when the picture has not changed.  In MFC (and in most Windows programs), you do not need to poll for input.  Instead, you can rely on Windows inform you whenever an “event” has occurred.  Windows will notify your program each time the user presses a key, moves the mouse, or clicks a button. You can also ask Windows to notify your program of other events, including the expiration of a timer or the user clicking on a menu choice.

The structure of our MFC programs will look like this:

// Initialization

Load the world

Display the world

// Respond to Events

Event 1:

Modify the world 

Display the world

Event 2:

Modify the world 

Display the world

.

.

.

Make sure that you understand how this differs from the old program model.  There is no “rendering loop” at all.  We just set up the world and respond to events whenever Windows tells us that they have occurred.

Initialization

MFC is more than just a set of classes- it is an “application framework.”  In the standard programming model, libraries provide you with a set of functions that your program can call.  With an application framework, you provide with functions for it to call.  You do not need to define a main (or winmain) function- MFC takes care of that.  Then where do you perform all of your initialization?  You provide a function named InitInstance(). And MFC guarantees that it will be called when your program first starts running.

In the Workspace window, select the ClassView tab.  Expand the branches of the tree, and you will see this:
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Figure 5.1

This view provides a list of your program’s classes and the functions and variables that they contain.  The InitInstance() function was generated by the AppWizard.  Double-clicks on it to bring up its function body.  Look through the function, and find the call to the LoadWorld function.  Replace that LoadWorld call with this one:


if(OK != Morfit_engine_load_world("shapes.wld",  "", "Bitmaps", USER_DEFINED_BEHAVIOR ))



return false;

This function is where you can include any other initialization activity that you only want to occur once at the start of your program.

Next, double-click on the OnIdle() function in the Class View.  Delete the sample code – all of the lines between


//**** MORFIT CODE ****


//******* BEGIN *******

and



// **** MORFIT CODE ****


// ******** END ********

Rendering the World

All that remains is to render the world.  In MFC, you provide a function named OnPaint() that will be called every time your program’s window needs to be drawn.  This function is called when the window is first created, when it is resized, or whenever you inform Windows that the contents of the window should be updated.  Bring up the OnPaint() function from the Class View.  Notice the line:

if (Morfit_engine_render(m_hWnd, Morfit_camera_get_default_camera()) != OK)



return;

The first parameter is the HWND (window handle) of the window where you want to render, and the second parameter is the camera that you want to use.

You don’t need to make any changes in this function.  Compile and run the program.  You should see the world displayed in your program’s window.  Try resizing the window.  Select File -> Exit.  The MFC AppWizard generated the code to handle this command, as well as the Minimize, Maximize, and Close buttons on the top-right corner of the window.

Beyond Hello, World!

While the above program may look nice (at least compared to our console programs), it doesn’t really do much.  In this section we’ll make the world a little more dynamic by adding functions to respond to user events.  We will respond to timers and mouse clicks.  But first, let’s write some code that will run in the “event” that nothing is happening.

Idle processing

Your application spends most of its time responding to Windows Messages.  When the message queue is empty and the program has nothing to do, the application will call the OnIdle function.  Let’s provide an OnIdle function that rotates the shapes.  This will set the shapes spinning around.

Double click on the OnIdle() function.  Inside MORFIT CODE BEGIN and MORFIT CODE END, insert the following:


for(DWORD shape=Morfit_object_get_first_object() ; shape!=NULL ; shape=Morfit_object_get_next_object(shape) )


{



Morfit_object_rotate_x(shape,.5,WORLD_SPACE);



Morfit_object_rotate_y(shape,.5,WORLD_SPACE);



Morfit_object_rotate_z(shape,.5,WORLD_SPACE);


}

This will rotate each object in the world .5( around each axis.  Rotating the objects isn’t enough, though.  While you may have changed the state of the world, you need to make sure that the change is reflected in what is displayed on the screen.  What we need to do is call the rendering function (OnPaint).  However, instead of calling the OnPaint function dir, we call the Invalidate() function.  This informs Windows that the contents of our window are not up to date, and need to be redrawn.  This has already been taken care of - before it returns, OnIdle calls


m_pMainWnd->Invalidate(false);

Build and run the program.  The shapes now rotate around their axes.

The Timer

The OnIdle function is a useful place for activities that you want to run continuously.  However, you have very little control over how often it is run.  If you want something to occur at regular intervals, you should use a timer.  Let’s modify our program so that every five seconds, the shapes switch places.  To do this, we will use a Windows timer.

The concept of a Windows timer is fairly simple.  You set a timer to produce an event every n milliseconds, and specify a function for Windows to call in response to that event. Add the following line to the InitInstance function:

m_pMainWnd->SetTimer(1,5000,NULL);

The first parameter is an event ID that uniquely identifies the timer.  It allows you to keep track of multiple timers at once.  The second parameter is the period of the timer, in milliseconds.

Now we will create the function to run in response to the timer.  Open the Class Wizard (select it from the View menu, or press Ctrl-W).  Select the Class name “MMainFrame”.  In the list of Object Ids, also select “MMainFrame”.  Scroll down in the Messages list box, and select the WM_TIMER message.  The dialogue box should look like this:
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Figure 5.2

Double-click on the WM_TIMER message, or press “Add Function”.  Now double-click on OnTimer in the Member functions list, or press the “Edit Code” button.  Add the following code, which will swap the locations of the objects:


KillTimer(1);


DWORD shape1=Morfit_object_get_first_object();


DWORD shape2=Morfit_object_get_next_object(shape1);


DWORD shape3=Morfit_object_get_next_object(shape2);


double loc1[3],loc2[3],loc3[3],temp[3];


Morfit_object_get_location(shape1,&loc1[0],&loc1[1],&loc1[2]);


Morfit_object_get_location(shape2,&loc2[0],&loc2[1],&loc2[2]);


Morfit_object_get_location(shape3,&loc3[0],&loc3[1],&loc3[2]);


temp[0]=loc1[0];


temp[1]=loc1[1];


temp[2]=loc1[2];


Morfit_object_set_location(shape1,loc2[0],loc2[1],loc2[2]);


Morfit_object_set_location(shape2,loc3[0],loc3[1],loc3[2]);


Morfit_object_set_location(shape3,temp[0],temp[1],temp[2]);


Invalidate(false);


SetTimer(1,5000,NULL);

Note that we stop the timer at the beginning of the function, and reset it at the end.  This prevents the function from being called a second time while you are still handling the first timer event.  While this would not really be a problem here (with a very short routine, and a period of 5 seconds between events) it is a good habit to get into.  Once again, after making changes in the world, we call Invalidate(false) to force Windows to redraw the window.

Compile and run the program.  In addition to rotating, the shapes should switch places every five seconds.

User Input

The last type of event that we will look at is user input.  Windows generates an event whenever the user presses a key, moves the mouse, or clicks a button. 

We’ll demonstrate how to handle user input by allowing the user to move the shapes by using the mouse,  The user will select a shape by clicking on it.  A second click will move the object to a new location.

First, let’s add a variable to the MMainFrame class to store the handle to the currently selected object.  Right-click on the MMainFrame class, and select “Add member variable”.  Add a protected variable named selected of  type DWORD.  In the MMainFrame() constructor, initialize selected to NULL:

MMainFrame::MMainFrame()

{


selected = NULL;

}

We wish to respond to the left mouse button being clicked.  Open the Class Wizard, and once again select the MMainFrame Class and the MMainFrame Object ID.  This time, select the WM_LBUTTONDOWN message.  Click “Add Function”, and then select “Edit Code” to bring up the OnLButtonDown() function.

Here is the algorithm that we will use:

In response to the first click:


If the user clicked on an object, select it


If the user clicked on an empty spot, ignore

In response to the second click:


Calculate the 3D coordinates of the point that the user clicked


Move the object to the new location

Let’s respond to the first mouse click.  How will we differentiate between a first click and a second click?  A first click occurs when there is no object selected (selected=NULL), while a second click occurs when an object is already selected.

To find out which object was clicked on (if any), we will call the Morfit_engine_2D_to_3D() function.  While we will examine this function more closely in Chapter 7, here is a brief description: if there is an object located at the given (x,y) point, it will convert the point into 3D world coordinates.  It also returns handles to the object and the polygon that were clicked.  If there is no object at the given location, it will return the point [0, 0, 0] and the object handle will be set to NULL.  We can get the 2D coordinates of the point that the user clicked on by examining the point parameter to the OnLButtonDown() function.

Here is our code to respond to the first click:

double result[3];

DWORD polygon,object;

if (selected==NULL)

{


if (Morfit_engine_2D_point_to_3D(point.x, point.y, result, &object, &polygon)==OK)



if (object!=NULL) 



{




selected=object;




KillTimer(1);



}

}

When the user click on an object, we store the object handle in our selected member variable.  We also stop the timer, so that the shapes will stop switching places while one is selected.

How do we respond to the second click?  At first glance, this would seem to be enough:

else 

{

Morfit_engine_2D_point_to_3D(point.x,point.y,result,&object, &polygon);

Morfit_object_set_location(selected,result[0],result[1],result[2]);

}

Unfortunately, if the user clicks on a blank area of the screen, Morfit_engine_2D_point_to_3D() cannot return a 3D coordinate.  This is because there are infinitely many 3D points that correspond to each 2D coordinate (see Chapter 7 for more about this problem).  For the first click, this was not a problem.  If the user did not click on an object, we just ignored the click.  Here, we would like to allow the user to move an object anywhere, not just on top of another object.  

First, we will try the Morfit_engine_2D_point_to_3D() function.  If the user clicked on an object, then no problem- it will return a 3D point.  If the user clicked on the background, however, we will have to force the engine to pick one 3D point out of the infinite possibilities.  The function Morfit_engine_2D_point_to_3D_point_on_plane() will return the 3D coordinates of the 2D point that lies on a given plane.  We will (somewhat arbitrarily) pick the plane x=1000, which can be written in standard form as 1x + 0y + 0z – 1000 = 0.  Here is the code.  Don’t worry too much about understanding the specific function calls- we will look at them again in Chapter 7.  Just try to understand how the program uses the MFC application structure to respond to mouse input.

else

{

if (Morfit_engine_2D_point_to_3D(point.x,point.y,result,&object, &polygon)==OK)


Morfit_object_set_location(selected,result[0],result[1],result[2]);


else


{



double plane[4]={1,0,0,-1000};



if(Morfit_engine_2D_point_to_3D_point_on_plane(point.x, point.y, plane,result)==OK)



Morfit_object_set_location(selected,result[0],result[1],result[2]);


}


selected=NULL;


SetTimer(1,5000,NULL);

}

After placing the object in its new location, we reset the timer so that the objects will continue switching places every 5 seconds.

Run the program.  Click on an object to select it, and click elsewhere to move it.

Summary

This program introduced you to using the Morfit API with MFC.  The examples later in the book will make use of MFC.  To become more familiar with using MFC, look through the MFC sample programs that came with the Morfit SDK.  Read through the source code and comments of each project, and run them.  They will help you gain an understanding of how MFC and Morfit combine to provide you with powerful tools to create 3D graphics Windows programs.

C6 – Groups

In Chapter 3, you were introduced to the Object API, the principal means of controlling objects in Viewer Mode.  This chapter introduces you to the Group API, which you will use to manipulate worlds loaded in Editor Mode.  Editor Mode gives you greater freedom to add and change objects, at the cost of rendering speed.  Chapter 12 discusses the differences between Viewer and Editor Modes.

What is a Group?

Polygons are allowed to belong to collections called groups.  These groups can belong to other groups, which can in turn belong to other groups.  This allows you to set a hierarchy between the members of a group.
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Let us look at the example of a table.  This table is made up of 4 legs and a tabletop.  Each leg, in turn, is made up of 4 polygons.  In total, the table contains 17 polygons (16 for the 4 legs, and 1 for the tabletop).  We could represent the table object as follows:

Figure 6.1

There is no hierarchy amongst the polygons- they all belong directly to the table object.

Here is how the table group might look:
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Figure 6.2

Here, the polygons leg_1_1, leg_1_2, leg_1_3, and leg_1_4 belong to the group leg_1.  The leg_1 group, along with leg_2, leg_3, leg_4, and the polygon tabletop, in turn belong to the table group.

What is the advantage of grouping together polygons in a hierarchy?  Imagine that you have a table and a chair.  At times, you might want to move the chair by itself, in order to adjust its placement at the table.  At other times, you might want to move the table and chair as a unit, maintaining the chair’s location relative to the table.

Each polygon and each group contains a pointer to its father group.  In the example above, leg_1_1 will contain a pointer to leg_1, and leg_1 will store a pointer to table.  The table group’s father pointer will be set to NULL, meaning that the table is not part of any larger group.  (Actually, the NULL group represents the whole world.  The leg belongs to the table, which in turn belongs to the world.)

Building Groups

Creating Groups

Let us look at how to form groups.  Don’t forget that to work with groups, you must load the world in Editor Mode.  To load a world in Editor Mode, the last parameter of  the Morfit_engine_load_world() command must be EDITOR_MODE.

The following command will create a new group:

DWORD Morfit_group_create(char *name);

This will create an empty group with the given name.  You can add polygons to the group with the following function:

Morfit_polygon_set_group(DWORD polygon_handle, DWORD group_handle);

To add a group to another group:

Morfit_group_set_father_group(DWORD group_handle, DWORD father_group);

The following program fragment will create a new group called table, which will include the 4 leg groups and the tabletop (assume that we already have the handles of each of these items):

DWORD table =  Morfit_group_create(“table”);

Morfit_group_set_father_group(leg_1, table); 

Morfit_group_set_father_group(leg_2, table); 

Morfit_group_set_father_group(leg_3, table);

Morfit_group_set_father_group(leg_4, table);

Morfit_polygon_set_group(tabletop, table);

Deleting groups

To remove a polygon or group from a group, just set its father to NULL:

Morfit_group_set_father_group(leg_1, NULL) will take leg_1 out of the table group.

Morfit_polygon_set_group(tabletop, NULL) will take the tabletop out of the table group.

To remove all the members from a group, use Morfit_group_ungroup(DWORD group_handle).

This function will not delete the polygons or member groups, it merely removes them from the group.  However, the function Morfit_group_delete_members(DWORD group_handle) not only removes the members from the group, but deletes them from the world.

Copying groups

To make a copy of a group, use the function DWORD Morfit_group_duplicate_tree(DWORD group_handle).  This function returns a handle to the new group.  

Querying groups

To find out which group a polygon belongs to:

DWORD Morfit_polygon_get_group(DWORD polygon_handle);

This function returns a handle to the polygon’s group.  If it returns NULL, the polygon does not belong to a group, it belongs directly to the world.  In the above example, Morfit_polygon_get_group(tabletop) will return table, while Morfit_polygon_get_group(leg_polygon_1_1) will return leg_1.

To find out whether a polygon belongs to a certain group, whether directly or indirectly, call:

Morfit_polygon_is_in_group(DWORD polygon_handle, DWORD group_handle);

For example:

Morfit_polygon_is_in_group(leg_polygon_1_1, leg_1) will return YES. 

Morfit_polygon_is_in_group(leg_polygon_1_1, table) will also return YES, because the polygon is a member of leg_1, which is in turn a member of table.

Morfit_polygon_is_in_group(polygon_handle, NULL) will always return YES, because NULL represents the entire world, and every polygon is a member of the world.

Use similar functions to find out what group a given group belongs to (its father group), or to find out whether a group is contained, directly or indirectly, inside another group:

DWORD Morfit_group_get_father_group(DWORD group_handle);

Morfit_group_is_groupA_included_in_groupB(DWORD groupA_handle, DWORD groupB_handle);

For example:

Morfit_group_get_father_group(leg_1) will return table.

Morfit_group_is_groupA_included_in_groupB(leg_1,table) will return YES, while Morfit_group_is_groupA_included_in_groupB(leg_1,leg_2) will return NO.

Morfit_group_is_groupA_included_in_groupB(group1_handle,group1_handle) will always return YES, as will Morfit_group_is_groupA_included_in_groupB(group_handle, NULL).

You can check to see how many polygons belong to a group using:

int Morfit_group_get_number_of_polygons(DWORD group_handle);

Morfit_group_get_number_of_polygons(NULL) will return the number of polygons in the entire world.

Working with Groups

Now that you have created a group, what can you do with it?  For starters, anything you can do to an object, you can do to a group.  You can move groups, rotate them, and have them move around on tracks.  You can set them to chase groups or cameras, follow tracks, or move according to physics.  Note that neither groups nor objects will actually move automatically (chase, follow tracks, or use physics) while you are in Editor Mode.  However, you can set these properties while in Editor Mode, and when you next load the world in Viewer Mode, the properties will take effect.  For example, the World Builder (which runs in Editor Mode) allows you to set these properties, but you don’t see the objects actually move until you launch Viewer Mode.

In addition, because you use them in Editor Mode, the API provides functions to change the groups.  You can scale groups, and change their color.  You can change their lighting properties, or wrap them with bitmaps.  Let’s take a look at the different Group API functions.  Afterwards, we’ll write a sample program that demonstrates how to work with groups.

Group Handles and Names

You can get a group’s handle in the same way that you get an object’s handle or a camera’s handle.  The following functions all return handles to groups:

DWORD Morfit_group_get_first_group(void);

DWORD Morfit_group_get_next(DWORD group_handle);

DWORD Morfit_group_get_using_name(char *name);

In addition, as we saw, Morfit_group_create() returns a handle to the new group.

To access a group’s name:

char * Morfit_group_get_name(DWORD group_handle);

Morfit_group_set_name(DWORD group_handle, char *name);

To get handles to the polygons that make up a group, use the following functions:

DWORD Morfit_group_get_using_name(char *name);

DWORD Morfit_group_get_first_polygon(DWORD group_handle);

Moving Groups

To set a group’s location:

Morfit_group_set_location(DWORD group_handle, double location[3]);

This places the group’s center at the specified coordinates.

Note that there is no Morfit_group_get_location.  Instead, use:

Morfit_group_get_center_of_mass(DWORD group_handle, double center[3]);

Actually, this returns the “center of volume,” not the “center of mass.”  To find the center of the group, the engine first calculates the bounding box of the group, and then finds the exact center.

The following function returns a group’s bounding box:

Morfit_group_ge_bounding_box(DWORD group_handle, double box[2][3]);

box[0][0] is the minimum X

box[0][1] is the minimum Y

box[0][2] is the minimum Z

box[1][0] is the max X 

box[1][1] is the max Y

box[1][2] is the max Z

You can move a group relative to its current location with the command:

Morfit_group_move(DWORD group_handle, double step[3], int space_flag);

Here, space_flag is either CAMERA_SPACE, OBJECT_SPACE, or WORLD_SPACE.

The Group API provides one additional function to move a group.

Morfit_group_move_to_match_point(DWORD group_handle, DWORD point_belongs_to_group, DWORD point_to_match);

point_belongs_to_group is a point in the group, and point_to_match is a point in the world outside of the group.  This function will move the group so that the given point in the group matches the point outside of the group.  For example, if the selected group is a piano, and you supply a point on the back of the piano and a point on a wall, this function will move the piano so that it is against the wall.  The easiest way to understand this function is to open the World Builder and experiment with the Move-To-Point button.  This button is implemented using this function.

Rotating Groups

The Group API provides many methods to rotate groups.  You can rotate the group around any-axis, in either world space, camera space, or object space.

Morfit_group_rotate(DWORD group_handle, double degrees, int space_flag, int axis_flag); 

Here, space_flag is one of WORLD_SPACE, CAMERA_SPACE, or OBJECT_SPACE.  axis_flag can be 0 to rotate around the x-axis, 1 to rotate around the y-axis, or 2 to rotate around the z-axis.  For example:

Morfit_group_rotate(group, 45, WORLD_SPACE, 1) will rotate the group 45( around the world’s y-axis.

Morfit_group_rotate(group, 30, OBJECT_SPACE, 0) will rotate the group 30( around its own x-axis.

By default, when you rotate a group, it will rotate around the group’s center.  The following allows you to change the group’s center of rotation:

Morfit_group_set_rotate_reference_point(DWORD group_handle, double center[3]);

Morfit_group_get_rotate_reference_point(DWORD group_handle, double center[3]);

At first, Morfit_group_get_rotate_reference_point() will return the same value as Morfit_group_get_center_of_mass().  But if you change the center of rotation using Morfit_group_set_rotate_reference_point(), the center of mass will remain the same, and only the Morfit_group_get_reference_point() will reflect the change.

Here is an example to show how moving an object’s center of rotation affects its rotation.  Imagine that you have a pendulum that you want to swing back and forth.  Its center of mass will be towards the middle of the pendulum:
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Figure 6.3

If you rotate the pendulum around the world’s x-axis (which goes straight into the screen), you would get something like this:
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Figure 6.4

Clearly this is not the desired result.  If, however, you set the pendulum’s center of rotation to the top of the pendulum, and then rotated around the world’s x-axis, the pendulum would rotate properly:
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Figure 6.5

The following function allows you to rotate a group around an arbitrary line:

Morfit_group_rotate_around_line(DWORD group_handle, double p1[3], double p2[3], double degrees);

Here, p1 and p2 are points that define the line around which you wish the group to rotate.

Now we will look at a function that allows you to rotate an object to match a given polygon.  It takes the following form:

Morfit_group_rotate_to_match_polygon(DWORD group_handle, DWORD polygon_in_the_group, DWORD reference_polygon, int inverse_flag);

In this function, reference_polygon is the polygon whose direction you want to match.  If inverse_flag is YES, the group will rotate to align with the back of the polygon.

Suppose you have a chair and a wall, and you want to rotate the chair so that its back is to the wall.  You would call the following:

Morfit_group_rotate_to_match_polygon(chair, chair_back, wall, NO);

A similar function allows you to rotate to match a specific direction, instead of a polygon:

Morfit_group_rotate_to_match_direction(DWORD group_handle, DWORD polygon_in_the_group, double direction[3]);

The group will rotate so that the normal of the polygon matches the specified direction.

Orienting Groups

Sometimes you want to drop an object or group onto the ground.  How does the program know which surface of the object is its bottom?  How does it know that a table stands on its legs, and that the legs don’t stand on the table?  When you drag an object from the model gallery, how does the World Builder know how to orient it?

The Group API allows you to define a group’s orientation.  In any group, you can define a polygon to be the bottom, top, front, or back of the group.  To fully define a group’s orientation, you should define one polygon as the group’s top or bottom, and one polygon as the group’s front or back.  The following function sets the group’s orientation:

Morfit_group_set_orientation(DWORD group_handle, DWORD polygon_handle, int orientation_value);

If orientation_value is either ORIENTATION_TOP or ORIENTATION_BOTTOM, the selected polygon will be given that orientation, and all other top or bottom polygons in the group will be set to ORIENTATION_UNKNOWN.  (This is because there should only be one top or bottom polygon in the group, otherwise contradictions may occur.)  Similarly, ORIENTATION_FRONT or ORIENTATION_BACK will clear the orientations of all other front or back polygons in the group.

To find out which polygon, if any, has a given orientation, use the following:

DWORD Morfit_group_get_bottom_polygon(DWORD group_handle);

DWORD Morfit_group_get_top_polygon(DWORD group_handle);

DWORD Morfit_group_get_front_polygon(DWORD group_handle);

DWORD Morfit_group_get_back_polygon(DWORD group_handle);

These functions all return a handle to the first polygon in the group with the given orientation.

Once a group has a front or back polygon and a top or bottom polygon, you can get the group’s axis system:

Morfit_group_calculate_axis_system(DWORD group_handle, double x_axis[3], double y_axis[3], double z_axis[3]);

This function  returns the x, y, and z-axes of the group.  Once again, the group’s x-axis extends from the front of the group towards the back, its y-axis runs from left to right, and its z-axis runs from bottom to top.  You can rotate a group so that its orientation matches a given axis system: 

Morfit_group_rotate_to_match_axis_system(DWORD group_handle, double x_axis[3], double y_axis[3], double z_axis[3]);

You can convert points between world space and group space (another name for object space) using the following functions:

Morfit_group_convert_point_to_world_space(DWORD group_handle, double group_space_point[3], double result[3]);

Morfit_group_convert_point_to_group_space(DWORD group_handle, double world_space_point[3], double result[3]);

For example, to find the world space coordinate five units in front of the group:

DWORD gs[3]={-5,0,0};

DWORD ws[3];

Morfit_group_convert_point_to_world_space(group, gs, ws);

Scaling Groups

When you load an object in Viewer Mode, you are stuck with it.  You can move it or rotate it, or change the way it appears, but you can’t change it.  The polygons that comprise the object will always stay the same.  For this reason, you cannot resize an object in Viewer Mode.  That would involve altering the object’s polygons.  In Editor Mode, this restriction does not apply. 

The following function allows you to resize a group:

Morfit_group_scale(DWORD group_handle, int space_flag,double scale_x, double scale_y, double scale_z);

scale_x, scale_y, and scale_z define how much you want to scale in each direction, while space_flag indicates whether the x, y, and z-axes are the world’s axes, the object’s axes, or the camera’s axes.  For example,

Morfit_group_scale(group, OBJECT_SPACE, 2, 1, 1) will double the group’s size in the x direction, while

Morfit_group_scale(group, OBJECT_SPACE, .5, .5, .5) will reduce the group’s size by half.

Color and Light

You can specify a group’s color as a combination of red, green, and blue:

Morfit_group_set_color(DWORD group_handle, int red, int green, int blue);

You can set also set the group’lighting properties.  A group can give off 2 types of light.  Ambient light is direction-less.  The second type of light has a direction- its brightness depends on the angle between the light’s direction and the polygon on which it is shining.  If the direction of the light is directly away from you, only the ambient light will be visible.  If the direction of the light is directly towards you, the brightness will be the ambient light plus the light intensity.  The exact intensity is calculated as follows:

final_intensity = ambient + angle_between_polygon_and_light_direction *  light_intensity

where the angle is normalized to the range [0-1], 0 being 180( and 1 being directly towards the polygon.  The format of the lighting function is as follows:

Morfit_group_light_group(DWORD group_handle, double direction[3], double ambient, double light_intensity);

If ambient or light_intensity are negative, the group will give off darkness instead of light!  We will look more closely at creating light effects in Chapter 11

Bitmaps

Instead of specifying a color for a group, you can specify a bitmap to cover the group.  The bitmap will wrap around the outside of the group.  You can get a bitmap’s handle using the function Morfit_bitmap_load().  (Bitmaps will be discussed in Chapter 8.)  You can either stretch a bitmap over the group, or tile it across the surface.  (Note that this function works best for groups that are relatively flat, because it ignores the z coordinate as it wraps around the object.)  In order to tile a bitmap, its size in each direction must be a power of 2.
Morfit_group_wrap_a_bitmap(DWORD group_handle, DWORD bitmap_handle, int repeat_x, int repeat_y);

repeat_x and repeat_y are the number of times the bitmap should repeat in the x and y directions.

Of course, the entire group doesn’t have to share the same color or bitmap.  Chapter 9 on the Polygon API will show how to set the appearance of individual polygons.

Group Properties

There are a number of other group properties that you can control.  First, you can set a group as static or dynamic.  Just like the chase or physics settings, this is irrelevant while in Editor Mode.  However, if you save the world and then load it in Viewer Mode, the property will take effect.  

To set a group as static or dynamic:

Morfit_group_set_static(DWORD group_handle);

Morfit_group_set_dynamic(DWORD group_handle);

int Morfit_group_is_static(DWORD group_handle);

Disabled objects are invisible and do not take part in collision detection.  When you load a world, all of its objects and groups are enabled by default.  If you want to a group to be disabled automatically when the world is loaded: 

Morfit_group_load_as_disabled(DWORD group_handle, int YES_or_NO);

int Morfit_group_get_load_as_disabled_status(DWORD group_handle);

A Sample World

Now that we have seen the functionality of the Group API, let’s look at a sample program that takes advantage of some of the functions that we have seen.  Open the World Builder.  Design a world that includes a table and 3 chairs- you can find them in the “DomesticObjects” folder.  Name the objects TABLE, CHAIR1, CHAIR2, and CHAIR3.  Note that because we will be operating in Editor Mode, it does not matter whether the objects are static or dynamic- you can move any of them.  Create a camera.  Save the world as “groups.wld”.  The world should look something like this:

[image: image21.png]


Figure 6.6

We will write a program that will allow you to move any of the chairs or the table by dragging them with the mouse.  When you drag a chair, it will drag only that chair.  When you drag a table, it will drag along all selected chairs.  At first, no chairs will be selected, so the table will move by itself.  To select or deselect a chair, hold down the control key and click the mouse on the chair.

Create a new project in Visual Studio using the Morfit AppWizard.  Name it Groupsdemo.   In Project -> Settings, set the Working Directory to the folder that contains the “groups.wld” file.

Displaying the World

First, let’s have the program load and display our world.  In the ClassView, select the InitInstance function.  Replace the call to Morfit_engine_load_world() with this:

if(OK != Morfit_engine_load_world("groups.wld", "", "Bitmaps",  EDITOR_MODE))




return false;

Note that we are loading the world in Editor Mode.

Remove the AppWizard-generated code for the OnIdle function.  To do this, select the OnIdle function from the ClassView.  Double-click the function to bring up the code, and delete it.  Next, right-click the function to bring up its properties, and select “delete”. 

Build and run the program.  Your world should be displayed on the screen.

Dragging an object

Now let’s allow the user to drag a chair or the table across the world.

First, we will need to create and initialize member variables to store various information.  Right-click on the MMainFrame class and select “Add Member Variable”.  Add the following variables:

Type

Name

Purpose

DWORD
table_group
store the handle of the table

DWORD
chair[3]

store the handle of each chair

DWORD
selected

store the handle of the currently selected group

CPoint

prevPoint
store the last known cursor coordinates, to know how far the mouse has 



moved.

Now we need to initialize these variables.  We cannot initialize them in the MMainFrame constructor because the frame is constructed before the world has been loaded.  At that point, we do not yet have access to the objects.  Instead, let’s initialize them in the InitInstance function, right after we load the world:

pMainFrame->chair[0] = Morfit_group_get_using_name("CHAIR1");

pMainFrame->chair[1] = Morfit_group_get_using_name("CHAIR2");

pMainFrame->chair[2] = Morfit_group_get_using_name("CHAIR3");

pMainFrame->table_group = Morfit_group_get_using_name("TABLE");

pMainFrame->selected = NULL;

All that remains is to add the code to handle the mouse.  Open up the ClassWizard.  Select the Class Name MMainFrame, and the Object ID MMainFrame.  Double-click on the following messages, to add code to handle them: WM_LBUTTONDOWN, WM_LBUTTONUP, and WM_MOUSEMOVE.

Here is the procedure that we want to follow:

When the user clicks the left button, we should check to see if he clicked on an object.  If so, select that object and capture the mouse.  Also, record the current location of the mouse cursor.

When the user moves the mouse, check to see if the mouse is captured.  If so, calculate how far the user has moved the mouse.  Translate the 2D movement across the screen into 3D movement across the world, and move the object to its new location.

When the user releases the left button, deselect the object and release the mouse.

Here is the code to handle the user clicking the left button:

void MMainFrame::OnLButtonDown(UINT nFlags, CPoint point)

{

double result[3];

DWORD object, polygon;


if (nFlags == MK_LBUTTON)


{



if(OK != Morfit_engine_2D_point_to_3D(point.x, point.y, result, 


&object, &polygon))




return;



selected = Morfit_polygon_get_group(polygon);



prevPoint = point;



if ((selected == chair[0]) || (selected == chair[1])|| (selected== 

chair[2]) || (selected == table_group))




SetCapture();


}

}

Listing 6.1

The reason that we check to see if the selected object is one of the chairs or the table is that otherwise, the user may be dragging another object in the world (e.g. the floor), and we wish to restrict the user to dragging a table or chair.

Here is the code to handle the mouse movement:

void MMainFrame::OnMouseMove(UINT nFlags, CPoint point) 

{


if(GetCapture() != this)



return;


if (nFlags == MK_LBUTTON)


{



DWORD object, polygon;



int delta_x,delta_y;



double prev3D[3], new3D[3];



double step3D[3];



if(OK != Morfit_engine_2D_point_to_3D(prevPoint.x, prevPoint.y, 


prev3D, &object, &polygon))




return;



delta_x = point.x - prevPoint.x ;



delta_y = point.y - prevPoint.y ;

Morfit_engine_translate_movement_on_screen_to_movement_in_world( prev3D, new3D, delta_x,delta_y);



step3D[0] = new3D[0] - prev3D[0];



step3D[1] = new3D[1] - prev3D[1];



step3D[2] = new3D[2] - prev3D[2];



Morfit_group_move(selected, step3D, WORLD_SPACE);



prevPoint = point;



Invalida(false);


}

}

Listing 6.2

This function checks to see if the mouse has been captured.  (If it has not been captured, the user is merely moving the mouse without holding down the button.   We ignore this movement by returning from the function immediately.)  If the mouse has been captured, we use Morfit_engine_2D_point_to_3D() to get the current location of the point on the object which the user is dragging.  We calculate how far the mouse has moved, and translate that movement into 3D coordinates.  The selected group is then placed in the new location.

The final function that we need to write is OnLButtonUp().  When the user releases the mouse button, we release the captured mouse.

void MMainFrame::OnLButtonUp(UINT nFlags, CPoint point) 

{


if(GetCapture() != this)



return;


ReleaseCapture();


}

Listing 6.3

Build and run the program.  You should be able to drag any of the objects in the world by holding down the left mouse button as you drag them.

Grouping Objects

Now let’s demonstrate grouping and ungrouping objects.  Right now, when you drag the table or a chair, only that object is moved.  We wish to allow the user to add and remove chairs to a group.  When the user drags the table, any chairs in the selected group will move along with the table.

The implementation is very simple.  When the user selects a chair, we will add that chair to the table’s group by setting the chair’s father group to the table’s group.  After that, moving the table will move the chair along with it, because the chair will be part of the table’s group.  To remove a chair from the group, we simply set its father group to NULL.  Then, when the table is moved, the chair will not move along with it.  Here is all the code that we need to add (in the OnLButtonDown function):

if (nFlags & MK_CONTROL)


{



if(OK != Morfit_engine_2D_point_to_3D(point.x, point.y, result, &object, &polygon))




return;



DWORD GroupToAdd = Morfit_polygon_get_group(polygon);



if (Morfit_group_get_father_group(GroupToAdd) != table_group)




Morfit_group_set_father_group(GroupToAdd,table_group);



else




Morfit_group_set_father_group(GroupToAdd, NULL);


}

Listing 6.4

If the CTRL key was held down when the mouse button was clicked, this function checks to see if we clicked on an object.  We find the group of the polygon that was clicked on (i.e. which chair the polygon belongs to). If the chair is not already part of the table group, we add it.  If it is part of the table group, we remove it.

Build and run the program.  Try dragging a chair or the table.  It should continue to work as before.  Now hold down CTRL, and click on a chair.  You can continue to move the chair as usual.  Drag the table.  The chair should move along with the table.  Control-click again on the chair to remove it from the group.  Drag the table - the chair will be left behind.

Summary

In this chapter we looked at groups.  Groups allow you to create a hierarchy of objects in the world.  You use groups to control the world in Editor Mode.  Together with Editor Mode, the Group API gives you complete control over all of the objects that make up the world.

Chapter 7 – The Engine API

The Engine API contains a wide variety of functions that relate to the world as a whole and the way in which it is displayed on the screen.  We have encountered a number of these functions already- for example, almost every program will need to load a world and display it on the screen.  In this chapter we will take a detailed look at many of the functions in the API.

Once again, the functions described in this chapter do not provide an exhaustive list of the functions in the Engine API.  Instead, they focus on the more commonly used functions.  For a complete list of available functions, look in Morfit Extension Help or in the Morfit header file.

One set of functions that will not be covered in this chapter is those relating to using graphics accelerator cards.  These functions in the Engine API are obsolete- instead, use the 3D Card API, described in Chapter 10.

Loading the World

Every program that we have written has called the function to load a world into the engine:

int Morfit_engine_load_world(char *world_file_name, char *world_directory_path, char *bitmaps_directory_path, int world_mode);

The function returns OK if the world was loaded successfully, and VR_ERROR if it was not.

The parameter world_mode, as we have seen, is used to specify whether you want to load the world in Viewer Mode or Editor Mode.  Here is a complete list of the possible values for world_mode:
USER_DEFINED_BEHAVIOR
Load the world in Viewer Mode

AUTO_BEHAVIOR01

Automatically moves the camera or an object according the arrows key

EDITOR_MODE


Loads the world in Editor Mode

DONT_USE_ZBUFFER

Do not use the z buffer

To specify more than one option, you can use an “|” operation: (AUTO_BEHAVIOR01 | DONT_USE_ZBUFFER).  Note that DONT_USE_ZBUFFER is incompatible with EDITOR MODE- Editor Mode always uses the z buffer.  (For more on the z buffer, see the section on Display Accuracy, below.)

If another world was already loaded, the new world will replace the old one in the engine.  Sometimes you might want to load a second world into an already loaded world without replacing it.  For example, suppose that you have loaded a world that contains a road, and have another world file that contains a model of a car.  You can use Morfit_engine_add_world() to load the model of the car into the world without replacing the world with the road.  The function is called as follows:

DWORD Morfit_engine_add_world(char *world_file_name, char *world_directory_path, char *bitmaps_directory_path, double position[3]);

Note that position indicates where the origin of the new world will be placed.  The function returns a handle to a group that contains the added world.  Usually, you will want to call Morfit_group_set_location() to move the center of the added group to the position.  Why?  Let’s say that you have a car stored in the file “car.wld”, and you want to place the car at position[3].  Remember that in all probability, the car is not located at location [0,0,0] in its world.  Therefore, if you call the following:

car_world_handle = Morfit_engine_add_world(“car.wld”,””,””,position);

the car will be located away from position just as it is located away from the origin in its own world.  To move the car to the correct location, you should then call:

Morfit_group_set_location(car_world_handle,position);

This will ensure that the car itself, and not the origin of the car’s world, is located at position.

To check to see whether the engine currently has a world loaded, call the following function:

int Morfit_engine_is_engine_empty(void);

It returns YES if the engine is empty and NO if a world has been loaded.

The inverse of the Morfit_engine_load_world() command is Morfit_engine_save().  This allows you to save all information related to the current state of the world, so that it can be recreated later with Morfit_engine_load_world().

int Morfit_engine_save(char *file_name, DWORD group_to_save, int save_flags);

file_name is the file to which you wish to save the world.  If you do not specify a file extension, it will default to the .wld format.

group_to_save is the handle of the group which you want to save to disk.  Use NULL to save the entire world.

save_flags can be one or more of the following options.  To combine options, use the “|” operation.

SAVE_DEFAULT

SAVE_ONLY_WHATS_NEEDED
Does not save extra resources that are not needed for the saved group. It will only save those animations that are needed for the polygons in the given group. Cameras, backgrounds and tracks will not be saved.

SAVE_FLAT_BITMAP_PATH

Does not save the directory path for each polygon- assumes they are all stored in the same directory.








SAVE_BITMAP_AS_JPG

Saves the bitmaps in the JPG format.

SAVE_BITMAP_AS_BMP

Saves the bitmaps in the BMP format

SAVE_BITMAP_AS_JBM

Saves the bitmaps in the JBM format

SAVE_IN_MULTIPLE_FILES

Saves each object in its own file

SAVE_ONLY_MODELS




SAVE_RELEASE


All objects placed in the main module

SAVE_BITMAP_OPTIMIZED

Saves all bitmaps in the JGP forma, except those with transparency, which are saved in the BMP format

JPG is the most compressed bitmap format.  It will save space, but is lower quality and will take longer to load.  Also, bitmaps with transparent pixels will not look right.  The BMP file format is larger, but its picture quality is better.  Save in the BMP format if you want to be able to edit the bitmaps in an outside editor like PhotoShop or PaintBrush.  The JBM format is the engine’s internal format.  JBMs will load the fastest.

Displaying the world

Once a world has been loaded into the engine, you can render it into a window on the screen.  These functions display the world and control the window on which it is displayed.

Morfit_engine_render() is perhaps the most important function in the entire Morfit SDK.  It takes the internal state of the currently loaded world and displays it on the screen.

Morfit_engine_render(HWND hwnd, DWORD camera);

hwnd is a handle to the window that you wish to render to.  NULL represents the default rendering window.  In MFC, if you wish to render to the program’s main windows, use:

Morfit_engine_render(m_hWnd, camera_handle);

Note that when called in Viewer Mode, Morfit_engine_render() does more then just display the world on the screen.  It also advances all objects and camera who are set for some type of automatic motion.  For example, it will advance objects along their tracks, advance object and cameras that are set to chase other objects, or move objects according to their physics settings. To disable automatic movement call the following functions with the parameter NO:

Morfit_engine_advance_objects_automatically(yes_or_no_flag);

Morfit_engine_advance_cameras_automatically(yes_or_no_flag);

The default rendering window is the window on which the world is drawn if you supply a NULL window handle to Morfit_engine_render().  The following functions control the default window:

Morfit_engine_set_default_rendering_window_size(int left_x, int top_y, int width, int height);

Morfit_engine_maximize_default_rendering_window(void);

Morfit_engine_minimize_default_rendering_window(void);

Morfit_engine_set_default_rendering_window_title(char *text);

Morfit_engine_set_default_rendering_window_size(int left_x, int top_y, int width, int height);

HWND Morfit_engine_get_default_rendering_window_hwnd(void);

By default, Morfit_engine_render() will display the whole world.  To restrict the engine so that it displays only a part of the world, call the following function:

Morfit_engine_set_group_to_render(DWORD grp_to_render_handle);

To resume rendering the whole world, call Morfit_engine_set_group_to_render(NULL);

You can set the resolution and color depth of the display window with the following function:

Morfit_engine_set_resolution(int width, int height, int bits_per_pixel);

Morfit_engine_get_resolution(int *width, int *height, int *bits_per_pixel);

Morfit_engine_set_color_depth(int bits_per_pixel);

bits_per_pixel can be 8, 16, or 24.  The Morfit Engine works fastest at 16 bpp, which is the default setting.

Common screen resolutions are 640 x 480, 800 x 600, and 1024 x 768.

At times, you may wish to render first on to a location in memory instead of directly on to the screen.  For example, if you wish to add to the rendered image before it is displayed on the screen, you can write it first to memory, add your changes, and then place that image on to the screen. 

To write to memory instead of on to the screen:

HDC Morfit_engine_render_on_memCDC(HWND hwnd, DWORD camera_handle);

This function returns the Hardware Device Context, or HDC, of the rendered image.  This HDC is passed to many of the Windows API commands that allow you to draw on the screen.

After you have finished making changes to the image in memory, you can display it on the screen using:

Morfit_engine_bitblt();

Display Accuracy

The main tradeoff that you will encounter in rendering is between speed and picture quality.  There are many options that you can set that will affect, on the one hand, the quality and accuracy of the image, and on the other hand, the time it takes to render the image.  This section looks at a variety of tools that you can use to affect the performance of the engine.  Experiment with the following settings in each of your programs until you find the fastest setting that still displays an accurate and attractive image.

Picture Quality

We encountered picture quality in Chapter 4, when we looked at the Morfit_camera_get_height() and Morfit_camera_get_width() functions.  Picture quality represents the total area of the world that the current camera is displaying.  If you display a very small area of the world in a large window, the picture quality will appear very poor.  If you display a very large area of the world in a small window, the picture quality will appear very good.  The following functions will control picture quality:

Morfit_engine_set_picture_quality(int quality);

int Morfit_engine_get_picture_quality();

Morfit_engine_increase_picture_quality();

Morfit_engine_decrease_picture_quality();

Displaying Far Away Objects

When you display an image on the screen, you do not usually need uniform accuracy throughout the whole image.  The human eye perceives far-away objects less clearly than close-by objects. Details which can be seen clearly from near by cannot be seen as they move farther away.  You can save a lot of time if you render your image in the same way, hiding details of far-away objects so that you can spend more time displaying high-quality images of nearby objects.  There are several ways in which you can effect the accuracy at which far-away objects are displayed.

Bitmaps provide a level of detail that is not always important for far-away objects.  You can instruct the engine to replace bitmaps with a solid fill color for objects that are far from the camera. 

Morfit_engine_set_far_objects_color_accuracy(int value);

int Morfit_engine_get_far_objects_color_accuracy();

Morfit_engine_increase_far_objects_color_accuracy();

Morfit_engine_decrease_far_objects_color_accuracy();

value should be in the range between 0 and NUMBER_OF_PALETTES –1.

More extreme than not displaying bitmaps on far-away objects is not displaying the objects themselves.  This technique is based on the idea that far-away objects are not usually immediately important to a game.  The culling depth of the image is the depth beyond which objects will not be displayed.

Morfit_engine_set_culling_depth(int value);

int Morfit_engine_get_culling_depth();

Morfit_engine_increase_culling_depth();

Morfit_engine_decrease_culling_depth();

Unfortunately, culling far-away objects can lead to unrealistic views in which objects that weren’t there before suddenly pop into the display as soon as they come into range.  The Morfit Engine provides a better solution, known as atmospheric effect, or fog. Fog provides a convenient way to obscure far-away objects without losing realism.

When you add fog to your world, the engine will use it to block out objects that are far away, and obscure the details (such as bitmaps or colors) of objects that are a bit closer up.  The engine will still display clearly objects that are close to the camera.  As objects get closer, they will gradually grow more detailed, instead of appearing to pop out of nowhere, as would be the case were you to use culling.

To see how fog affects the display, open up any world in the World Builder.  Press the Increase Atmosphere button to increase the atmospheric effect.  To change the color of the fog, use the Select Custom Color tool to select a color, and then click on the background.  You will be prompted whether you want to set the color of the background or of the atmospheric effect- select atmospheric effect.  (Usually, the color of the fog should match the color of the background.)

To set the atmospheric effect from within your program:

Morfit_engine_set_atmospheric_effect_intensity(double value);

double Morfit_engine_get_atmospheric_effect_intensity();

Morfit_engine_increase_atmospheric_effect_intensity();

Morfit_engine_decrease_atmospheric_effect_intensity();

Morfit_engine_toggle_atmospheric_effect();

To set the coof the fog:

Morfit_engine_set_atmospheric_effect(int red, int green, int blue);

Morfit_engine_get_atmospheric_effect(int *red, int *green, int *blue);

red, green, and blue should be integers between 0 and 255.

These functions will automatically set the color of the background to the color of the fog.  To set the color of the background independently:

Morfit_engine_set_background_color(int red, int green, int blue);

Morfit_engine_get_background_color(int *red, int *green, int *blue);

Z Buffer

Another factor that affects performance is whether the engine uses the z buffer.  Z buffer is an algorithm that the engine can use in order to decide which surfaces in the world are visible and which surfaces are hidden.  Usually, not using the z buffer is both quicker and more accurate, but there are times when the z buffer algorithm is better. In each of your programs, you should experiment to determine which method is better in your particular case.

When you load the world in Editor Mode, the z buffer is always used.  In Viewer Mode, you can control whether the z buffer is used with the following commands:

int Morfit_engine_use_zbuffer(int yes_no_flag);

int Morfit_engine_is_zbuffer();  // returns YES or NO

Rendering Mode

The Morfit Engine provides three rendering modes.  The default is “normal”.  In the “normal” rendering mode, the engine displays all objects and bitmaps.  In the “color fill” rendering mode, no bitmaps are displayed.  Instead, the objects are displayed in solid colors.  The “wire frame” mode displays only the outlines of the objects.  While you will rarely want to change rendering mode from “normal”, you can see the effects of the changes in the World Builder by selecting Camera Mode and then right-clicking on the image.  Select “Render’s Info”.  You can change the display mode by selecting “Full Render”, “Without Bitmaps”, or “Wire-frame”.

To set the display mode in your program:

Morfit_engine_set_normal_rendering_mode();

Morfit_engine_set_color_fill_rendering_mode();

Morfit_engine_set_wire_frame_rendering_mode();

2D and 3D Space

As we have seen, the Engine API is used to control the way in which the world is displayed on the screen.  One factor that makes rendering difficult is that we are displaying a 3D world, while the display screen is 2 dimensional.  When the user clicks the mouse on a pixel, you must convert this (x,y) value to a 3D coordinate.  Of course, each 2D coordinate can correspond to many (in fact, infinitely many) different 3D locations.  This section describes a set of functions that you can use to convert between the 2D coordinate system of the display and the 3D coordinate system of the world.

3D To 2D Conversion

Every 3D point in the world maps to exactly one 2D coordinate on the screen.  The following function calculates the 2D screen coordinate:

int Morfit_engine_3D_point_to_2D(double p3D[3], int p2D[2]);

After the function returns, p2D[0] will contain the x coordinate and p2D[1] will contain the y coordinate.  The function returns one of the following values:

-1: 
An error occurred. p2D contains 0,0.

0:
OK.  p2D contains a point inside the window.

1:
The given point lies outside the window.  p2D contains a valid result.

2:
The given point is behind the camera. The result in p2D is not accurate.

3:
The given point is both behind the camera and outside of the window.  The result in p2D is not accurate.

The following function converts a line from 3D to 2D coordinates.  You provide the endpoints of the line, p1 and p2, and the engine returns the endpoints of the result in p1_2D and p2_2D.

int Morfit_engine_3D_edge_to_2D(double p1[3], double p2[3], int p1_2D[2], int p2_2D[2]);

The return value indicates one of the following;

EDGE_FULLY_SEEN:

The edge is fully inside the window.  The result is valid.

EDGE_PARTIALLY_SEEN:
Part of the line is inside the window.  p1_2D and p1_3D define the segment of the line that lies inside the window.

EDGE_NOT_SEEN:

The entire line is outside of the rendering window.  The result is not valid.

VR_ERROR:


An error occurred.  The result is not valid.

The Morfit_engine_clip_edge() function is similar, except that instead of providing the 2D coordinates of the endpoints of the line, it provides the 3D coordinates of the endpoints of the line, clipped to fit inside the viewing window.

int Morfit_engine_clip_edge(double p1[3], double p2[3], double clipped_p1[3], double clipped_p2[3]);

This function returns the same results as Morfit_engine_3D_edge_to_2D().  clipped_p1 and clipped_p2 contain the endpoints of the clipped line.

2D to 3D Conversion

What makes 2D to 3D conversion more difficult is the fact that each point in the 2D window can correspond to an infinite number of points in the 3D world.  Morfit provides a number of functions to help you find the 3D coordinate that you desire.

Usually, if a polygon exists at the given point on the screen, then that is the 3D point that you desire.  

int Morfit_engine_2D_point_to_3D(int x, int y, double result[3], DWORD *selected_object_handle, DWORD *selected_polygon_handle);

If a polygon exists at the given point, the function will return OK, provide the 3D coordinate, and give you handles to the polygon and the object which lie at that location.  If more than one polygon lies at the given location, the function will return the front polygon (the one closest to the camera).  If there is no polygon at the given screen location, the function will return VR_ERROR.

Sometimes you will want the engine to return a 3D coordinate, even if there is no polygon at the given point.  In that case, you must provide a 2D point and a plane.  This function will return the corresponding 3D point that lies on the given plane.  

int Morfit_engine_2D_point_to_3D_point_on_plane(int x, int y, double polygons_plane[4],double p3d[3]);  // returns SUCCESS or VR_ERROR

The plane is specified in standard form, Ax + By + Cz + D = 0, where:

polygons_plane[0] = A

polygons_plane[1] = B

polygons_plane[2] = C

polygons_plane[3] = D

For example, the plane x = -20 is specified as 1x + 0y + 0z + 20 =0, so polygons_plane = {1,0,0,20}.

If you need to know which object or polygon lies at a given 2D point, but do not care about the corresponding 3D coordinate, you can use the following function:

DWORD Morfit_engine_get_object_at_point_2D(int x,int y);

DWORD Morfit_engine_get_polygon_at_point_2D(int x,int y);

When the user is dragging an object across the screen with the mouse, it is very useful to be able to convert the 2D movement of the mouse into 3D movement across the world.  The following function provides this information:

int Morfit_engine_translate_movement_on_screen_to_world(double p3D[3], double result_p3D[3], int delta_x, int delta_y);

You provide p3D (a 3D point on the screen), and delta_x and delta_y, the amount of movement across the screen.  The function computes result_p3D, the location of the point after it has been moved the given distance across the screen.

For example, suppose that an object is located at [x,y,z].  The mouse was last at screen coordinates (oldx,oldy).  The user has dragged the mouse to (newx,newy).  To move the object in response to the mouse movement:

int delta_x = newx – oldx;

int delta_y= newy – oldy;

double obj_loc[3] = {x,y,z};

double new_loc[3];

Morift_engine_translate_movement_on_screen_to_movement_in_world(obj_loc, new_loc, delta_x, delta_y);

Morfit_object_set_location(object_handle,new_loc[0],new_loc[1],new_loc[2]);

Movement

Collision Detection

The Engine API provides a function to perform collision detection.  Suppose that an object is at start_location, and you wish to move it to end_location.  The following function will determine whether there are any polygons blocking the movement from Point1 to Point2.

int Morfit_engine_is_movement_possible(double start_location[3], double end_location[3], DWORD *intersected_polygon, double intersection[3], DWORD *blocking_object);

You provide start_location and end_location.  If there is nothing blocking the movement, the function will return YES.  If there is a polygon blocking the movement, the function will return NO.  intersected_polygon and blocking_object will contain hato the polygon that blocked and the object to which the polygon belongs.  intersection will contain the point on the polygon which intersects the movement.

This function is nearly identical to Morfit_object_is_movement_possible().  However, that function allows you to exclude a single object from the collision calculations.  For example, to determine whether a car can move from one point to another, you don’t want to be blocked by the hood of the car!  For an example use of Morfit_object_is_movement_possible(), see Chapter 3.

Morfit_engine_is_movement_possible() only returns the first polygon that you would hit moving from one point to another.  If you wish to know how many polygons you would pass through on the path between 2 points, use the following:

int Morfit_engine_get_number_of_collisions(double point1[3], double point2[3], double combined_normal[3]);

In addition to returning the number of collisions, it calculates the average normal of all of the blocking polygons.

Movement Speed

If you move an object by 50 units each time the world is rendered, the speed at which the object moves will depend on the processing speed of the computer.  If you want the speed of the object to be constant, and not dependant on the speed of the particular computer, you can calculate the relative speed of the processor, and control the movement accordingly.  Morfit_engine_get_computer_speed_factor() returns the current speed of the processor.  To move at a constant speed, no matter how fast the processor, use the following:

factor=Morfit_engine_get_computer_speed_factor();

corrected_number= 50*factor;

move_my_object(corrected_number);

Note that the computer speed factor constantly changes, depending on the present load on the CPU.  You can’t get the speed once and use it for the entire program.  You should check it each time you want to use it.  The function is very fast, so feel free to call it as often as you would like.

The Log Window

Any time you load a world into the engine, you see a log window that displays the progress of the current activity.  Morfit allows you to create a log window for your own purposes.  Anytime you perform an operation that will take a significant amount of time, you may want to display the progress on the screen.  The following functions create a log window and control its display.  Here is an example log window:
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Figure 7.1

The log window contains 3 areas that you can control:  The text window, the progress number, and the target number.  The Progress Bar will be automatically updated to reflect the progress and target numbers.

To create a log window:

Morfit_engine_set_log_window_visible();

To remove the log window from the screen:

Morfit_engine_hide_log_window();

To minimize the log window:

Morfit_log_window_minimize();

To query whether the log window is currently visible:

int Morfit_engine_is_log_window_visible();

You can specify the text in the log window in either of two ways.  This function adds text to the window:

Morfit_engine_log_window_output(char *text);

This function replaces the current window text with the new text:

Morfit_engine_log_window_set_text(char *new_text);

To set the title of the log window:

Morfit_engine_log_window_set_title(char *new_caption);

To control the progress and target values:

Morfit_engine_set_log_window_progress(int value);

Morfit_engine_set_log_window_target(int value);

int Morfit_engine_get_log_window_progress();

int Morfit_engine_get_log_window_target();

You can also get the window handle of the log window.  This is often needed for functions in the Windows API.

HWND Morfit_engine_log_window_get_hwnd();

Miscellaneous Functions

This section describes some useful functions of the Engine API that do not fit neatly into any of the above categories.

Adding Polygons to the World

In Viewer Mode, you cannot add or remove objects from the world.  In Editor Mode, you can create new polygons and add them to the world.  First you create the new polygons (usually with Morfit_polygon_create()).  You then add points to the polygon using Morfit_polygon_add_point().  You can modify and move the polygon.  However, the polygon will not be displayed on the screen until you add it to the world:

int Morfit_engine_add_polygon(DWORD polygon_handle);

Eliminating Unnecessary Objects

Multiple polygons that lie on the same plane can be combined into one polygon.  For example:
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Figure 7.2

Combining polygons that lie on the same plane will help you save memory and processing time.  To combine polygons and eliminate unnecessary ones:

int Morfit_engine_reduce_polygons_count(double accuracy);

This function works only in Editor Mode.  It returns the number of polygons that were eliminated.  accuracy represents how closely the polygons must align to be combined.  For example, if accuracy is 0, only polygons that lie exactly the same plane will be combined.  If the normals of the two planes are 1.0 and .9, then the polygons will only be combined if accuracy is greater than or equal to .1.

Another tool that you can use to save memory is to unload from memory any bitmaps that you are done using:

int Morfit_engine_unload_unused_bitmaps();

This function returns the number of bitmaps that were unloaded.  To unload all bitmaps:

Morfit_engine_unload_all_bitmaps();

The Speaker

Whenever the engine detects an error, it causes the computer to beep, and then writes out the error to the “morfit.log” and “error.log” files.  You can turn off the speaker to stop it from beeping due to errors (the error will still get written to the log):

Morfit_engine_set_speaker_mode(int yes_no_flag);

Summary

The Engine API contains a wide variety of functions that determine the way in which your world is displayed on the screen.  You saw ways in which to control the accuracy of the display and time it takes to render an image.  You saw ways to convert between the 2D coordinate system of the screen and the 3D system of the world.  As we saw in Chapters 5 and 6, these functions are especially useful when moving objects around the world in response to the mouse.

Chapter 8 - Bitmaps and  Animations

If you look through the World Builder’s Model Gallery, you will notice that few of the models are filled with  solid colors.  Instead they are covered with pictures, known as bitmaps.  This chapter describes how to work with bitmaps: how to create them, place them on objects, and manipulate them.  It also explores the concept of an animation, a set of bitmaps that make an object appear to move or change.  We will use the World Builder to become familiar with bitmaps and animations.  We will then look at the APIs to see how to control them from our programs.

Placing Bitmaps

Before you can use a bitmap in your world, it must exist in a file.  You can find bitmaps in many different places: your hard disk, the Web, other models in the World Builder.  Right now, let’s create our own.  Open up Paint (it should be in the Accessories folder in the Start Menu.  You can of course use your favorite graphic editor- Paintbrush, Photopaint, PhotoShop, etc.). Draw anything you want- here’s what I came up with:
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Figure 8.1

Now save the picture.  Note that in Paint, if you use the normal File->Save command, it will save the entire canvas, including all of the white space that surrounds the picture.  Instead, select the picture that you’ve drawn.  From the Edit Menu, select Copy To.  Save it to a file on the hard disk. 

Next, open up World Builder.  Create a new world based on the Blank Floor template.  In the Model Gallery, in the 3Dforms folder, find the Morfit Cube and place it into the world.  You can see that the cube is covered with a bitmap, the Morfit Logo.  Notice that some of the sides of the cube have many copies of the logo, while some have only one big copy.  Rotate the object (or move the camera) until one of the sides with only one copy of the logo is facing you.

Let’s replace this bitmap with the one that we created.  Click on the Select Bitmap from Hard Disk button.  Find the bitmap that you created, and open it.  The mouse cursor will turn into a little bucket, the Fill tool.  Click on the side of the cube closest to you.  You should ssomething like this:
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Figure 8.2

If your bitmap is sideways like mine, don’t worry about it.  You can rotate a bitmap just like you rotate an object.  Just select Bitmap Mode and click on bitmap.  Now you can use the rotate buttons to turn your bitmap around.  Hold down the Shift key while you rotate the Bitmap to rotate in 90( increments.  The Blue Arrow buttons will flip the bitmap horizontally and vertically- experiment with them.

Tiling Bitmaps

When you placed the bitmap on the object, the World Builder resized it so that it fit the selected polygon exactly.  If you resize the bitmap to make it smaller, the engine will fill the polygon with multiple copies of the bitmap.  This is known as tiling the bitmap.  (Actually, the bitmap’s size didn’t change- the engine just adjusted the polygon’s bitmap coordinates.  You will see more about that later.)  Select the bitmap, and use the Plus and Minus Magnifying Glass buttons to resize it.  If you right-click on the bitmap while you are in Bitmap Mode, you can pull up the Tile properties.  Select how many vertical and horizontal copies of the bitmap should fit into the polygon, and hit OK.  The bitmap will be resized accordingly.

Transparency

The bitmap that we placed was opaque- the entire bitmap blocked out everything that lay behind it.  Sometimes you will want a transparent bitmap, in which part of the picture is see through.  To see how this works, select Load Bitmap from Hard Disk again.  This time, instead of clicking Open, notice the Transparent Color option in the bottom right corner.  Select Most Frequent Color.  Now open the bitmap, and click on the polygon.  The most frequently used color in the bitmap (in my case, yellow), will become transparent! You can place another object behind the cube, and verify that you can in fact see right through the bitmap.

When is transparency useful?  Suppose that you want to create an object that looks like a person.  If you Create a polygon and paste a bitmap of a person onto it, all of the white-space around the person will be seen.  The object will look like a rectangle with a person pasted on.  The solution is to make the area around the person transparent.  To see a good example of this, take any of the trees from the trees folder in the Model Gallery and place it in your world.  Notice that you can see around the different parts of the tree, while in reality it is only a bitmap pasted on a rectangle.

In the World Builder, only the most frequently used color can be made transparent.  We will see that using the Bitmap API in your program, you can select any color to be transparent.

It is important to remember that only one color can be made transparent.  If you want to make the background of an image transparent, the background must be entirely of one color.  For example, if the background is a mixture of the colors (255, 255, 255) and (254, 255, 255), to your eyes it will look like solid white, but the engine will see it as two separate colors.  For this reason, whenever you create or resample a bitmap using an outside editor, make sure that antialiasing is turned off.  (Antialiasing allows an editor to create a new color by tiling existing colors.)

Bitmap File Formats

The Morfit Engine currently supports 3 bitmap file formats:  BMP, JPEG, and JBM.  You can load bitmaps in any of these formats from the disk, and you can also save the bitmaps in the world to any of the 3 formats.  Each format has its advantages and disadvantages.

The BMP, or Windows Bitmap format, can store very high quality images.  Also, images in this format can be edited easily in Paint, PhotoShop, or any other graphic editor.  The disadvantage BMP is that it tends to produce very large files.

The JPEG format produces much smaller files, but the picture quality will be lower.  Also, because it uses antialiasing, JPEG may cause problems in images that have transparent areas.

JBM is the Morfit Engine’s internal format.  Store images in this format for the fastest load time.

Animation

An animation is a set of bitmaps that replaces itself over the course of time.  The simplest example would be a TV screen.  Instead of placing a bitmap on the TV screen, you could place a set of bitmaps on the screen.  While you view the world, the engine will cycle through the bitmaps.  Another example would be a tree.  If you replace the tree bitmap with a set of bitmaps of the same tree with the leaves in different places, it will look like the leaves are blowing in the wind.

Rather than creating our own set of bitmaps, let’s take a look at an animation that is already made.  Find the People->Kayak folder in the Model Gallery.  Take the boater and place it in the world.  Move the camera around.  As you move the camera, you will see the boater move. Launch Viewer Mode.  Move the camera around using the arrow keys.  Notice that as long as you are in front of the boater, you will see one set of images.  Move the camera to the side of the boater- the image changes, and you see a different set of pictures.  Close the viewer to return to the World Builder.

How does the Viewer know which set of bitmaps to display?  It depends on where the camera is in relation to the object.  If it is in front of the object, you will see one set of images.  If the camera is off to the side, you will see a different set of images.   In fact, to fully specify an animation, you need to provide 8 sets of bitmaps:
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Figure 8.3

However, the Morfit Engine makes it easier for you.  Notice that 2 and 8, 3 and 7, and 4 and 6 can be mirror images of each other.  The engine will automatically mirror one set of bitmaps to create the other set for you.  Now you only need to supply 5 sets of images: Front, Front-side, Side, Back-side, and Back.

Each bitmap has a time associated with it.  This represents how much time the image will be displayed before switching to the next picture.  In the boater animation, each picture is on the screen for an equal amount of time.  Let’s say you wish to show the image of a person standing still.  Every five seconds, you want the person to wave.  You could set the first image to last for 5 seconds, and the image of the person waving only 1 second.

In the World Builder, one of the tabs on the left side of the screen is the Bitmap\Animation View.  This view displays all of the bitmaps and animations that are currently loaded.  Right-click on the boater animation, and select Edit Animation.  You should see a window that looks like this (the specific animation name and bitmaps may differ):
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Figure 8.4

The pane on the left contains 5 groups of bitmaps: FRONT, FRONT_SIDED, SIDE, BACK_SIDED, and BACK.  For any animation, you can use as many or as few bitmaps as you would like.  However, each group must contain the same number of bitmaps.

The exception to this rule is the empty group.  For example, one set can have 4 bitmaps while another has none, but one can’t have 5 while another set has 4.  

For a simple animation, you may only need to define one of the views. For example, to create the image on a TV screen, you might only need to provide images for the FRONT view.  Turn on the Preview feature.  Select a bitmap.  You can remove the image, or add another image before or after it.  The Times field allows you to control how long the image is displayed for.  The time is measured in 1/100’s of a second, so 50 would display the image for half a second.  If you set the time of the first image of each group to 300, and leave the rest as they are, the boater would be still, and then row every 3 seconds.  Close the dialogue box, and hit OK to save the new animation.  Now you can place this new animation onto the boater.  Double-click the animation to select it, and then click on the boater to fill the polygon with the new animation.

To create a new animation, right-click anywhere in the Bitmap\Animation View and select Add Animation.  Select one of the 5 groups, and click Insert After.  You don’t have to add each bitmap to the group one by one- you can hold down the Control key and select all of the bitmaps that you want, and hit Open.  The selected bitmaps will be added to the animation.

The Bitmap 

Now that you are familiar with the concepts of bitmaps and animations, the APIs are very easy to understand.

Loading Bitmaps

Before you can work with a bitmap, you need to load it from the disk using the following function:

DWORD Morfit_bitmap_load(char *file_name, int transparent_index);

This function returns a handle to the loaded bitmap.

file_name is the name of the bitmap to load, without the file extension.  If you provide an extension, it will be ignored.  The engine will first search for a matching file with the .jbm extension, then with the .bmp extension, and only after that for a file with the .jpg extension.  You cannot override this, so it is impossible to load the file “mypicture.jpg” when there is also a file named “mypicture.bmp” in the same directory.  You must delete the .bmp file first.  You can provide a complete path, such as “c:\windows\bitmaps\mypicture”, or just a relative path, such as “bitmaps\mypictures”.

transparent_index allows you to specify which color, if any, should be transparent.  If you specify –1, then no color will be transparent.  0 specifies that the most frequently used color in the bitmap will be transparent.  1 means the second most frequently used color, 2 the third most frequently used color, etc.

Note: If you load a bitmap once with one transparent_index, and then load in the same bitmap with a different transparent_index, the engine treats them as two separate images, with two separate handles.

Once you have loaded bitmaps into memory, you can cycle through them as you do other objects, using  Morfit_bitmap_get_first_bitmap() and Morfit_bitmap_get_next(DWORD bitmap_handle).

You can get a specific bitmap using:

DWORD Morfit_bitmap_get_handle(char *file_name, int transparent_index);

While this looks similar to Morfit_bitmap_load(), remember that it only provides the handle to a bitmap that you have already loaded from the disk.

To save a bitmap that you have edited, use the function Morfit_bitmap_save():

Morfit_bitmap_save(DWORD bitmap_handle, char *full_path_name);

The bitmaps will be saved according to the file extension that you provide.  For example:

Morfit_bitmap_save( my_bitmap_handle, "c:\\John\\bitmaps\\grass.bmp");

will save the picture as a BMP file.  If full_path_name is NULL, it will resave the bitmap to the file from which it was loaded.

To unload a bitmap from memory when you are done using it:

Morfit_bitmap_unload(DWORD bitmap_handle);

Bitmap Colors

We have already seen that a color index of 0 represents the most frequently used color in the bitmap, 1 means the second most frequently used color, and so on.  You can find out the actual color that corresponds to a given index using:

int Morfit_bitmap_index_to_rgb(DWORD bitmap_handle, BYTE index ,BYTE *red, BYTE *green, BYTE *blue);

You supply the bitmap_handle and the index, and the engine returns the RGB value of the color.   The RGB value represents the amounts of red, green, and blue in the color.  For example:

Morfit_bitmap_index_to_rgb(my_bitmap, 0, &red, &green, &blue) will return the RGB value of the most frequently used color in the bitmap.

You can also find out how frequently a specific color occurs:

int Morfit_bitmap_rgb_color_to_index(DWORD bitmap_handle, BYTE red, BYTE green, BYTE blue);

You supply the color, and the function returns the index of the color.

Let’s say that you want to load a bitmap, and want bright red (RGB value red=255, green=0, blue=0) to be the transparent color.  Unfortunately, you don’t know how frequently this color is used, so you can’t specify its transparent index when you load the bitmap.  This will do the trick:

DWORD temp_handle = Morfit_bitmap_load(“picture”,-1);

int red_index = Morfit_rgb_color_to_index(temp_handle, 255, 0, 0);

DWORD my_bitmap = Morfit_bitmap_load(“picture”, red_index);

Morfit_bitmap_unload(temp_handle);

This loads the bitmap, calculates the index of the desired color, and then reloads the bitmap using the desired transparency index.  You can then unload the unneeded bitmap from memory.

You can find out the RGB value of the transparent color:

int Morfit_bitmap_get_transparent_rgb(DWORD bitmap_handle, int *red, int *green, int *blue) ;

This function returns VR_ERROR if the given bitmap has no transparent color.

To find out the index of the transparent color:

int Morfit_bitmap_get_transparent_index(DWORD bitmap_handle) ;

Resizing Bitmaps

The following function creates a new bitmap which is a copy of the original bitmap, only resized to the new height and width.  It returns a handle to the new bitmap.

DWORD Morfit_bitmap_resample(DWORD source_bitmap_handle, int new_width, int new_height);

You can duplicate a bitmap by specifying the original height and width.

To get the size of any bitmap, in pixels, use these functions:

int Morfit_bitmap_get_width(DWORD bitmap_handle);

int Morfit_bitmap_get_height(DWORD bitmap_handle);

Other Bitmap Functions

The following function returns the number of polygons that are filled with the given bitmap:

int Morfit_bitmap_get_number_of_polygons_using_bitmap(DWORD bitmap_handle);

We will see in the next chapter how to paste bitmaps onto polygons.

The Morfit_bitmap_get_memory() function returns the address of the bitmap in memory.  It returns a BYTE array of size width*height.  You can use this array to edit the pixels of the bitmap.  The bitmap is stored in the array by rows, starting from the top left.  To find a specific pixel, use the following formula:

array[width * (row-1) + column]

For example, array[0] is the top-left pixel.  array[width] is the first pixel in the second row, array[3*width+2] is the second pixel in the fourth row.

The array contains the color index of each pixel: once again, 0 is the most frequently used color, 1 is the second most frequently used color, and so on.  255 represents the transparent color, if one exists.

BYTE * Morfit_bitmap_get_memory(DWORD bitmap_handle);

The palette is an array that contains the mapping between each color index and its corresponding RGB value.  You can change an index’s RGB value using:

int Morfit_bitmap_set_palette_color(DWORD bitmap_handle, BYTE index_of_color_to_be_changed, BYTE red, BYTE green, BYTE blue);

You can find out how many colors are used in a bitmap using:

int Morfit_bitmap_get_palette_size(DWORD bitmap_handle);

If you want to get the index of a specific RGB value, call:

int Morfit_get_pallete_index(DWORD bitmap_handle, BYTE red, BYTE green, BYTE blue);

This function will return the index of color closest to the RGB value that you specified.

Let’s say that you have a bitmap loaded into memory, and you want to draw a green line across the entire top row of the image.  Here’s how you could do it:

BYTE green_index;

Morfit_bitmap_get_palette_color(my_bitmap, green_index, 0, 255, 0);

BYTE *bmp_ptr=Morfit_bitmap_get_memory(my_bitmap);

int width =Morfit_bitmap_get_width();

for(int i=0; i<width; i++) 

bmp_ptr[i]=green_index;

Here, we have found the next available slot in the color palette and filled it with green.  We loaded the bitmap into memory, and found the width of the bitmap.  Then we went along the top row of the bitmap, and set it to the new color index, which corresponds to green.

Note:  Changing palettes and bitmaps only works when using software rendering. 

Animations

Recall that animations are simply sets of bitmaps that are each displayed for a set amount of time.  Each animation can contain up to 5 sets of bitmaps, representing views from the front, front-side, side, back-side, and back.

For any given animation, not all sets of bitmaps must be used, but all sets that are used must contain the same number of bitmaps.  For example, if the FRONT set contains 6 bitmaps, then the BACK set can contain 6 bitmaps or 0 bitmaps, but not 8 bitmaps.

The Animation API contains functions to control the list of bitmaps in each set, and how long each bitmap is displayed for.

Creating Animations

To create an animation, call the function Morfit_animation_create():

DWORD Morfit_animation_create(char *name);

This function returns the handle to a new, empty animation.  As with any Morfit object, you can cycle through the list of animations using Morfit_animation_get_first_anima() and Morfit_animation_get_next(DWORD animation_handle).

char * Morfit_animation_get_name(DWORD animation_handle) returns the name of the animation, and Morfit_animation_set_name(DWORD animation_handle, char * name) changes its name.

To get the handle of a specific animation, call:

DWORD Morfit_animation_get_handle(char *animation_name);

If there is no animation with the given name, the function will return 0.

When you are done using an animation, delete it from memory using:

Morfit_animation_delete(DWORD animation_handle);

Adding Bitmaps

Once you have created an animation, you can add bitmaps to any of the 5 sets:

int Morfit_animation_add_bitmap(DWORD animation_handle, int bitmap_list ,DWORD bitmap_handle, int bitmap_position_index);

animation_handle is the animation to which to add the bitmap.

bitmap_list is one of the following constants:

BITMAP_LIST_FRONT

BITMAP_LIST_FRONT_SIDED

BITMAP_LIST_SIDE

BITMAP_LIST_BACK_SIDED

BITMAP_LIST_BACK

bitmap_handle is the bitmap to add

bitmap_position_index is the position in the sequence to add the bitmap.  For example, 0 will place the bitmap at the start of the sequence, 1 will place the bitmap after the first bitmap (the new bitmap will be second in the sequence), 2 will place the bitmap after the third bitmap, and so on.  –1 will place the bitmap at the end of the list.

This function returns the actual position in which it was placed.  (This will be different from bitmap_position_index if you supplied –1, or if you supplied too large a number- e.g. bitmap_position_index was 5 and the set only contained 2 bitmaps.  In that case your bitmap will be placed third (after the second bitmap) and the function will return 2.)

To remove a bitmap from an animation:

int Morfit_animation_remove_bitmap(DWORD animation_handle, int bitmap_list , int bitmap_position_index);

Here, bitmap_postion_index is the frame number of the bitmap to delete.  Once again, -1 represents the last bitmap in the set.

To get the handle of the bitmap in a specific position:

DWORD Morfit_animation_get_bitmap(DWORD animation_handle, int bitmap_list ,int bitmap_position_index);

To find out how many bitmaps are in an animation, use the following functions:

int Morfit_animation_get_number_of_frames(DWORD animation_handle);

int Morfit_animation_get_number_of_bitmaps(DWORD animation_handle);

The first function returns the number of bitmaps in each set, and the second returns the total number of bitmaps in the animation.  For example, suppose you have provided 4 bitmaps for each of the FRONT, SIDE, and BACK sets, and none in FRONT_SIDED and BACK_SIDED.  The first function will return 4, the second function will return 12.

The following function will fill an array with the handles of all of the bitmaps in the animation:

Morfit_animation_get_all_bitmaps(DWORD animation_handle, DWORD bitmaps_array[]);

The following lines of code fill an array with the handles of all of the bitmaps in the animation:

int number = Morfit_animation_get_number_of_bitmaps(my_animation);

DWORD *handles = (DWORD *) malloc(number * sizeof(DWORD));

Morfit_animation_get_all_bitmaps(my_animation, number);

(In C++, you can replace the malloc call with:  DWORD *handles = new DWORD[number];)

Frame Times

A bitmap’s frame time is the amount of time the bitmap is displayed before switching to the next bitmap.  Frame time is specified in 1/100’s of a second.  To specify the frame time of a bitmap:

int Morfit_animation_set_frame_time(DWORD animation_handle, int frame_index, DWORD time);

For example, Morfit_animation_set_frame_time(my_animation, 0, 200) would set the frame time of the first bitmap in each set to 2 seconds.

Retrieve the frame time of a bitmap with:

DWORD Morfit_animation_get_frame_time(DWORD animation_handle, int frame_index);

You can also set all of the frame times at once.  Create an array that holds the time of each frame, and then call:

int Morfit_animation_set_times(DWORD animation_handle, DWORD time_for_each_frame[], int size_of_array);

For example, to set the first frame to display for 3 seconds, and the next 2 frames to display for 2 seconds each:

DWORD times[3];

times[0]=300;

times[1]=200;

times[2]=200;

Morfit_animation_set_times(my_animation, times, 3);

To get the all of the frame times, first create an array to hold them, and call:

int Morfit_animation_get_times(DWORD animation_handle, DWORD time_for_each_frame[], int size_of_array);

This will fill the array with the frame times of each bitmap.

You can also scale the speed of the bitmaps:

Morfit_animation_factor_speed(DWORD animation_handle, double factor);

For example, suppose the first three frame times of an animation are 20, 2, and 1.  You can halve the speed of the animation (double the frame time of each bitmap) with:

Morfit_animation_factor_speed(my_animation, 2);

The new frame times would be 40, 4, and 1.  You can double the speed of the animation (halve the frame time of each bitmap) with:

Morfit_animation_factor_speed(my_animation, .5);

Because each bitmap must be shown (none of the times can fall below 1), the new frame times would be 10, 1, and 1.  (Note that the engine stores the original ratios, so that if you were to double the new times, they would return to 20, 2, and 1, not 20, 2, and 2.)

Other Animation Functions

This function returns YES if a given animation is used in the loaded world, and NO otherwise:

int Morfit_animation_is_part_of_the_last_world(DWORD animation_handle); 

To find out how many polygons are filled with a given animation:

int Morfit_animation_get_number_of_polygons_with_animation(DWORD animation_handle);

Summary

This chapter described the fundamentals of bitmaps and animations.  We looked at how to use the World Builder to add them to your world, and then we looked at the APIs that allow you to use them in your programs.  In the next chapter, in the course of learning how to work with polygons, we will see how to attach the bitmaps and animations to polygons.

Chapter 9 – The Polygon API

Polygons are the building blocks of objects. For example, a cube object is just a collection of 6 square polygons arranged in a specific way.  Until now, we have been dealing with objects as self-contained units.  This chapter looks at the polygons that make up the objects: how to create them and how to work with them.

What is a Polygon?

A polygon is a set of connected lines that all lie on the same plane.  The lines must form a loop, with the last line leading back to the first.  Also, all polygons must be convex- that is, all angles in the polygon must be less than 180(.  The following are not valid polygons, the first because it does not form a complete loop, and the second because it has two angles that are not convex:
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Figure 9.1

Here is a rule of thumb: imagine wrapping a rubber band around the polygon.  Will it fit snugly, or will it stretch across any open space?  If it fits snugly then the polygon is convex; otherwise, it is concave.

Creating Polygons

To create a new polygon:

DWORD Morfit_polygon_create(void);

This function creates a new polygon and returns its handle.  The polygon that is created is empty- it contains no points.  Also, the polygon is not added to the world:  It is not seen, it does not participate in collision detection, etc.  To add it to the world, you must call Morfit_engine_add_polygon().

Just as with any other Morfit type, you can find a polygon’s handle by calling:

DWORD Morfit_polygon_get_handle_using_name(char *polygon_name);

Or you can cycle through all the polygons in the world with:

DWORD Morfit_polygon_get_first_polygon(void); 

DWORD Morfit_polygon_get_next(DWORD polygon_handle);

You can access a polygon’s name through:

int Morfit_polygon_set_name(DWORD poly_handle, char *polygon_name);

char * Morfit_polygon_get_name(DWORD poly_handle);

To copy a polygon, call:

DWORD Morfit_polygon_duplicate(DWORD polygon_handle);

The following function deletes a polygon:

void Morfit_polygon_delete(DWORD polygon_handle);

Remember not to try to use a polygon’s handle after you deleted it!

The following function will join two polygons to create one larger polygon, if possible.  If it is successful, it deletes the 2 polygons that you providand returns a handle to a new polygon that combines the two.  If it is not successful (for example, if the new polygon would not be convex) it returns NULL and leaves the 2 polygons untouched.

DWORD Morfit_polygon_join(DWORD polygon1_handle, DWORD polygon2_handle);

A polygon is stored as a list of points.  Each point will be connected by a line to the next point.  The last point will connect to the first.  The following function adds a point to the end of the list:

DWORD Morfit_polygon_add_point(DWORD polygon_handle, double xyz_bmX_bmY_brightness[6]);

The array xyz_bmX_bmY_brightness is defined as follows:

xyz_bmX_bmY_brightness[0] = the point’s x coordinate

xyz_bmX_bmY_brightness[1] = the point’s y coordinate

xyz_bmX_bmY_brightness[2] = the point’s z coordinate

xyz_bmX_bmY_brightness[3] = the point’s bitmap-x coordinate

xyz_bmX_bmY_brightness[4] = the point’s bitmap-y coordinate

xyz_bmX_bmY_brightness[5] = the point’s brightness

bitmap_x and bitmap_y are only relevant when the polygon is filled with a bitmap.  We will look at their meaning later on.

For example, to create a polygon and add points to it at (10,10,10), (20,10,10), and (20,20,20), without using a bitmap:

DWORD polygon = Morfit_polygon_create();

double point1[6] = {10,10,10,0,0,0};

double point2[6] = {20,10,10,0,0,0);

double point3[6] = {20,20,20,0,0,0};

Morfit_polygon_add_point(polygon,point1);

Morfit_polygon_add_point(polygon,point2);

Morfit_polygon_add_point(polygon,point3);

To add a point to the top of the list instead of to the tail:

DWORD Morfit_polygon_add_point_to_head(DWORD polygon_handle, double xyz_bmX_bmY_brightness[6]);

To find out how many points are in the list:

int Morfit_polygon_get_num_of_points(DWORD polygon_handle);

To delete a point from the polygon:

Morfit_polygon_delete_point(DWORD polygon_handle, DWORD point_handle);

After you have finished constructing the polygon, you can check to see if it is valid with the following function:

int Morfit_polygon_is_valid(DWORD polygon_handle); // returns YES or NO

This function checks to see that the polygon is convex, that all points lie on the same plane, and that the bitmap coordinates and brightness points are valid.  Note that this error checking is done automatically when you call Morfit_engine_add_polygon().  Recall from Chapter 7 that Morfit_engine_add_polygon() adds the polygon into the world, so that it will be rendered and take part in collision detection.

Rotating and Moving Polygons

You rotate and move polygons in exactly the same way that you rotate or move objects or groups.

To rotate a polygon around one of its axes:

Morfit_polygon_rotate_x(DWORD polygon_handle, double degrees); 

Morfit_polygon_rotate_y(DWORD polygon_handle, double degrees); 

Morfit_polygon_rotate_z(DWORD polygon_handle, double degrees); 

To rotate a polygon so that it matches another polygon’s alignment:

Morfit_polygon_rotate_to_match_polygon(DWORD polygon_handle, DWORD reference_polygon_handle);

To move a polygon, relative to its current location:

Morfit_polygon_move(DWORD polygon_handle, double step[3]); 

The following function gets the location of the center of the polygon:

Morfit_polygon_get_location(DWORD polygon_handle, double location[3]);

Note that in Viewer Mode only, if the polygon belongs to a dynamic object, its location is defined in relation to that object’s center.  For example, if the function returns {0,0,0}, then the polygon is located at the center of the dynamic object, not at the world’s origin.  To get the polygon’s actual location, you must add the location of the object:

actual_x_location = object_x_location + polygon_x_location

actual_y_location = object_y_location + polygon_y_location

actual_z_location = object_z_location + polygon_z_location

This function moves the polygon to the specified location:

Morfit_polygon_set_location(DWORD polygon_handle, double location[3]); 

To move a polygon so a point of that polygon moves to match a given point:

Morfit_polygon_move_to_match_point(DWORD polygon_handle, DWORD point_belongs_to_polygon, DWORD point_to_match);

Note that this function will not rotate the polygon.

Polygon Properties

All polygons are one sided.  That means that if you look at the polygon from one side, you will see the fill color or bitmap that is attached to the polygon.  If you look at the polygon from the other side, you will see right through it.  So how does the World Builder create two sided polygons?  They are really just two one-sided polygons placed back to back.

To toggle which side of the polygon is visible:

Morfit_polygon_flip_visible_side(DWORD polygon_handle);

The following code segment will take a polygon, and create the effect that it is two sided:

DWORD flipped = Morfit_polygon_duplicate(original);

Morfit_polygon_flip_visible_side(flipped);

Just remember that when you move or rotate one polygon, you must move or rotate the other.  Even better, you should put the polygons together into a group using Morfit_polygon_set_group().

A polygon also has a property called rotated.  A rotated polygon will automatically turn so that its visible side faces the camera.  For example, you can create a bitmap of a tree and place it on a polygon.  But if you look at the tree from the side or the back, it will disappear.  If you make the polygon a rotated polygon, it will automatically turn to face the camera.  To see this effect, create a world in the World Builder and add a tree to the world.  Move the camera around, and notice that you always see the tree, no matter what direction you move the camera.  Now bring up the tree’s Properties of Polygon.  Uncheck the box marked Rotated.  Now move the camera around- when you move the camera behind the tree, it will be invisible.

Any time you have a polygon that should be seen from all sides, mark it rotated.  Also, any time you create an animation that can be viewed from the side or back, make sure that the polygon is rotated.

To mark a polygon as rotated in your program:

Morfit_polygon_set_rotated(DWORD polygon_handle, int yes_no_flag);

int Morfit_polygon_is_rotated(DWORD polygon_handle); // returns YES or NO

If you do no want a polygon to take part in collision detection:

Morfit_polygon_make_non_collisional(DWORD polygon_handle);

By default, polygons do take part in collision detection:

Morfit_polygon_make_collisional(DWORD polygon_handle);

int Morfit_polygon_is_collisional(DWORD polygon_handle);

Polygons can be enabled or disabled.  Disabled polygons are not displayed on the screen and do not take part in collision detection.

Morfit_polygon_disable(DWORD polygon_handle);

Morfit_polygon_enable(DWORD polygon_handle);

int Morfit_polygon_is_disabled(DWORD polygon_handle); // returns YES or NO

Note that it is much faster to disable and enable polygons than to delete and create them.  Suppose you are programming a game in which there are certain objects that can be destroyed- enemies that you can kill, treasures that you can take, etc.  Instead of deleting the object when it is destroyed and then creating it anew the next time you encounter a similar object, you can just disable the object.  When you need it again, you can just place it in the new location and re-enable it.

Fill Colors

It is very easy to set a polygon’s fill color:

Morfit_polygon_set_color_fill(DWORD polygon_handle, int red, int green, int blue);

red, green, and blue are the RGB values of the color.

To get a polygon’s color:

Morfit_polygon_get_color(DWORD polygon_handle, int *red, int *green, int *blue);

Bitmaps and Animations

Instead of using a solid fill color, you can attach bitmaps or animations to polygons.  We saw in the previous chapter how to load bitmaps and how to create animations.  This section describes how to attach them to polygons.

To attach a bitmap to a polygon:

Morfit_polygon_set_bitmap_fill(DWORD polygon_handle, DWORD bitmap_handle);

To get the name or handle of the bitmap attached to a specific polygon:

char * Morfit_polygon_get_bitmap_name(DWORD polygon_handle); 

DWORD Morfit_polygon_get_bitmap_handle(DWORD polygon_handle);

These functions will both return NULL if there is no bitmap associated with the polygon.

Bitmap Colors and Brightness

You access the transparent color of the bitmap (see Chapter 8 for a discussion of transparent bitmaps):

Morfit_polygon_get_transparent_rgb(DWORD polygon_handle, int *red, int *green, int *blue); 

int Morfit_polygon_get_transparent_index(DWORD polygon_handle);

Let’s say you want to paste a bitmap on one polygon, and then want to paste the same bitmap on another polygon, only with a different brightness level.  Instead of having to create two bitmaps, one brighter than the other, you can paste the same bitmap on both polygons and adjust the brightness level on one of them.

To control a bitmap’s brightness:

Morfit_polygon_set_brightness(DWORD polygon_handle, int value);

value controls how bright the bitmap is, compared to the original bitmap:

value = 100: the same brightness as the original bitmap

value = 200: twice as bright as the original bitmap

value = 50: half as bright as the original bitmap

Remember that when we added a point to the polygon, we specified that point’s brightness.  Each point of the polygon can have its own brightness value.  To see if all of a polygon’s brightness values are the same:

int Morfit_polygon_is_uniform_brightness(DWORD polygon_handle);

The following function returns the average brightness of the polygon:

double Morfit_polygon_get_brightness(DWORD polygon_handle);

If different vertices of the polygon have different brightness values, the bitmap will grow brighter or dimmer closer to each vertex.  However, having vertices with different brightness values will slow down the rendering process.

Brightness is currently only relevant when using software rendering.

Light diminution controls how much the atmosphere affects a given polygon.  If all polygons have the same diminution value, then the fog will effect all polygons equally.  If a polygon has a high diminution, it will take the fog’s color very quickly.  If a polygon’s diminution is 0, you will be able to see it even in heavy fog.

double Morfit_polygon_get_light_diminution(DWORD polygon_handle); 

Morfit_polygon_set_light_diminution(DWORD polygon_handle, double value);

For example, suppose you turn on atmospheric effect with its color set to black.  This will simulate night.  An object that represents a rock should have a high diminution.  It would be fairly hard to see in the dark, and unless the camera is very close to it, it will appear black.  However, a bonfire could be seen from very far away.  It should have a very low diminution value.

Bitmap Orientation

You can control how a bitmap is stretched across a polygon.  All bitmaps are rectangles, but polygons don’t have to be.  The Morfit Engine uses bitmap coordinates to specify how a bitmap is pasted onto a polygon.  Every bitmap is a rectangle whose top left point is bitmap coordinate (0,0), and bottom left coordinate is (1,1).  Remember the function Morfit_polygon_add_point()?  The second parameter is an array that specifies not only the x, y, and z coordinates of the point, but also the bitmap coordinates of the point.  These coordinates specify which point of the bitmap is attached to that vertex of the polygon.  For example, given the following bitmap:
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Figure 9.2

If you have the following polygon with the given vertex coordinates:
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Figure 9.3

The bitmap will be pasted like this:
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Figure 9.4

Notice that the top left corner of the bitmap is placed at (0,0), the bottom right of the bitmap is at (1,1), and so on.

Note that you only need to supply coordinates for three of the vertices of the polygon, and the engine will computer the rest. If you want the engine to compute a vertex’s bitmap coordinates, just supply the coordinates (-1,-1).

You can tile a bitmap across a polygon like this:
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Figure 9.5

The engine will calculate the point (1,1):
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Figure 9.6
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And tile the bitmap accordingly:

Figure 9.7

You can also stretch bitmaps across non-square polygons:
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Figure 9.8

To rotate a bitmap, call the function:

Morfit_polygon_rotate_bitmap(DWORD polygon_handle);

This will rotate the bitmap coordinates of each vertex of the polygon.

To flip the bitmap 180(:

Morfit_polygon_mirror_horizontal_bitmap(DWORD polygon_handle); 

Morfit_polygon_mirror_vertical_bitmap(DWORD polygon_handle);

Often, you will want a bitmap to continue from one polygon to another that is adjacent to it.  This function matches the coordinates of the bitmaps so that the picture flows seamlessly from one polygon to the next.

Morfit_polygon_match_bitmap_cords(DWORD source_polygon_handle, DWORD target_polygon_handle);

Animations

To associate an animation with a polygon:

Morfit_polygon_set_animation(DWORD polygon_handle, DWORD animation_handle);

The following function returns the handle to the polygon’s animation.  If no animation is attached to the polygon, it will return NULL.

DWORD Morfit_polygon_get_animation(DWORD polygon_handle);

To set which frame of the animation is currently visible, call:

Morfit_polygon_set_animation_frame(DWORD polygon_handle, int animation_frame);

0 is the first frame, 1 is the second frame, etc.  –1 will select the last frame.

To get the current animation frame:

int Morfit_polygon_get_animation_frame(DWORD polygon_handle);

Translucency

All the polygons that we have seen so far are opaque.  When you look at them, you see either the fill color, the bitmap, or the animation.  Polygons can also be transparent or translucent- they can let through all or some of the light or color behind them.  For example, think of a glass window.  You can see the window a little bit, but you can also see what is behind it.

Creating translucent polygons is very easy.  You simply call the following function.  (Note that blending only works when hardware rendering support is on.  Press CTRL-ALT-V to toggle hardware support.)

Morfit_polygon_set_translucent(DWORD polygon_handle, BYTE glass_type);

glass_type can be any of the following constants:

DISABLE_BLENDING

DARK_FILTER_GLASS

FILTER_GLASS

OPAQUE_FILTER_GLASS

NORMAL_GLASS

CONTROL_GLASS

BRIGHT_TRANSPARENT_GLASS

BRIGHT_TRANSLUCENT_GLASS
BRIGHT_OPAQUE_GLASS

LIGHT_SOURCE_GLASS

INVERSE_GLASS

For a complete description of the effects of each of these glass types, look in the mrft_api.h file.  You should test the different options and find the one that you like best.  They all control the way in which the polygon’s bitmap and the image behind the polygon are blended to create a final image.  DISABLE_BLENDING is the default, and makes the object opaque.

To get an object’s glass type:

BYTE Morfit_polygon_get_translucent(DWORD polygon_handle);

Polygon Math Functions

All points in a polygon must lie in the same plane.  To find out the equation of this plane:

Morfit_polygon_get_plane(DWORD polygon_handle, double plane[4]);

The plane’s equation is:

plane[0]*x + plane[1]*y + plane[2]*z + plane[3] = 0

The plane’s normal is the vector ( plane[0], plane[1], plane[2])

This function checks to see if a 3D coordinate lies inside the polygon:

int Morfit_polygon_is_point_inside_polygon(DWORD polygon_handle, double pnt[3]); // returns YES or NO

We saw that the function Morfit_engine_2D_to_3D can be used to find out which polygon is located at a certain (x,y) coordinate on the display screen.  To find out which vertex of the polygon is closest to the point (x,y), call:

DWORD Morfit_polygon_get_closest_point(DWORD polygon_handle, double p3d[3]);

It returns the handle to the closest point.

Polygons and Groups

We saw in Chapter 6 that groups are made up of polygons and other groups.

To add a polygon to a group:

Morfit_polygon_set_group(DWORD polygon_handle, DWORD group_handle);

To find out which group a polygon belongs to, call:

DWORD Morfit_polygon_get_group(DWORD polygon_handle);

This function returns YES if the polygon is in the given group, directly or indirectly, and NO otherwise:

int Morfit_polygon_is_in_group(DWORD polygon_handle, DWORD group_handle);

The orientation of a group defines the way in which the group aligns itself with the world.  Each group should have one ORIENTATION_TOP or ORIENTATION_BOTTOM polygon, and one ORIENTATION_FRONT or ORIENTATION_BACK polygon.  All other polygons should have ORIENTATION_UNKNOWN .  To set a polygon’s orientation:

Morfit_polygon_set_orientation(DWORpolygon_handle, int orientation_value);

Patches

Remember how we said that in Viewer Mode, you can’t create new polygons?  Well, there is one exception to this rule: patches.  Patches are special polygons that are stuck on top of other polygons.  You use patches to replace the bitmap of a part of the polygon with another bitmap.  For example, suppose that you have a game in which you shoot a gun at a wall.  Where the bullet hits the wall, you’d like to see a mark.  You can find out the location where the bullet hit the wall (remember, Morfit_engine_is_movement_possible() returns the location where the movement was blocked,) and place a patch at that location.  You can then set the patch’s bitmap to be a picture of a dent, or a bullet mark, or whatever you want.

You can create a polygon using:

Morfit_polygon_add_patch(DWORD polygon_handle, DWORD patch_polygon_handle);

You would then have to set the polygon’s location, bitmap, and properties.  Instead, use the following function, which does all of that for you:

DWORD Morfit_polygon_add_patch_easy(DWORD father_polygon, double center[3], double radius, double direction[3], DWORD bitmap_handle, int rgb[3]);

father_polygon is the polygon on which to create the patch

center is the location of the center of the patch

radius describes how big the patch should be.  Since the patch is really a square and not a circle, radius defines the distance from the center to the one of the square’s edges.

direction describes the direction towards the front of the patch and is used to orient the bitmap.  If you don’t care about the direction, use {0,0,0}.

bitmap_handle is the bitmap that will fill the patch.  If you would rather use a fill color, use NULL for bitmap_handle.

rgb- if bitmap_handle is NULL, rgb will describe the fill color of the patch.  If you provide a bitmap, rgb will be ignored.

The following function will delete a polygon’s patches:

Morfit_polygon_delete_patches(DWORD polygon_handle, int type_of_patches_to_delete_or_serial_number);

The last parameter is one of the following:

ALL_PATCHES – deletes all of a polygon’s patches

REGULAR_PATCHES – deletes all patches that were created using Morfit_polygon_add_patch() or Morfit_polygon_add_patch_easy().

SHADOW_PATCHES – deletes all of a polygon’s shadow patches.  Shadow patches are discussed in Chapter 11, Shadows and Lights.

Summary

This chapter described how to work with polygons.  Polygons are the building blocks of all objects and groups.  You associate fill colors, bitmaps, or animations with polygons in order to control their appearance.  Polygons can be opaque or translucent.  Special polygons called patches can be used to create different effects.  We will see more of patches in Chapter 11.

Chapter 10 – Other APIs

The previous chapters provided a detailed look at the major APIs in the Morfit SDK. There are a number of more minor APIs that you might not need to use quite as often, but still provide very useful functions.  This chapter gives a brief overview of each of these APIs.  For complete details, you are encouraged to use Morfit Extension Help in Microsoft Visual Studio, or read the function descriptions in the header file mrft_api.h.

The Point API

As we have seen, all groups and objects are made up of polygons.  Each of these polygons contains one or more points.  These points identify the vertices of the polygons.  Each point has the following attributes:

location

brightness

bitmap coordinates

The Point API allows you to set these values for any point.  For a discussion of what each of these values means, see Chapter 9.

The Track API

Objects, groups, and cameras can all be set to follow a track.  A track is simply a collection of points- x, y, and z coordinates- which define its path.  This API allows you to create and modify tracks.

The 3D Card API

The rendering process can be speeded up if your computer has a 3D graphics accelerator card.  Some effects, such as translucency, will only be visible if you are using a 3D card.  While any Morfit program is running, you can press CTRL-ALT-V to enable toggle hardware and software rendering.  To enable the 3D card from one of your programs:

int Morfit_3D_card_use(int YES_or_NO);

The 3D Card API also contains functions to check to see if a 3D card is available, and whether it is enabled.

The Background API

A background is simply a bitmap that the engine displays in the background of the world.  The engine wraps the background around the world, so that it can be seen no matter which direction the camera is facing.  Background properties include the background’s distance, which affects how far away the background appears and how much it appears to move when the camera moves up and down, and its bottom, which defines how high off the ground the background begins.  You can also control how quickly the brightness of the atmosphere blends into the brightness of the background.

The Math API

The final three APIs are not tied to the Morfit Engine at all.  Instead, they contain general functions that you might find useful while doing 3D graphics programming.

The Math API contains various mathematical functions to compute geometric properties.  For example, it contains functions to get the distance between 2 points, find the intersection between lines and planes, calculate the equation of a plane defined by 3 points, or the equation of a ray reflecting off a surface.

The Utilities API

Most of the Utilities functions offer convenient ways to work with bitmaps.  This API provides functions to load bitmaps from a disk, convert bitmaps between the BMP and JPEG formats, convert colors from 16 bit to 24 bit RGB values, etc.  It also provides functions to print out from various locations in memory, or to determine whether the operating system is Windows 98.

The Profiler API

The Profiler API provides two macros, MORFIT_START_TAKING_TIME(char * log_output _string), and MORFIT_STOP_TAKING_TIME.  These allow you to examine the efficiency of your program by calculating  how long a certain section of code takes to run.  The results will be printed out to the Morfit log file.

Summary

The fact that these APIs are small does not mean that they are not useful.  They contain many interesting functions, and are very simple to understand.  I encourage you to look at the mrft_api.h header file to get a more detailed look at the available functions.

Chapter 11 – Shadows and Lights

In Chapter 9, we looked at a special kind of polygon known as a patch.  A patch is simply one polygon that is pasted onto another.  Patches can be used to place different bitmaps or colors over a portion of a polygon.

One important use for patches is to create the effects of shadows and lights.  Patches are ideal for these effects because lights and shadows don’t create new shapes, they merely brighten or darken existing objects.  The Morfit Engine makes creating shadows and lights very easy.

Shadows

Let us first look at how a shadow is created.  Creating a shadow requires three objects: a light source, a polygon to cast the shadow, and a polygon to receive the shadow:
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Figure 11.1

You can create shadows using one easy function:

Morfit_engine_create_shadow(DWORD entity_receiving_shadow, DWORD entity_creating_shadow, double light_src[3], BYTE serial_number);

Both entity_receiving_shadow and entity_creating_shadow can be polygons, objects, or groups.  The two entities don’t even have to be of the same type.  For example:

Morfit_engine_create_shadow(wall_polygon, person_object, light, serial_number);

Morfit_engine_create_shadow(room_group, piano_group, light, serial_number);

If either handle is NULL, it is treated as the NULL group, which represents the whole world.  The following example will cast the piano’s shadow over all of the polygons in the world:

Morfit_engine_create_shadow(NULL, piano_group, light, serial_number);

light_src[3] contains the x, y, and z coordinates of the light source (note that for the purpose of casting shadows, all lights sources are point sources).

serial_number is any number between 10 and 255.  You can use it to differentiate between different groups of shadows.  For example, if you have two different objeccasting shadows, and one of them moves, you don’t want to have to recreate all of the shadows, only those cast by the object that moved.  For example:

Morfit_engine_create_shadow(room_group, person_object, light, 255);

Morfit_engine_create_shadow(room_group, piano_group, light, 254);

.

.

.

// Person moves

Morfit_polygon_delete_patches(room_group,255);

Morfit_engine_create_shadow(room_group, person_object, light, 255);

You can also use the serial number to change the color or bitmap fill of a specific group of patches.

To delete shadow patches, you can call either of the following:

Morfit_polygon_delete_patches(DWORD polygon_handle, int type_of_patches_to_delete_or_serial_number);

Morfit_group_delete_patches(DWORD group_handle, int type_of_patches_to_delete_or_serial_number);

The first function deletes all patches from a single polygon, the second deletes all patches from a given group.

Shadow Fill Color

Note that a shadow inherits the properties of the blocking polygon. If a translucent object casts a shadow, the resulting patch will be translucent.  If a person casts a shadow on the floor, the patch will be filled by the bitmap of the person.  Generally, this is not what you want.  You can change the patches’ properties so that the object casts a solid shadow.  (An exception might be the shadow from a stained glass window- it should cast the image of the window onto other objects.)

To change the color of a group’s shadows:

Morfit_group_set_patches_color(DWORD group_handle, int red, int green, int blue, int patches_type);

To fill the shadows with a bitmap:

Morfit_group_set_patches_bitmap(DWORD group_handle, DWORD bitmap_handle, int patches_type);

You will often want your shadow patches to be translucent.  This is because the shadow should usually merely darken the object receiving the shadow, not completely obscure it.

To change the patches’ translucency:

Morfit_group_set_patches_translucent(DWORD group_handle, BYTE translucent_type, int patches_type);

Remember that to see the effect of translucency, you must switch on hardware rendering.

In each of these functions, patches_type can either be a serial number, ALL_PATCHES, NORMAL_PATCHES, or SHADOW_PATCHES.

Dynamic Patches

Creating patches can be a slow process.  To speed the process up, use polygons for both the entity receiving the shadow and the entity casting the shadow.

Even when using polygons, however, creating shadows can take a long time.  For objects and light sources that do not move, you can create the shadows once at the beginning of the program, and not worry about them again.  For creating shadows for moving objects or light sources, however, the API provides a quicker function:

Morfit_engine_create_dynamic_shadow(DWORD entity_receiving_shadow, DWORD entity_creating_shadow, double light_src[3], BYTE serial_number);

This function takes exactly the same parameters as Morfit_engine_create_shadow().  Its advantage is that it is faster.  Its disadvantage is that if you want to delete some of the patches, you must delete all of them.  You cannot delete only the patches from one group or only the patches with a given serial number.  You delete dynamic patches with:

Morfit_engine_delete_dynamic_shadows(void);

Lights

Lights are created in nearly the same way as shadows.  In fact, the Morfit Engine uses the exact same function to create lights and shadows.  Think of light as “bright shadows.”  Take a look at the following picture:
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Figure 11.2

Here, we see a light source creating light on a destination polygon.  However, because the Morfit Engine works with point light sources, in effect we have the following:
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Figure 11.3

This  is identical to how we create a shadow:  we have a point light source, a blocking polygon, and a receiving polygon.  The only difference is that the light casts a “shadow” that makes the receiving object brighter, not darker, than it was before.

Here is one way to create a light effect: call Morfit_engine_create_shadow(), just as before.  Only now, set the resulting patch’s color to a bright color, or a bright bitmap, and make the patch translucent:

Morfit_engine_create_shadow(floor_polygon, light_polygon, light_point, serial_number);

Morfit_group_set_patches_color(floor_polygon, 200,200, 200, serial_number); Morfit_group_set_patches_translucent(floor_polygon, NORMAL_GLASS, serial_number);

However, remember that by default, patches share the properties of the polygon that created them.  Instead of setting the patches’ properties every time they are created, we can just set the properties of the blocking polygon once:

DWORD light_polygon = Morfit_polygon_get_handle_using_name(“light”);

Morfit_polygon_set_color(light_polygon, 200, 200, 200);

// OR, to use a bitmap instead of a solid color:

// DWORD bitmap = Morfit_bitmap_load("\\Bitmaps\\light", 0);

// Morfit_polygon_set_bitmap(light_polygon, bitmap);

Morfit_polygon_set_translucent(light_polygon, NORMAL_GLASS);

Now, to create a light effect, just call:

Morfit_engine_create_shadow(floor_polygon, light_polygon, light_point, serial_number);

That’s it- the patches will automatically have the same color (or bitmap) as the light polygon, and the patches will automatically be translucent.

What is the advantage of setting the light polygon’s properties, and not the patches’ properties?  Well, if you are only creating the light at the beginning of the program, and never changing it, then there is not a big difference. But if you want to recreate the light effect often- for example if the light source can move- then you will save a considerable amount of time by setting the properties of the light polygon instead of the patches themselves.

The only factor that makes creating a light more complicated than creating a shadow is that you have to create the blocking polygon.  Just place a polygon between the light source and the rest of the world.  For example, if the light source is on the ceiling, creating a polygon right below it.  You should then call Morfit_polygon_disable() to make it invisible.

A World with Lights and Shadows

We will now write a program that shows the effects of lights and shadows in the world.  Use the World Builder to create a new world.  The world should consist of the following: a room object (4 wall polygons and a floor polygon), a piano object, and a chair object.  Create a lamp object, and place it on the ceiling.  The lamp can be a simple cube or pyramid, or you can design a more complicated model.  Rename the top polygon of the lamp lamp_top.  Name the bottom polygon (or wherever you want the source of the light to be) lightSource.  Now create a blocking polygon named shadow right below the light source.

Because Viewer Mode is much faster than Editor Mode, we would like to load the world in Viewer Mode.  Therefore, make sure that all of the objects (room, lamp, piano, chair, and shadow) are dynamic.  Save the world as “light_vm.wld” and close the World Builder

Finally, select a bitmap to use for the light.  You can search for one on your computer or on the Internet, or you can create your own.  The bitmap should be fairly bright.  To create a nice effect, use a bitmap that is brighter in the center and darker towards the outside.  I will use the following bitmap, named “flare.bmp”:
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Figure 11.4

We would like a program that will allow us to rotate the light source using the arrow keys.  The lamp will continuously rotate around its z-axis.  The arrow keys will rotate it around its x and y-axes.  As the light source moves, it should recreate the light and shadow effects.  For the sake of simplicity, we will write a console application, but you could convert this program to MFC very easily.  Here is the general procedure that we will follow:

load the world

get the objects’ handles

loop:


rotate the lamp


delete old light and shadow patches


create new light patches


create new shadow patches

Here is the first part of the program:

#include <stdio.h>

#include <conio.h>

#include "..\\..\\..\\Engine\\Include\\mrft_api.h"

void main()

{

int rc=Morfit_engine_load_world("light_vm.wld", “.”, "Bitmaps", USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



printf("\nFailed to load world.\n");



p("Please look at error.log and morfit.log to see why.\n");



printf("Press any key to exit\n");



getch();



return;


}


//Use hardware rendering if exists


if(Morfit_3D_card_check_hardware_support()==YES)



Morfit_3D_card_use(YES);


Morfit_engine_maximize_default_rendering_window();


Morfit_engine_set_default_rendering_window_title("Light (Editor Mode) Use the arrows key.    Exit  -  <ESC>");


DWORD lamp_object=Morfit_object_get_object_using_name("lamp");


// the polygon in the light that we will use as our point source


DWORD light_polygon_polygon=Morfit_polygon_get_handle_using_name("lightSource");


//Let’s set the lamp rotation center at the top of the lamp


//In World Builder we named the top polygon as lampTop. The center


//of this polygon will be our rotation center


DWORD lamp_top_polygon=Morfit_polygon_get_handle_using_name("lampTop");


double location_of_top[3];


Morfit_polygon_get_center(lamp_top_polygon,location_of_top);


Morfit_object_set_rotation_center(lamp_object, location_of_top);


DWORD polygon_creating_shadow = Morfit_polygon_get_handle_using_name("shadow");


Morfit_polygon_disable(polygon_creating_shadow); 


DWORD flare_bitmap = Morfit_bitmap_load("Worlds\\Bitmaps\\flare2", 0);


Morfit_polygon_set_bitmap_fill(polygon_creating_shadow, flare_bitmap);


Morfit_polygon_set_translucent(polygon_creating_shadow, NORMAL_GLASS); 


DWORD room_handle = Morfit_group_get_using_name("room");


DWORD chair_handle = Morfit_group_get_using_name("chair");


DWORD piano_handle = Morfit_group_get_using_name("piano");


//Check to see that all objects loaded correctly:


if(piano_handle==NULL || chair_handle==NULL || room_handle==NULL) 



exit(-1);


DWORD camera=Morfit_camera_get_default_camera();

Note that we have enabled the 3D accelerator card.  Without using a 3D card, you will not see the effects of using transparency.  While the program is running, press CTRL-ALT-V to toggle use of the card, and see what a difference hardware rendering makes.

Now that the world is loaded and we have all the necessary handles, we will begin our loop:


for(;;) {



//rotate the lamp around the Z-axis



Morfit_object_rotate_z(lamp_object, 5, WORLD_SPACE);



//rotate the lamp according to the keyboard input



if(GetAsyncKeyState(VK_UP)<0 )   Morfit_object_rotate_y(lamp_object, 5 , WORLD_SPACE);



if(GetAsyncKeyState(VK_DOWN)<0 ) Morfit_object_rotate_y(lamp_object, -5, WORLD_SPACE);



if(GetAsyncKeyState(VK_RIGHT)<0) Morfit_object_rotate_x(lamp_object, 5 , WORLD_SPACE);



if(GetAsyncKeyState(VK_LEFT)<0 ) Morfit_object_rotate_x(lamp_object, -5, WORLD_SPACE);



if(GetAsyncKeyState(VK_ESCAPE)<0) break; 

After rotating the lamp, we need to delete the old patches.  Note that because the patches are being created and destroyed every rendering cycle, we can use dynamic patches for extra speed.



Morfit_engine_delete_dynamic_shadows();

Now let’s create the light.  Remember that to create light, we need a point source, a blocking polygon, and a receiving object.  For the point source, we will use the center of the lightSource polygon.  You could just as easily use the center of the lamp object.  Remember that we need to retrieve the point source’s position each time, because it will move as the light rotates.  For the blocking polygon, we use the shadow polygon.  Since we have 3 receiving objects (the room, the chair, and the piano) we will call the function once for each of these objects.


//get the light source location (it is changong since the lamp is moving)


double light_source_location[3];


Morfit_polygon_get_center(light_polygon_polygon, light_source_location);


//create the light


//Try changing the light source’s location (location_of_top)


//Here we create the light spot. Note that a bright shadow==light.


Morfit_engine_create_dynamic_shadow(room_handle, polygon_creating_shadow,light_source_location, 254);


//creating the light on the chair


Morfit_engine_create_dynamic_shadow(chair_handle, polygon_creating_shadow,light_source_location, 254);


//creating the light on the piano


Morfit_engine_create_dynamic_shadow(piano_handle, polygon_creating_shadow,light_source_location, 254);

Note that we have given the “light” patches the serial number 254.  This will distinguish them from the “shadow” patches, which will be given a different serial number.

Now let’s create the shadows.  To create the shadows, we also need a point source, a blocking polygon (or object) and a receiving object.  Here, the point source will be the center of the shadow polygon.  The receiving object will be the room, and the blocking objects are the chair and the piano.


//Creating the shadow


double light_source_for_piano_and_chair[3];



Morfit_polygon_get_center(polygon_creating_shadow,light_source_for_piano_and_chair);


Morfit_engine_create_dynamic_shadow(room_handle, piano_handle,light_source_for_piano_and_chair, 255);


Morfit_engine_create_dynamic_shadow(room_handle, chair_handle,light_source_for_piano_and_chair, 255);

When we created the light effect, the light patches automatically inherited the properties (translucence and bitmap) of the shadow polygon.  Here, the shadow patches automatically inherit the properties of the blocking objects.  But since we don’t want the shadows to be opaque, or to have the bitmaps of the piano and the chair, we will override these values:

//Note that since we give a serial number of 255 it won’t change


//the properties of the light patches(serial==254)


Morfit_group_set_patches_color(room_handle, 80,80,80, 255);  


Morfit_group_set_patches_translucent(room_handle, DARK_FILTER_GLASS, 
255);  

Now that we have created the lights and shadows, all that remains is to render the world:



Morfit_engine_render(NULL,camera);



}

}

Run the program.  Toggle the use of the 3D card to see what effect that has.  Experiment with different translucency  types for the shadows and the light.

Here is the complete program:

#include <stdio.h>

#include <conio.h>

#include "..\\..\\..\\Engine\\Include\\mrft_api.h"

void main()

{

int rc=Morfit_engine_load_world("light_vm.wld", “.”, " Bitmaps", USER_DEFINED_BEHAVIOR);


if(rc==VR_ERROR) {



printf("\nFailed to load world.\n");



printf("Please look at error.log and morfit.log to see why.\n");



printf("Press any key to exit\n");



getch();



return;


}


//Use hardware rendering if exists


if(Morfit_3D_card_check_hardware_support()==YES)



Morfit_3D_card_use(YES);


Morfit_engine_maximize_default_rendering_window();


Morfit_engine_set_default_rendering_window_title("Light (Editor Mode) Use the arrows key.    Exit  -  <ESC>");


DWORD lamp_object=Morfit_object_get_object_using_name("lamp");


// the polygon in the light that we will use as our point source


DWORD light_polygon_polygon=Morfit_polygon_get_handle_using_name("lightSource");


//Let’s set the lamp rotation center at the top of the lamp


//In World Builder we named the top polygon as lampTop. The center


//of this polygon will be our rotation center


DWORD lamp_top_polygon=Morfit_polygon_get_handle_using_name("lampTop");


double location_of_top[3];


Morfit_polygon_get_center(lamp_top_polygon,location_of_top);


Morfit_object_set_rotation_center(lamp_object, location_of_top);


DWORD polygon_creating_shadow = Morfit_polygon_get_handle_using_name("shadow");


Morfit_polygon_disable(polygon_creating_shadow); 


DWORD flare_bitmap = Morfit_bitmap_load("Worlds\\Bitmaps\\flare2", 0);


Morfit_polygon_set_bitmap_fill(polygon_creating_shadow, flare_bitmap);


Morfit_polygon_set_translucent(polygon_creating_shadow, NORMAL_GLASS); 


DWORD room_handle = Morfit_group_get_using_name("room");


DWORD chair_handle = Morfit_group_get_using_name("chair");


DWORD piano_handle = Morfit_group_get_using_name("piano");


//Check to see that all objects loaded correctly:


if(piano_handle==NULL || chair_handle==NULL || room_handle==NULL) 



exit(-1);


DWORD camera=Morfit_camera_get_default_camera();


for(;;) {



//rotate the lamp around the Z-axis



Morfit_object_rotate_z(lamp_object, 5, WORLD_SPACE);



//rotate the lamp according to the keyboard input



if(GetAsyncKeyState(VK_UP)<0 )   Morfit_object_rotate_y(lamp_object, 5 , WORLD_);



if(GetAsyncKeyState(VK_DOWN)<0 ) Morfit_object_rotate_y(lamp_object, -5, WORLD_SPACE);



if(GetAsyncKeyState(VK_RIGHT)<0) Morfit_object_rotate_x(lamp_object, 5 , WORLD_SPACE);



if(GetAsyncKeyState(VK_LEFT)<0 ) Morfit_object_rotate_x(lamp_object, -5, WORLD_SPACE);



if(GetAsyncKeyState(VK_ESCAPE)<0) break; 



Morfit_engine_delete_dynamic_shadows();


//get the light source location (it is changong since the lamp is moving)


double light_source_location[3];


Morfit_polygon_get_center(light_polygon_polygon, light_source_location);


//create the light


//Try changing the light source’s location (location_of_top)


//Here we create the light spot. Note that a bright shadow==light.


Morfit_engine_create_dynamic_shadow(room_handle, polygon_creating_shadow,light_source_location, 254);


//creating the light on the chair


Morfit_engine_create_dynamic_shadow(chair_handle, polygon_creating_shadow,light_source_location, 254);


//creating the light on the piano


Morfit_engine_create_dynamic_shadow(piano_handle, polygon_creating_shadow,light_source_location, 254);


//Creating the shadow


double light_source_for_piano_and_chair[3];



Morfit_polygon_get_center(polygon_creating_shadow,light_source_for_piano_and_chair);


Morfit_engine_create_dynamic_shadow(room_handle, piano_handle,light_source_for_piano_and_chair, 255);


Morfit_engine_create_dynamic_shadow(room_handle, chair_handle,light_source_for_piano_and_chair, 255);

//Note that since we give a serial number of 255 it won’t change


//the properties of the light patches(serial==254)


Morfit_group_set_patches_color(room_handle, 80,80,80, 255);  


Morfit_group_set_patches_translucent(room_handle, DARK_FILTER_GLASS, 
255);  



Morfit_engine_render(NULL,camera);



}

}

Listing 11.1

Summary

This chapter described how to create lights and shadows.  While the procedure may sometimes seem complicated, remember that you only need to decide on 3 things: the point source, the blocking object, and the receiving object.  For shadows, the point source can be any point in the lamp, the blocking object is the object casting the shadow, and the receiving object is the object receiving the shadow (usually the room, but it can be anything).  For lights, the point source can be any point in the lamp, the blocking polygon is a special polygon below the lamp, and the object receiving the light can be any object in the world.

Chapter 12 – Editor Mode vs. Viewer Mode

In every program that you write, one of the first decisions that you will need to make will be whether to use Editor Mode or Viewer Mode.  Your decision will impact nearly every aspect of your program, from the APIs that you can use and the operations that you can perform to the speed and performance of your program.  For this reason, it is very important to understand clearly the differences between the two rendering modes.

The first time that you load a world in Viewer Mode, the engine creates a very large data structure called a BSP-tree.  The size of this structure, and therefore the time it takes to construct it, depends on the number of polygons in the world.  However, even for a world with relatively few polygons, this structure can take a long time to build.  For large worlds, it can takes hours.  For this reason, after it builds the tree, the engine saves the world to a file with a .bsp extension.  As long as you do not make changes to the world, the engine will not have to create the structure again.

The BSP-tree is used to decide which surfaces are visible at any given time.  Therefore, you can perform any operation that does not change which objects are visible.  For example, because patches are stuck to already existing polygons, creating them will not block any surface that was not already blocked.   Therefore, you can safely create patches in Viewer Mode without requiring the engine to recreate the entire tree.  However, because creating any other polygons or objects could block new surfaces, creating them would necessitate rebuilding the BSP-tree.  Therefore, you cannot create any other new objects in Viewer Mode.  For the same reason, you cannot scale polygons or even rotate or move them.  The exception is, of course, dynamic objects.  These objects are not placed in the BSP-tree, so you can safely move them and rotate them.

Why Use Viewer Mode?

Because hidden surface calculations are extremely fast using the BSP-tree, rendering in Viewer Mode can be up to 40% faster than rendering in Editor Mode.  Therefore, you should try to use Viewer Mode whenever possible.

Here are some reasons to use Viewer Mode:

You would like to use automatic movement, such as chasing objects, moving on tracks, or moving according to physics.  Automatic movement is only available when you are in Viewer Mode.

Your world has relatively few objects that need to move.  Any object that needs to be movable must be dynamic.  If most of the objects in the world are dynamic, then operating in Viewer Mode won’t be much faster than Editor Mode.  It is the static objects that make rendering faster.

You do not need to create new objects at runtime (most games fall into this category).

Sometimes you might want to use Viewer Mode, but will need to be able to create or destroy polygons over the course of the game.  For example, suppose you would like to destroy enemies as they are killed, and recreate new enemies a short time later.  Instead of creating and destroying them, you can simply disable and re-enable the objects.  This will get around the restriction against creating and destroying objects in Viewer Mode.  Even more importantly, disabling and re-enabling is much quicker.

Why Use Editor Mode?

Under the following conditions, you might prefer to run your world in Editor Mode:

You need to be able to create new objects at runtime.

You need to be able to resize or modify objects.

If you have a world that is very large, here is a technique that you can use to speed up rendering.  If the engine had to worry about all of the polygons all the time, it would run very slowly, even in Viewer Mode.  Instead, suppose your world is described by a large bitmap, and your character is located at the center of the bitmap:
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Figure 12.1

Create only the part of the world that surrounds your current location.  As you move through the world, you can destroy the objects that lie behind you and create the part of the world that you are approaching.  If you tried to load such a large world in Viewer Mode, it would be impossible- it would take days to create the BSP-tree.  If you were to create the whole world in Editor Mode, it would have to many polygons to worry about in each render, and would run too slowly.  By using Editor Mode and creating only the part of the world that you need at a given moment, you can give the appearance of a massive world.

Summary

Most games that you create will use Viewer Mode.  Once the world is created, you will generally not have a need to create new objects or change existing ones.  Viewer Mode usually provides enough of the functionality that you need, while delivering much better speed.  Use the Editor Mode when you have an exceptionally large world, don’t care about speed, or have the need to create or modify objects at runtime (for example, the World Builder is a program that runs in Editor Mode).

Chapter 13 – The Terrain Builder

All of the worlds that we have designed so far have been based on one of the templates: BlankFloor, BlankRoom, and the like.  In order to create more complicated landscapes, you can use the Morfit Terrain Builder.  The Terrain Builder allows you to take a bitmap picture and turn it into a terrain.

The Terrain Builder converts the color of each pixel of the bitmap into an altitude in the world.  Brighter colors in the bitmap will become the mountains, and darker colors will become the valleys.

The easiest way to understand how the Terrain Builder works is to try it.  Open up the Terrain Builder- it is located in the Morfit->Tools folder.  The window will look like this:

[image: image41.png]2 mavzmin/2





Figure 13.1

The first thing that you need to do is select a source bitmap.  Browse through your bitmaps until you find one that looks .  You can also find satellite pictures of many locations on the Web.  A few sample bitmaps come along with the program.  Click on the arrow in the browse window to select one of them.  You can click on View Bitmap to view (and edit) the bitmap that you have chosen.  The picture can be stored in any of the following formats: BMP, JPEG, or JBM.

Once you have selected a bitmap, click on “Create terrain”.  Accept the default options and hit OK.  The program will create your world and display it on the screen.

[image: image42.png]¢ ~

narow zaom wide z00m
angle angle



Notice that the program paints the world based on altitude.  Higher locations will have brighter colors, and lower locations will have darker colors.  You can change that by selecting one of the other options under “Painting Method”.  If you choose Bitmap, you will be asked to select a bitmap to wrap over the world.  Try this to see the effect.  If you choose Legend, the colors will still be based on the altitude, but you can specify which colors are used for which altitudes. Select Legend to get the following box:

Figure 13.2

Starting from the top left box and moving across to the right, select a box and then click on “Add/Change color”.  The first color that you select will fill the lowest elevations, the next box will fill the next lowest elevations, and so on.  If you want the whole terrain to be one color, you can select that color once and leave the other boxes blank.  If you change the painting method, you must create the terrain again to see the effects of the changes.
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When you create the terrain, the following dialogue box pops up to allow you to control how the terrain is created:

Figure 13.3

The first sliding bar controls the level of optimization: how much the engine should attempt to reduce the number of polygons used by smoothing out the bitmap.  Lower numbers will produce a more detailed terrain using a higher number of polygons.

The second sliding bar controls the maximum number of polygons that the engine will use to build the terrain.  The more polygons you use, the more detailed the terrain, but the slower it will load.

Dimensions controls the size of the created terrain.

Experiment with various bitmaps, painting methods, and creation properties.  

The Camera Options provide control over how the program displays the terrain that you have created.

Click on Viewer Window to display the terrain in the full screen.

When you are satisfied with the terrain select Save to save the terrain as a .wld file.  You can now load the file in the World Builder.

It is sometimes useful to edit the bitmap itself before you create the terrain.  For example, suppose that you have a bitmap with a very bright area- that will turn into a mountain.  If you edit the bitmap, and simply draw a black line through the mountain, you will end up with a path through the mountain!  Of course, if the line is not thick enough, it will be optimized out.  Either increase the thickness of the line, decrease the level of optimization, or increase the maximum number of polygons that the terrain builder will use to create the world.  Experiment with different bitmaps and drawings to see what kind of effects you can create.

Chapter 14 – The World Editor

99% of the time, you will be able to use the World Builder to create all of the effects that you desire.  Every once in a while, though, you will want more precise control over an object in the world.  In these cases, you will want to be able to edit the world directly.  While you can open the .wld file in any text editor (such as Notepad), Morfit provides the World Editor tool to make the job easier.

Let’s design a very simple world in the World Builder, and then take a look at it in the World Editor.
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Create a new world in the World Builder based on the BlankFloor template.  Add one object from the model gallery- something simple.  I added the solid red pyramid from the 3Dforms folder.  In order to make the world even simpler, do not save your world directly.  Instead, select File->Release.  Use the dialogue box to remove the template polygons (the black and white floor, in this case):

Figure 14.1

Now, start the World Editor, which is located in the Morfit->Tools folder.  Open the world which you have created.  You should see the text file, which will look something like this:

// This file was created by Morfit VR Engine

/* notes ....

*/

BEGIN_DESIGN:

ATMOSPHERE: 160 160 170 FOG: 0.0100  LIGHT: 0

DEFAULT_COLOR: 160 160 170 

BEGIN_MODULE: main


OBJECT:



MODULE_NAME: PYRAMID_2_2



MATRIX: 




 1
 0
 0
 0




 0
 1
 0
 0




 0
 0
 1
 0




 349.6577272727143
-15.7009090909099
 99.05802724908517


END_OBJECT: 

END_MODULE: main

BEGIN_MODULE: PYRAMID_2_2


POLYGON: pNewFilledArea_40



COLOR: 255 79 79



BITMAP: NO_BITMAP



TRANSPARENT: -1  DISABLE_BLENDING



ROTATED: NO



LIGHT_DIMINUTION: 40



NUM_OF_POINTS: 3




-127.7873960812481
 127.7873960812557
-97.03302724908008
 1E-006
 9.999999996743541E-007
 100




 127.7873960812561
 127.7873960812338
-97.03302724908008
 0.9999990000000001
 9.999999996743541E-007
 100




 0.8246716256430773
 5.226219457199477E-011
 97.03302724908008
 0.5032267265849094
 0.4999999999999489
 100


POLYGON: front



ORIENTATION: FRONT



COLOR: 155 0 0



BITMAP: NO_BITMAP



TRANSPARENT: -1  DISABLE_BLENDING



ROTATED: NO



LIGHT_DIMINUTION: 40



NUM_OF_POINTS: 3




-127.7873960812519
-127.7873960812525
-97.03302724908735
 1E-006
 0.999999
 100




-127.7873960812481
 127.7873960812557
-97.03302724908008
 1E-006
 9.999999996743541E-007
 100




 0.8246716256472837
 5.521627599591739E-011
 97.03302724908735
 0.5032267265849094
 0.4999999999999489
 100


POLYGON: pNewFilledArea_60



COLOR: 185 0 0



BITMAP: NO_BITMAP



TRANSPARENT: -1  DISABLE_BLENDING



ROTATED: NO



LIGHT_DIMINUTION: 40



NUM_OF_POINTS: 3




 127.787396081252
-127.7873960812507
-97.03302724907826
 0.9999989999999889
 0.9999989999998996
 100




-127.7873960812561
-127.7873960812557
-97.03302724908008
 1E-006
 0.999999
 100




 0.8246716256472837
 5.521627599591739E-011
 97.03302724908735
 0.5032267265849094
 0.4999999999999489
 100


POLYGON: pNewFilledArea_70



COLOR: 255 4 4



BITMAP: NO_BITMAP



TRANSPARENT: -1  DISABLE_BLENDING



ROTATED: NO



LIGHT_DIMINUTION: 40



NUM_OF_POINTS: 3




 127.7873960812561
 127.7873960812338
-97.03302724908008
 0.9999990000000001
 9.999999996743541E-007
 100




 127.787396081252
-127.7873960812507
-97.03302724907826
 0.9999989999999889
 0.9999989999998996
 100




 0.8246716256472837
 5.521627599591739E-011
 97.03302724908735
 0.5032267265849094
 0.4999999999999489
 100


POLYGON: BOTTOM



ORIENTATION: BOTTOM



COLOR: 128 150 128



BITMAP: NO_BITMAP



TRANSPARENT: -1  DISABLE_BLENDING



ROTATED: NO



LIGHT_DIMINUTION: 40



NUM_OF_POINTS: 4




 127.7873960812561
 127.7873960812338
-97.03302724908008
 0.9999990000000001
 9.999999996743541E-007
 100




-127.7873960812481
 127.7873960812557
-97.03302724908008
 0.9999989999999737
 9.999998993432865E-007
 100




-127.7873960812561
-127.7873960812557
-97.03302724908008
 0.9999989999999637
 0.9999989999998997
 100




 127.787396081252
-127.7873960812507
-97.03302724907826
 0.999998999999989
 0.9999989999998997
 100

END_MODULE: PYRAMID_2_2

END_DESIGN:

Listing 14.1

This might look intimidating, or look like a lot of information for just one object.  But let’s take a look at it piece by piece.

The world is stored as a series of nested blocks.  The outermost block, the design block, contains the entire world.  The world is surrounded by the commands:

BEGIN_DESIGN:

…

END_DESIGN:

Now we define the global properties of the world- things that will effect the world as a whole.  For example, here we have defined the atmospheric color and strength, and the background color:

ATMOSPHERE: 160 160 170 FOG: 0.0100  LIGHT: 0

DEFAULT_COLOR: 160 160 170 

To see how we can use the text editor to change the world, let’s turn the background green.  Edit the line that specifies the default color:

DEFAULT_COLOR: 40 220 40

Save the world and open it in the World Builder- you should now see a bright green background!

Instead of opening the world in the World Builder every time you want to see a change, you can view it directly from the World Editor.  you select Run->Load World, you will find three options: Viewer Mode, Editor Mode, and Auto Behavior Mode.  Auto Behavior Mode is just like Viewer Mode, except that you can use the arrow keys and the space bar to move the camera through the world.  Run the world in Auto Behavior Mode.  Since we have not yet created a camera, the viewer might be facing away from our object, and all you will see is the green background.  Hold down the left or right arrow key to turn the camera until you see the pyramid as well.

After the global properties comes a module known as main.  Every world must have a main module.  This contains all those objects and polygons that are directly part of the world- that is, they are not part of any higher level group.  Our world has just one such object, the pyramid:

BEGIN_MODULE: main


OBJECT:



MODULE_NAME: PYRAMID_2_2



MATRIX: 




 1
 0
 0
 0




 0
 1
 0
 0




 0
 0
 1
 0




 349.6577272727143
-15.7009090909099
 99.05802724908517


END_OBJECT: 

END_MODULE: main

Every object is contained within its own OBJECT and END OBJECT commands.  First comes the MODULE_NAME directive, which gives a name to the object and describes where the object’s design is contained.  After this comes the object’s matrix.  Changing the object’s matrix will rotate, scale, or move the object within the world.  How to perform these operations directly is a subject for a 3D graphics math book and is beyond the scope of this book.

After the main module, we can define any other modules that we need.  In this case, we must define the PYRAMID_2_2 module that we referred to inside main.

The PYRAMID_2_2 module is structured in the same way:

BEGIN_MODULE: PYRAMID_2_2


POLYGON: pNewFilledArea_40


POLYGON: front


POLYGON: pNewFilledArea_60


POLYGON: pNewFilledArea_60


POLYGON: BOTTOM

END_MODULE:PYRAMID_2_2

This module defines the polygons that make up the pyramid object.  Objects can also be nested.  For example, a HOUSE module might be defined something like this:

BEGIN_MODULE: HOUSE


POLYGON: front


POLYGON: left


POLYGON: right


POLYGON: back


OBJECT:



MODULE_NAME: ROOF



MATRIX: 1 0 0 0




.




.




.


END OBJECT:

END_MODULE: HOUSE

You would then need to define the ROOF module.

Back to our example- the pyramid module includes several polygons.  Each polygon has a definition like this:


POLYGON: BOTTOM



ORIENTATION: BOTTOM



COLOR: 128 150 128



BITMAP: NO_BITMAP



TRANSPARENT: -1  DISABLE_BLENDING



ROTATED: NO



LIGHT_DIMINUTION: 40



NUM_OF_POINTS: 4




 127.7873960812561
 127.7873960812338
-97.03302724908008
 0.9999990000000001
 9.999999996743541E-007
 100




-127.7873960812481
 127.7873960812557
-97.03302724908008
 0.9999989999999737
 9.999998993432865E-007
 100




-127.7873960812561
-127.7873960812557
-97.03302724908008
 0.9999989999999637
 0.9999989999998997
 100




 127.787396081252
-127.7873960812507
-97.03302724907826
 0.999998999999989
 0.9999989999998997
 100

The polygon has a name and an optional orientation (TOP, BOTTOM, FRONT, or BACK).  It has an RGB color, and a bitmap.  Its transparency, rotation, and light diminution are defined.  Finally, it contains a list of the points that make up its vertices.

For what we have done so far, you could have just used any text editor.  What makes the World Text Editor so useful is when you want to add objects to the world.  Let’s add a camera.  From the Insert menu, select camera.  You will see a dialogue box in which you can assign the camera’s properties: name, location, direction, view field, culling depth, etc.  (For a review of any of these properties, see Chapter 4, The Camera API.)  

You can use the insert menu to add anything you want to you world: cameras, animations, tracks, objects, backgrounds, etc.

It is very important to remember the following:

Polygons, objects, and dynamic objects must be inserted inside a module.  They can be placed inside the main module or any other module.

Modules, cameras, animations, tracks, and backgrounds must be inserted outside of any module, but inside of the BEGIN_DESIGN and END_DESIGN directives.

Summary

While the World Builder is much easier to use to create complex worlds and effects, at times you may have the need to fine-tune your world by directly editing the text file.  When you need to edit the world directly, the World Text Editor is a very useful tool to use.  You should become familiar with it using very small, simple worlds, so that when you want to edit more complex worlds you will be able to find your way around the file.
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